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About the documentation

This document serves as a user's guide for two 32-bit versions of TerraPhoto. The entry-level 
version, TerraPhoto Lite, is functionally a subset of the full version, TerraPhoto. Tools available 
in TerraPhoto and TerraPhoto Lite work identically in the two versions. Tools that are not 
available in TerraPhoto Lite are marked as "Not Lite" in the documentation.

This User's Guide is divided into several parts:

• Getting Started - general information about TerraPhoto and instructions on how to install 
and run the application.

• Visualization Options - information about viewing raster images in the background and a 
description of the creation of rendered views and flythru movies.

• Project Workflow - general advice on steps to take when processing a project.
• Tool Reference - detailed descriptions of the tools and menu commands in TerraPhoto main 

toolbox and main window.
• Programming Interface - a list of public functions as well as a description of file formats.
• Additional Information - information about the installation configuration.

Accessing the documentation

The documentation is accessible as an Acrobat Reader PDF document which serves the role of 
online help. Accessing the electronic format of the documentation has the following advantages:

• You can conduct automated searches for keywords in topic names or body text.
• You can click hypertext to "jump" to related topics.

Document conventions

The following conventions and symbols appear in this guide:

• Data click - click on the data mouse button, usually the left button on a right-hand mouse.
• Reset click - click on the reset mouse button, usually the right button on a right-hand mouse.
• < > - angle brackets used for keybord keys, for example, <Return>.
• Key in - type a command in the key-in line of MicroStation and then press <Return>.
• OR - alternate procedures or steps in a procedure.
• C:/TERRA - paths to directories of files on a hard disk are written with capital letters.
• Icons used to introduce special information:

• When no distinction between MicroStation versions is necessary, this document refers to the 
CAD environment simply as "MicroStation".

MicroStation documentation

This document is written under the assumption that the reader knows how to use basic 
MicroStation features. You should refer to the printed documentation or online help of 
MicroStation whenever you need information about using the CAD environment.

Icon: Appears next to:
Notes and Hints
Procedures
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Introduction
TerraPhoto is widely used for the production of orthorectified images from airborne imagery. It is 
specifically written for handling images taken during a laser scanning mission and using the laser 
data for an accurate ground model. The complete orthorectification process can be performed 
without having any known points at the site. However, known points can be used to improve the 
absolute accuracy of the image positions.

TerraPhoto’s approach to orthorectification is simple and accurate. The rectification routine has 
the following advantages:

• Straightforward workflow which directly creates a mosaic of orthorectified rasters.
• Triangulated laser ground model follows all terrain features accurately. The software 

computes an elevation value for each pixel in the ortho image.
• Automatic smoothing of color transitions between images as well as several correction 

methods for color issues in the raw images.

TerraPhoto can further create wall textures automatically from oblique images taken during a 
flight. The 3D building models required for wall texture rectification have to be available as 
design file elements in MicroStation. They can be produced, for example, by TerraScan building 
vectorization tools.

Images from mobile systems can be used to calibrate multiple-camera systems, to improve the 
positioning of the images from several cameras of a system, to rectify images on the ground 
surface, and to create source data for coloring MLS point clouds.

TerraPhoto can serve as an application for displaying raster images in the background of 
MicroStation views. The supported file formats include ECW, GeoTIFF, TIFF, BMP, CIT, COT, 
RLE, PIC, PCX, GIF, JPG, JP2, and PNG raster files. Furthermore, the software is able to produce 
rendered views and images, as well as fly-through movies. It can also be used to display videos 
that are taken during a flight or drive session and assigned to the trajectory files.

TerraPhoto is fully integrated with MicroStation. The CAD environment provides a huge number 
of useful tools and capabilities in the areas of view manipulation, visualization, vector element 
placement, labeling, and plotting.

TerraPhoto Lite
TerraPhoto Lite is a light version of TerraPhoto and provides a subset of the functionality of the 
full version. It can be used to display raster images in the background. It supports all the same 
raster formats and can convert raster files between some of the formats. It is also able to create 
rendered views and images.

TerraPhoto Lite provides all the necessary tools for color balancing and for seamline editing as 
preparations steps for ortho mosaic creation. It does not include the orthorectification tools.
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Terra application family
Terrasolid developes a full family of civil engineering applications. Almost all Terra applications 
are tightly integrated with MicroStation presenting an easy-to-use graphical interface to the user.

TerraBore is a solution for reading in, editing, storing and displaying bore hole data. You can 
triangulate soil layers with the help of TerraModeler.

TerraMatch fixes mismatches between laser points from different data strips automatically. It 
can be used for the calibration of a laser scanner system and for fixing project data.

TerraModeler creates terrain surface models by triangulation. You can create models of ground, 
soil layers, or design surfaces.  Models can be created based on survey data, graphical elements, 
laser data, or XYZ text files.

TerraPhoto rectifies digital photographs taken during laser scanning survey flights and produces 
rectified ortho images.

TerraPipe is used for designing underground pipes. It gives you powerful tools for designing 
networks of drainage, sewer, potable water, or irrigation pipes.

TerraScan processes laser scanning data. It reads in laser points from text or binary files and lets 
you view the point cloud three dimensionally, classify the data, and create vector data based on 
the points.

TerraSlave is a stand-alone application that processes TerraScan macros. It enables distributed 
processing and scheduling tasks to gain optimal time and working performance.

TerraStereo is a stand-alone application for viewing very large point clouds in mono and stereo 
mode. It utilizes advanced point rendering techniques and the graphics card memory in order to 
display huge amounts of points.

TerraStreet is an application for street design. It includes all the terrain modeling capabilities of 
TerraModeler. The street design process starts with the creation of horizontal and vertical 
geometries for street alignments.

TerraSurvey reads in traditional survey data and creates a three dimensional survey drawing. The 
application recognizes a number of survey data formats automatically.
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Hardware and software requirements
TerraPhoto is built on top of MicroStation.  You must have a computer system capable of running 
this CAD software.

To run TerraPhoto, you must have the following:

• Pentium or higher processor
• Windows 8, 7, Vista, XP, or 2000 (64-bit version recommended)
• mouse
• 1024*768 resolution display or better
• 512 MB RAM or better
• MicroStation V8, MicroStation V8i (Select Series 2 or higher) or Map PowerView. Check 

Terrasolid’s web pages for a more detailed overview of compatible MicroStation versions.

Installation of TerraPhoto requires about 2 MB of free hard disk space.

Installation media
TerraPhoto may be delivered on a CD/USB-Stick or as a zip file.

A zip package only contains the actual software - it does not include the PDF User’s Guide.

A Terra Installation CD/USB-Stick includes the software and the online documentation. When 
you install from the CD/USB-Stick, the software and the documentation are copied to your hard 
disk. The CD/USB-Stick may include versions for multiple environments. You should locate the 
directory which corresponds to your operating system and MicroStation version.

Directory on CD/USB For operating system For MicroStation
\setup\eng Windows V8 or V8i
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Installation from zip file
To install TerraPhoto from a zip file:

1. Unpack the zip archive with any zip file manager.
2. Start SETUP.EXE which is part of the zip archive.

This may open a dialog confirming the execution of SETUP.EXE and/or prompting for the 
administrator password.

The installation program needs to know where MicroStation has been installed. It 
automatically searches all local hard disks to find the MicroStation directory.

The installation dialog opens:

3. Enter the directory where to install TerraPhoto.

The default path is C:\TERRA. You may change this to another location. The specified 
directory is created automatically if it does not exist.

4. Check the MicroStation directory. Replace the path if the correct location was not found 
automatically.

5. Click OK to start the installation.

When the installation is finished, a message is displayed.

See Chapters Installation Directories on page 348 and Configuration Variables on page 349 
for additional information.

Installation from CD/USB-Stick
To install TerraPhoto from CD/USB-Stick:

1. Insert the Terra Installation CD/USB-Stick.
2. Locate the correct directory which corresponds to your computer configuration.
3. Start SETUP.EXE from that directory.

The installation program tries to determine where MicroStation has been installed and opens 
the Terra Setup dialog:
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4. Enter the directory where to install the application(s).

The default path is C:\TERRA. You can change this to another location. The specified 
directory is created automatically, if it does not exist.

5. Check the MicroStation directory. Replace the path if the correct location was not found 
automatically.

Alternatively, you can use the Scan button to automatically search the hard disk for the 
MicroStation installation or you can use the Browse button to locate the MicroStation 
executable yourself.

6. Check the MicroStation version information in the Version field. Select the correct version 
if it was not detected automatically.

7. Click OK to continue.

This opens another Terra Setup dialog:

8. Select the TerraPhoto for MicroStation item in the dialog.

You may select other applications as well for which you have installation files.

9. Click OK to start the installation.

A message is displayed when the installation is finished.

See Chapters Installation Directories on page 348 and Configuration Variables on page 349 
for additional information.
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Starting TerraPhoto
TerraPhoto is an MDL application that runs on top of MicroStation.

To start TerraPhoto:

1. Select MDL Applications command from the Utilities menu in MicroStation.

The MDL dialog opens:

2. In the Available Applications list, select TPHOTO.
3. Click the Load button.

OR

1. Key in MDL LOAD TPHOTO.

When the application is loaded, it adds an Applications menu to the MicroStation menu bar and 
opens the TPhoto Main window and Main tool box:

The Available Applications list shows all MDL applications that MicroStation is able to locate. 
MicroStation searches for MDL applications in the directories listed in the MS_MDLAPPS 
configuration variable. If MicroStation can not find TPHOTO.MA, you should check the value 
assigned to this configuration variable. Make sure the directory path of the TPHOTO.MA file is 
included in the variable. To view configuration variables, select Configuration command from 
the Workspace pulldown menu in MicroStation. See also Sections Installation Directories on 
page 348 and Configuration Variables on page 349 for additional information.
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Unloading TerraPhoto
TerraPhoto is unloaded automatically when you exit MicroStation. Sometimes you may want to 
unload the application while continuing to work with MicroStation. This frees up the memory 
reserved by TerraPhoto.

To unload TerraPhoto:

1. Select MDL Applications command from the Utilities pulldown menu in MicroStation.

The MDL dialog opens:

2. In the Loaded Applications list, select TPHOTO.
3. Click on the Unload button.

OR

1. Key in MDL UNLOAD TPHOTO.

This unloads the application and frees the memory allocated for it.
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Visualization Options
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This chapter serves as an introduction to the concepts of viewing raster images in the background.

The basic requirements for viewing raster references are listed below:

• Raster files must have a known geographical position. Some raster file formats contain the 
georeferencing information in the file header (for example, GeoTIFF and ECW). 
Alternatively, the georeferencing information can be stored in external files specific for raster 
file formats (for example, .TFW files for TIFF, .JGW files for JPG).

• The design file must provide the appropriate coordinate range for the position of the raster 
files.

• Raster references are displayed only in top views or rendered views.

Georeferenced raster files

TerraPhoto can load georeferenced raster files in multiple formats. The two most commonly used 
formats are GeoTIFF, JPEG or ECW.

If your raster files do not have georeference information, you may still attach those files and assign 
the position interactively.
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Design file coordinate system

MicroStation design files use a coordinate system which can incorporate only a limited coordinate 
range. You should make sure that the raster image coordinates fit inside your design file 
coordinate system.

If you regularly work in the same geographical area and use the same coordinate system, your seed 
files are probably configured correctly.

As an alternative, you may want to create a new design file using a seed file that is provided with 
the TerraPhoto installation. The SEED3DCM.DGN file has working units defined as follows:

This seed file can include coordinate values between -21 474 836 and +21 474 836.

To create a suitable empty design file:

1. Select New command from the File pulldown menu in MicroStation.

The New dialog opens:

2. Type a name for the file to be created in the Files text field.
3. Click Select to select the seed file to be used.

The Select Seed File dialog opens.

4. Locate SEED3DCM.DGN seed file.

If you installed TerraPhoto in the default directory C:\TERRA, you can find this file at 
C:\TERRA\SEED\SEED3DCM.DGN. Alternatively, you can type in the full path of the 
seed file in the Files text field.

5. Click OK to accept the seed file.
6. Click OK to accept the creation of a new design file.

This creates a new design file and opens it.

• Master units: m
• Sub Units: cm

• Resolution: 100 cm per m
• 1 Pos Units per cm
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Top views

TerraPhoto displays raster images only in top views. A top view is an orthonormal view where 
usually, the north axis points upward on the screen. However, a top view can also be rotated 
around its z-axis.

To rotate a view to top rotation:

1. Select the Rotate View tool from the MicroStation View tool box.

The Rotate view dialog opens.

2. Select Top in the Method list.
3. Place a data click inside the view.

This changes the view to a top view where north direction points upward on the screen.

You can use the same tool to rotate the view around its z-axis. The method described below is 
especially handy when you have a corridor-like project area which you would like to run 
horizontally across the screen.

To rotate a view around the z-axis:

1. Select the Rotate View tool from the MicroStation View tool box.

The Rotate view dialog opens.

2. Select 3 Points in the Method list.
3. Place a data click inside the view to define the start point for a direction line.
4. Place a data click inside the view to define the end point for a direction line.

The direction line defines the horizontal direction of the rotated top view.

5. Place a data click inside the view to define the upward direction on the screen.

This rotates the view so that the given direction line runs from left to right on the screen.

Raster references in TerraPhoto

The Manage Raster References window is used to view raster images in TerraPhoto. The 
commands of the window are described in detail in Chapter Commands for Raster References 
on page 315.

To attach raster references in TerraPhoto:

1. Load TerraPhoto. See chapter Starting TerraPhoto on page 18 for instructions on how to 
load TerraPhoto.

2. Select the Manage Raster References tool.

This opens the Manage Raster References window.

3. Select Attach files command from the File pulldown menu.

This opens a standard dialog for opening files.

4. Select all files to be opened.

TerraPhoto inspects the selected files and opens the Reference Visibility dialog. This dialog 
allows you to change the visibility of the images in MicroStation views 1 - 8 and for rendered 
views.

5. Click OK.

The raster images are attached and are displayed in the selected views if they are top views.
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Fitting a view to show the location of the raster images

In order to see the raster images, it may be necessary to move the view to the right geographical 
location.

You can primarily use MicroStation tools for manipulating the views, such as Pan, Zoom, etc.. 
However, TerraPhoto offers a few tools which are handy in locating the raster images. One 
possibility is to fit a view to the area of all or selected attached raster images.

To fit a view to show all attached images:

1. Select an option of Fit command from the Display pulldown menu in the Manage Raster 
References window.

2. Place a data click inside a top view.

This fits the view to display all or selected reference images.
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6 Creating Rendered Views and Movies
This chapter describes the creation of 3D rendered views and movies with MicroStation and 
TerraPhoto tools.

In the first part, the concept of rotated views and camera views is introduced. Afterwards, 
rendering views including different objects is explained. The second part describes the workflow 
for the creation of flythru movies.

To create nice 3D visualizations, not only tools from TerraPhoto are used, but also tools and 
functions from TerraScan and TerraModeler. Those tools are included in the following 
descriptions but not further explained. See TerraScan and TerraModeler User’s Guides for more 
information.

Rendered Views
Rendering is a process which is used to generate an image of a geometric model of an object. The 
calculation of a rendered image includes besides geometry also a viewpoint, lightning, shading, 
and texture information. The process is done by a renderer that can be part of larger programs like 
MicroStation or TerraPhoto.

Rendered views are nice and demonstrative representations of geographic data used for 3D 
visualization purposes, in the field of geo-visualizations, for example, for 3D city or landscape 
models. They are also required as frames for the creation of flythru movies.

To display rendered views, it makes sense to rotate a view which means to change the orientation 
from a top view to another orientation. Another possibility is to create so-called camera views 
which offers the opportunity to define more precisely the location of the observer (= camera) and 
the target. These view settings can be manipulated by MicroStation View Control tools and are 
described in the following Sections Rotated Views on page 25 and Camera Views on page 27. 
As mentioned before, rendered views are calculated from geometric models of objects. Examples 
for such objects and their usage in TerraPhoto rendering are described in Section TerraPhoto 
Rendering on page 28.

Rotated Views

Rotated views are views that are rotated around the east axis. As a result, the z axis points in an 
upward direction which is the usual case for geospatial 3D visualizations. Depending on an 
additional rotation around the z axis, the north and east axes point into different directions. In 
MicroStation, there are some predefined settings for certain view orientations:

• Front – north axis points into the screen, east axis points to the right, z axis points straight 
upwards.

• Back – north axis points towards the observer, east axis points to the left, z axis points 
straight upwards.

• Left – north axis points to the left, east axis points into the screen, z axis points straight 
upwards.

• Right – north axis points to the right, east axis points towards the observer, z axis points 
straight upwards.

• Isometric – Front setting rotated 45° counterclockwise around the z axis and towards the 
observer around the east axis.

• Right isometric – Front setting rotated 45° clockwise around the z axis and towards the 
observer around the east axis.
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The following sketches illustrate the different view orientations. The first image shows the 
orientation of the coordinate axes in a top view while the other images show the orientation in the 
above described rotated views.

To rotate a view to a certain orientation:

1. Select Rotate View tool from the MicroStation View Control tools.
2. Select an option in the Method field.
3. Click inside a view in order to apply the selected orientation.

Besides these predefined orientations, views can be rotated dynamically to get individual displays 
from other directions.

To rotate a view dynamically:

1. Select the Rotate View tool from the MicroStation View Control tools.
2. Select Dynamic option in the Method list.
3. Place a data click inside a view.
4. Move the mouse to rotate the view.
5. Place another data click inside the view to accept the new orientation.

OR

3. Click the data mouse button and move the mouse pointer while the mouse botton is pressed.
4. Release the mouse botton in order to accept the new orientation.

Top view orientation

Front Left Isometric

Back Right Isometric Right

Orientation of coordinate axes for different view rotation settings in MicroStation. Colors of 
axis: red = east, green = north, blue = z
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Camera Views

Camera views are perspective views where the location of the observer (= camera) and the target 
are defined. This can be useful, for example, to analyze the visibility of objects from a certain 
location. Camera views are created using the camera settings of MicroStation.

Note, that camera views described in this section do not serve the same purpose as camera views 
of TerraPhoto, which are used as a first step to solve camera parameters. See Create camera view 
for more information.

To create a camera view:

1. Select View Control command from the Tools pulldown menu in MicroStation.

This opens the View Control menu.

2. Select the Camera Settings tool.

This opens the Camera Settings dialog:

3. Place a data click inside a view to define the view for camera view display. The settings in 
the lower part of the dialog become active.

4. (Optional) Change settings for the camera. For more information about camera settings 
refer to the MicroStation documentation.

5. Place a data click inside the view to define the target point of the camera.
6. Place a data click inside the view to define the camera location.

This displays the camera view.

It might be helpful to start the camera view creation from a top view that shows, for example, 
orthophotos. To define exact coordinates for the camera location and the target point, 
MicroStation’s AccuDraw can be used to set absolute coordinate values.

Another possibility is to set the height of camera location and target point based on a ground 
model. The ground model can be represented by laser points loaded into TerraScan or by a surface 
model loaded in TerraModeler.

To create a camera view using a ground model:

1. Load laser points representing the ground into TerraScan.

OR

Create a surface model with TerraModeler.

2. Select Camera Settings tool as described above.
3. Place a data click inside a view to define the view for camera view display.
4. Select Mouse Point Adjustment tool from the Drawing tools in TerraScan.

OR

Select View elevation tool from the Draw using Surface tools in TerraModeler.

5. In the Mouse Point Adjustment dialog, lock Adjust elevation and set a value for Dz. The 
value defines the height above the laser points for each mouse click. Select also a laser point 
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class in the Class field.

OR

In the View elevation dialog, lock Points on surface and set a value for Dz. The value 
defines the height above the surface model for each mouse click. Select also a surface model 
in the Surface field.

6. Place a data click inside the view to define the target point of the camera.
7. (Optional) Change the value for Dz in the Mouse Point Adjustment dialog or View eleva-

tion dialog to set another height for the camera location.
8. Place a data click inside the view to define the camera location.

TerraPhoto Rendering

TerraPhoto is able to render vector models of objects in a design file. Rendered views can also 
include elevation models previewed in TerraModeler, images that are attached as TerraPhoto 
references, as well as laser data loaded in TerraScan.

Buildings and other vector models
To include buildings into rendered views, vector models of the buildings have to be created. This 
can be done, for example, by using the building vectorization tools in TerraScan, which enable the 
(half-)automatic creation of building models based on classified laser data. The resulting models 
consist of a roof top, roof sides, roof bottom, and walls.

However, 3D vector models of any objects that have been created by other methods can be 
included in TerraPhoto rendered views.

Orthophotos or other georeferenced images can be draped on 3D shapes of objects, such as 
building roofs or bridge surfaces. The usage of such 3D elements is defined by the Define 
Rendering Settings tool in the Render tools of TerraPhoto.

The walls of 3D building models can be textured by raster files. The wall textures have to be 
produced by the Rectify wall rasters command in TerraPhoto.

RPC cells for trees
An option to visualize trees in 3D scenes is the use of RPC cells. RPC cells are purchased by 
Archvision (www.archvision.com). These cells include texture maps of an object from different 
directions and angles. They can be used to render objects like trees, cars, road furniture etc. in a 
realistic way no matter from which direction the object is viewed.

To use RPC trees in a rendered view, cell elements have to be placed for the trees. This can be 
done, for example, by using the automatic tree detection tool in TerraScan, which detects trees 
from classified laser data. It utilizes predefined tree shapes for tree recognition in the point cloud. 
It places either cells or RPC cells which are both MicroStation cell elements. RPC cells include a 
link to the corresponding RPC file on a hard disk. The tree shape definitions, RPC file storage 
settings, and cell definitions are managed in TerraScan Settings. The default directory for RPC 
file storage is C:/TERRA/RPC where TerraPhoto looks for the cells if a view is rendered.

Another possibility is to use TerraPhoto’s Place Rpc Tree tool in order to place RPC cells for trees 
manually based on laser and image data.

Digital elevation model
A digital elevation model (DEM) is usually the basis of 3D city or landscape models. In 
TerraModeler, a DEM is created from traditional survey data or from laser points of the ground 
and can be visualized using different methods. See TerraModeler Users’ Guide for more 
information.
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An representative way to use the DEM in a rendered view is to drape orthophotos on it. The 
orthophotos (or any kind of other georeferenced images, e.g. maps) have to be attached as 
TerraPhoto references with the setting R for ‘Rendered views’ switched on. See chapter 17, 
Commands for Raster References on page 315 for information about how to manage raster 
references in TerraPhoto. In addition, the DEM in TerraModeler has to be displayed as raster 
triangles, a specific display method for surface models.

Laser data
Laser points loaded in TerraScan can be included in rendered views as well. They are always 
rendered with the same point size and colored according to the display settings in TerraScan’s 
Display Mode dialog.

Usa the data in rendered views
To use all the above mentioned options in a rendered view, tools from TerraPhoto (Lite), 
TerraModeler (Lite), and TerraScan (Lite) are required. 

To create a rendered view using a DEM, vector models, and orthophotos:

1. Create a surface model using the Create Editable Model tool in TerraScan or using tools of 
TerraModeler.

2. Create raster triangles by using the Display Raster Triangles tool from the Display Regions 
tools in TerraModeler.

The raster triangles are not drawn as elements in the design file but only displayed 
temporarily. Therefore, the level set for triangle display appears to be empty in the Level 
Display dialog of MicroStation. However, the level must be switched on in order to display 
the surface model in rendered views.

3. Attach raster files as TerraPhoto raster references. See commands of the File pulldown 
menu for a description of how to attach images in TerraPhoto’s Manage Raster 
References window. It is essential, that the view setting R ( = Render) for the reference 
images is switched on.

4. Switch on all design file levels that contain vector models of buildings, RPC cells for trees, 
or other objects. These objects are only included in rendered views if the level display is 
switched on for the respective MicroStation view.

5. Attached raster references can be draped on one or more design file levels which consist 
elements like building roofs or bridge surfaces. Define such levels by using the Define 
Rendering Settings tool in the Render tools of TerraPhoto.

6. Select Display Rendered View tool from the Render tools in TerraPhoto.
7. Click inside the view to display the rendered view.

Rendered views are created by TerraPhoto tools Display Rendered View, Save Rendered View, 
and Create Flythru Movie.
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Examples

Rendered view including orthophotos draped on a DEM and building roofs, wall 
textures referenced on 3D building models, and RPC trees.

Rendered view without any imagery. Building models and RPC trees are displayed 
on top of a DEM that is colored by elevation and stored in TerraModeler.
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Flythru Movies
Flythru movies are created in TerraPhoto from a set of frames. The frames are rendered views 
along a camera path that determines the path, viewing direction, and other settings of the camera. 
All above described elements in rendered views can be part of frames for movies. Flythru movies 
are saved as .avi files.

The process of flythru movie creation includes the following steps:

• Definition of a camera path – creation of a 3D path for the camera.
• Definition of target vectors – defines camera viewing direction and distance.
• Creation of frames or movies – frames are rendered and saved as image files, or a movie is 

created directly without saving image files before.
• Creation of movies from frames – frames are recorded as movie file.

The next Sections describe these steps in detail.

Definition of a camera path

The camera path defines the flight path of the camera. It is created from a line string element 
digitized in the design file. To set the height of the camera path relative to the ground, the Mouse 
Point Adjustment tool from TerraScan or the View elevation tool from TerraModeler can be 
utilized. Additionally, settings for line digitalization in MicroStation are useful to create a smooth 
camera path.

To define a camera path:

1. Load laser points of the ground into TerraScan.

OR

Create a surface model with TerraModeler.

2. Select Mouse Point Adjustment tool from the Drawing tools in TerraScan.

OR

Select View elevation tool from the Draw using Surface tools in TerraModeler.

3. In the Mouse Point Adjustment dialog, switch on Adjust elevation and set a value for Dz. 
The value defines the height above the laser points for each mouse click. Select a laser point 
class in the Class field.

OR

In the View elevation dialog, switch on Points on surface and set a value for Dz. The value 
defines the height above the surface for each mouse click. Select a surface in the Surface 
field.

4. Select Place SmartLine tool in MicroStation. Select Rounded in the Vertex Type field, 
define a Rounding Radius, and switch on Join Elements.

5. Digitize a line string. The height above ground and the rounding radius settings can be 
changed during the digitalization process. The final 3D line string can be checked by 
rotating the view.

6. Select the line string using Selection tool in MicroStation.
7. Select Create Flythru Movie tool from the Render tools in TerraPhoto.

This defines the line string as camera path and opens the Create Flythru Movie dialog.

3D line strings from other sources may be used as camera path as well, for example, trajectories 
that are drawn into the design file.
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Definition of target vectors

Target vectors determine the viewing direction and distance of the camera from the camera path 
to the target. They are attached as line elements to the camera path using tools from the Create 
Flythru Movie dialog:

To define target vectors:

1. Select Create vectors command from the Target pulldown menu in the Create Flythru 
Movie dialog.

This opens the Create target vectors dialog:

2. Define settings and click OK. If direction is set to Fixed point, the target point has to be 
defined by a data click inside a view.

This attaches the vectors to the camera path. The result can be checked by rotating the view.

3. (Optional) Besides using the predefined settings, target vectors can be modified manually 
using, for example, Modify Element tools of MicroStation.

4. After manual modification, use Update from design command from the Target pulldown 
menu in the Create Flythru Movie dialog to apply the changes to the camera path 
definition.
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The automatic placement of target vectors can be undone be using MicroStation’s Undo 
command. Existing target vectors are replaced by choosing another setting for direction in the 
Create target vector dialog as long as they are not manually modified.

The following figures illustrate the differences of direction settings provided by the tool. The 
white line is the camera path and the red lines are the target vectors in 3D perspective views.

Setting: Effect:

Direction

Camera viewing direction:
• Fixed point - the camera is directed towards one point during 

the whole flythru.
• Forward onto surface - the camera is directed forward 

towards a surface model stored in TerraModeler.
• Forward horizontal - the camera is directed in a forward 

horizontal direction independently of the camera path direction.
• Forward - the camera is directed in a forward direction relative 

to the camera path.
• Down - the camera is directed vertically down.

From station First location of a target vector along the camera path.
To station Last possible location of a target vector along the camera path.

Step
Distance between two target vectors along the camera path. 
Determines the distance between camera direction changes. This is 
only active if Direction is not set to Fixed point.

Distance Length of a target vector. This is only active if Direction is not set 
to Fixed point.

Surface Surface model used as reference. This is only active if Direction 
is set to Forward onto surface.

Dz
Vertical elevation difference between the reference surface and the 
target vector’s end point. This is only active if Direction is set to 
Forward onto surface.

Fixed point Forward onto surface

Forward horizontal Forward
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To view the current target vector settings:

1. Select View list command from the Target pulldown menu in the Create Flythru Movie 
dialog.

This opens the View target vectors information window:

The window shows a list of all stations along the camera path, and for each station the frame 
number, the direction, and the slope of the target vectors.

To show the location of a vector, select a line in the View target vectors window. Select 
Show location and move the mouse pointer into a view. This highlights the selected target 
vector.

To identify a vector, select Identify and click next to a vector in a view. This selects the 
corresponding line in the View target vectors window.

Creation of frames or movies

The Create Flythru Movie dialog offers the possibility to safe frames as image files (.tif) for later 
movie creation, or to safe a movie directly as .avi file. Saving frames has the advantage that frames 
from different creation processes can be combined in one movie. Additionally, frames can be 
edited by other software before they are included in a movie. For example, text can be added to 
one or more frames using image processing software.

General settings for the movie/frame creation regarding clipping, quality and speed are defined in 
the Create Flythru Movie dialog and explained in the Create Flythru Movie tool description.

Before starting the movie or frame creation, check the following points:

• The MicroStation view for creating rendered views must be open and set to a suitable size. 
The view size determines the size of the frames/movie. All frames of a movie must have the 
same size.

• All design file levels containing vector data must be switched on for the respective view in 
order to display the data in the frames/movie.

• If raster images are used for the ground model, the setting R (= Render) in the Manage 
Raster References window must be switched on for the reference images. Also, a surface 
model in TerraModeler has to be available and displayed as raster triangles. For draping the 
raster images on objects, such as building roofs, check the level setting in Define Rendering 
Settings tool.

• If laser points are included, display settings for the respective view have to be set in 
TerraScan’s Display Mode dialog, and classes have to be switched on.

The suitability of settings and display options can be tested using the preview options offered in 
the Create Flythru Movie dialog.
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To save a flythru movie directly:

1. Select Save movie command from the File pulldown menu in the Create Flythru Movie 
dialog.

This opens the Save movie dialog, a standard dialog for saving files.

2. Select a directory and type a name for the movie file.
3. Click Save.

TerraPhoto starts the recording of the movie.

To save frames:

1. Select Save frames command from the File pulldown menu in the Create Flythru Movie 
dialog.

This opens the Save movie frames dialog:

2. Define settings and click OK.

This starts saving the frames as TIFF files.

For both saving methods, frames are previewed in the MicroStation view that is defined for show-
ing rendered views. The information bar at the bottom of the MicroStation application window 
shows the number of processed frames out of the number of all frames. Depending on the number 
of frames and the amount of elements that have to be rendered, the process may take a while.

Setting: Effect:
First frame First frame number that is saved.
Last frame Last frame number that is saved.
Directory Directory on a hard disk where frames are saved.

Prefix Text that is added in the beginning of the image file names. The 
frame number is automatically added to the file name.



Creation of movies from frames

A movie can be created from previously saved frames using the Build Movie From Frames tool 
from TerraPhoto Render tools. The Build Movie From Frames dialog shows a list of all frames 
used for movie creation and a preview of the images. It further provides commands for importing 
single image files or all files from a directory, for saving a movie as .avi file, as well as for copying 
or removing frames.

To import individual image files:

1. Select Import files command from the File pulldown menu in the Build Movie From 
Frames dialog.

This opens the Movie frames dialog, a standard dialog for importing files.

2. Define the image files for import.

The software checks the files and adds them to the list of frames.

To import all image files from a directory:

1. Select Import directory command from the File pulldown menu in the Build Movie From 
Frames dialog.

This opens the Movie frame directory dialog, a standard dialog for selecting a directory.

2. Define the directory for import.

The software checks the files in the directory and adds them to the list of frames.

To remove all image files from the list of frames:

1. Select New command from the File pulldown menu in the Build Movie From Frames 
dialog.

This removes all frames from the list.

Imported images can be cut, copied, and pasted using menu commands from the Edit pulldown 
menu in the Build Movie From Frames dialog. This is useful to remove single images from the 
list or to change the order of images. A copied image is pasted before a selected image in the list.

Copy and paste can be used, for example, to lengthen the display of a certain frame. This may be 
useful for a title frame which is then shown for a longer time than other frames in the final movie. 
To achieve that, copy the image for the title frame and paste it several times at the beginning of 
the list.
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The images can be previewed in a fast way using the <Arrow up> and <Arrow down> keys.

If frames from different camera paths or saving steps are combined in the same movie, make sure 
that the size of the frame images is equal. Only frame images with the same size can be combined 
in one movie. The View Save/Recall option of MicroStation can be used, for example, to save the 
view size for creating the frames.

To save a movie from frames:

1. Select Save As command from the File pulldown menu in the Build Movie From Frames 
dialog.

This opens the Save Movie dialog:

2. Define a directory and file name for the movie in the File field. You can use the Browse 
button or type the paths manually into the field.

3. Set a Speed value in order to define the display speed of the movie in frames per second.
4. Click OK.

This starts the movie creation. The information bar at the bottom of the MicroStation 
application window shows the number of recorded frames out of the number of all frames.

As frames are already rendered images, the recording using the Build Movie From Frames tool is 
faster than creating a movie directly from the Create Flythru Movie dialog. However, depending 
on the amount of images, the import of the frame images, and the recording process may take some 
time.
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Project Workflow
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Airborne orthorectification projects
Depending on the characteristics of the camera system and the desired quality level of the final 
orthophotos, a rectification project can require a large amount of effort or nearly no operator work 
at all.

Some of factors affecting the project workflow include:

• How good is the raw positioning?
• How good is GPS/IMU trajectory?
• Is the image timing accurate?

• How stable and well known is the camera?
• Is the internal geometry of the camera known beforehand?
• Is the camera misalignment known beforehand?

• How good are the raw images visually?
• Have light conditions been uniform during the flight session?
• Is there a color cast or other coloring problems in the images?

• What are the requirements for the final orthophotos?
• Reasonable positional quality only or best achievable positional quality?
• True orthophotos or normal orthophotos?
• Does the orthophoto mosaic need to be visually high quality without any detectable 

seamlines?

This chapter outlines two possible strategies for an orthorectification workflow. These two 
strategies represent two extreme cases: the minimum effort and the maximum effort possibility. 
You will probably choose a strategy which is somewhere in between these two extremes.
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Minimum effort project strategy

This workflow outline is based on the following conditions:

• Reasonable positional accuracy is enough for the orthophotos.
• Image timing and raw positioning is accurate.
• The camera system is stable and the internal geometry of the camera is known beforehand.
• Final orthophoto does not have to be high quality - it is acceptable to have some detectable 

seamlines.

These circumstances make it possible to choose a quite automatized workflow with very little 
operator time spent on the job. The project workflow may proceed with the following steps:

1. Create a TerraPhoto camera calibration file using values from a previous calibration.
2. Define a mission with New mission command.
3. Import trajectories using Manage Camera Trajectories tool.
4. Create an image list with Compute list command.

OR

3. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto 
Settings.

4. Create an image list by importing exterior orientation files with Load list command.

If you use data from a Pictometry system, the camera calibration files, the mission file, and the 
image list can be created automatically by importing the Pictometry survey file. See Import 
Pictometry Survey command.

5. Create thumbnail versions of raw images with Create thumbnails command.
6. Enter tie points with Define tie points command in a few (5-10) images. You should choose 

images from a couple of different locations. Choose places which have clearly identifiable 
objects on the ground (such as paint markings on asphalt) and have a good overlap pattern 
(crossing flight lines if possible).

7. Create an Output report to make sure that the starting mismatch of the tie points is at an 
acceptable positional level and that the camera misalignment angles match the camera 
parameters.

If the camera misalignment is not valid, apply new values given in the report. Make sure that 
the tie point mismatch is small after applying the new misalignment angles.

8. Search for automatic color points with Search points command from the Color points 
menu for balancing color differences between neighbouring images.

9. Create tile rectangles with Place tile array command.
10. Run orthorectification with Rectify mosaic command using the image list based on raw 

positioning and color points.
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Maximum effort project strategy

This workflow outline is based on the following conditions:

• You want to produce the best possible positional accuracy for the orthophotos.
• Image timing is accurate.
• Raw positioning is decent but not necessarily the highest accuracy.
• Some of the camera parameters are unknown or inaccurate for the project.
• Seamlines and coloring changes are not acceptable in the final orthophotos.

1. Create a TerraPhoto camera calibration file using known values from a previous calibration.
2. Define a mission with New mission command.
3. Import trajectories using Manage Camera Trajectories tool.
4. Create an image list with Compute list command.

OR

3. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto 
Settings.

4. Create an image list by importing exterior orientation files with Load list command.

If you use data from a Pictometry system, the camera calibration files, the mission file, and the 
image list can be created automatically by importing the Pictometry survey file. See Import 
Pictometry Survey command.

5. Create thumbnail versions of raw images with Create thumbnails command.
6. Use Define color corrections command to check the overall coloring of the raw images 

and apply color adjustments if necessary.
7. Enter enough tie points with Define tie points command to validate and fine tune camera 

parameters. This part of the workflow is described in detail in Section Adjust camera 
parameters for Airborne projects on page 119.

8. Produce an adjusted image list with Adjust positions command. You would typically adjust 
heading, roll, and pitch angles of each image in the list.

9. Check the image list against control points. Apply an xy transformation if necessary.
10. Create color points with Search points command from the Color points menu to balance 

color differences between neighbouring raw images.
11. Modify seamlines between neighbouring images with commands from the Color points 

menu.
12. Create tile rectangles with Place tile array command.
13. Run orthorectification with Rectify mosaic command using the adjusted image list, color 

points, and seamline shapes.
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Mobile system projects
This chapter outlines typical processing workflows for images from mobile systems. Usually, 
mobile systems include several cameras, such as down-looking and side-looking cameras. The 
first part in the processing workflow is to check the calibration of the camera system and possibly 
improve the camera parameter values using tie points. Images from down-looking cameras can 
then be used to create orthophotos of the ground (e.g. of the road surface). The images from side-
looking cameras may be utilized to assign color values to laser points.

Furthermore, images of the road surface allow the collection of specific tie point types that can be 
utilized by TerraMatch for the derivation of corrections values. This supports the correction of the 
trajectory drift for high-accuracy work.

Creating orthophotos and colored point clouds

1. Create TerraPhoto camera calibration files for each camera using the commands in the 
TerraPhoto camera dialog.

2. Define a mission with New mission command.
3. Import trajectories using Manage Camera Trajectories tool.
4. Create an image list with Compute list command.

OR

3. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto 
Settings.

4. Create an image list by importing exterior orientation files with Load list command.

If you use data from a Lynx system, the camera calibration files, the mission file, and the image 
list can be created automatically by importing the Lynx survey file. See Import Lynx Survey 
command.

5. Create thumbnail versions of raw images with Create thumbnails command.
6. Use Define color corrections command to check the overall coloring of the raw images 

and apply color adjustments if necessary.
7. Enter enough tie points with Define tie points command to validate and fine tune camera 

parameter values. This part of the workflow is described in detail in Section Adjust camera 
parameters for Mobile ground-based projects on page 119.

8. Reduce the image list to images from a camera that sees the ground with the Delete / By 
camera command.

9. Adjust Position and Rectify center parameters in the TerraPhoto camera dialog in order 
to reduce edge effects along image seamlines.

10. Create color points using commands from the Color points menu to balance color 
differences between neighbouring raw images.

11. Create selection shapes using commands from the Color points menu in order to remove 
artifacts from moving objects.

12. Create tile rectangles with Place tile array command.
13. Run orthorectification with Rectify mosaic command using the reduced image list, color 

points, and seamline shapes.
14. Reload the complete image list. Reduce the image list to images from side-looking cameras.
15. Use TerraScan commands in order to assign colors from raw images to laser point classes 

above the ground.
16. Attach the orthophotos of the ground with commands from the Manage Raster References 

window.
17. Use TerraScan commands in order to assign colors from the orthophotos to laser points on 

the ground.
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Deriving TerraMatch correction values from images

Images of the road surface can be used to define tie points from which TerraMatch corrections 
values can be derived. The tie points can be created from control points drawn into the design file 
(absolute control) or by placing them in images of different drive paths (relative control). The tie 
points are of Tie point types “Known depth” or “Depth”. These tie points at regular distances 
along the road allow the derivation of fluctuating correction values for TerraMatch.

The workflow involves TerraMatch functionality which is not described here. For more 
information refer to the TerraMatch User’s Guide available at www.terrasolid.com.

1. Create TerraPhoto a camera calibration file for the camera that sees the ground best 
(downward-looking camera) using the commands in the TerraPhoto camera dialog.

For the present workflow, only images that see the road surface as vertical as possible are 
needed. However, it is also possible to create the camera calibration files and image list for 
all cameras of the system and then reduce the image list to images captured by a downward-
looking camera.

2. Define a mission with New mission command.
3. Import trajectories using Manage Camera Trajectories tool.
4. Create an image list with Compute list command.

OR

3. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto 
Settings.

4. Create an image list by importing exterior orientation files with Load list command.

If you use data from a Lynx system, the camera calibration files, the mission file, and the image 
list can be created automatically by importing the Lynx survey file. See Import Lynx Survey 
command.

5. Create thumbnail versions of raw images with Create thumbnails command.
6. Define tie points for adjusting the images to the laser data and for deriving TerraMatch 

correction values. This part of the workflow is described in detail in Section Ground 
control points for Mobile ground-based projects on page 123.
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This chapter describes the basic steps required to setup a project in TerraPhoto. TerraPhoto refers 
to a project with the term ‘mission’.

The task of setting up a mission includes the following steps:

1. Create a suitable directory structure on the hard disk for storing the data.
2. Create or copy an initial camera calibration file.
3. Create a mission definition.
4. Create an image list.
5. Create thumbnails (optional).

The production of rectified images or ortho photos, as well as the placement of certain types of tie 
points require a ground model. The ground model can be loaded into TerraPhoto either from laser 
points loaded in TerraScan or directly from a laser point file. Most often it makes sense to load the 
ground model as one step of the mission setup workflow, for example, after defining the mission.

Mission directory structure

You probably want to create a master directory for each TerraPhoto project. This master directory 
would contain all the data for that project.

The list below shows an example directory structure:

c:\data\hut200 master directory of HUT200 project

camerapath raw camera trajectory files

dgn design files

images raw images

laser classified laser data and/or the ground model file

laserraw raw laser point files (not used inTerraPhoto)

mission mission, camera calibration, image list, tie point, and color point files

ortho orthophotos

temp temporary files required for TerraPhoto processing

trajectory imported TerraPhoto trajectories

Camera calibration file

The camera calibration file is created by one of the options described in Chapter Camera 
Calibration on page 46. Alternatively, a camera calibration file of a previous project may be used 
if the data was collected with the same and unchanged system.

Mission definition

TerraPhoto uses a mission definition to link all necessary pieces of information that belong to a 
project. This includes the following:

• Descriptive information about the mission, such as project name, location, and date.
• Output directories for rectified images and temporary files.
• List of cameras used in the mission. For each camera, the directory and name of a camera 

calibration file, the format and storage directory of the raw images, and a numbering scheme 
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are defined.

A mission is created, modified, and saved by using the commands from the Mission pulldown 
menu in the TPhoto Main window. See New mission for a description of mission settings and 
the workflow of creating a mission.

TerraPhoto provides commands for the automatic creation of mission, camera calibration, and 
image list files for certain camera systems. More precisely, TerraPhoto is able to import the output 
files of those camera systems which provide the information necessary for creating the TerraPhoto 
files. The following system output files are supported:

• Lynx system index files - see Import Lynx Survey command.
• Pictometry system files - see Import Pictometry Survey command.

Image list

An image list stores position and orientation information for each raw image. Further, it can 
contain additional information for each image, such as color correction values, quality and 
accuracy tags. TerraPhoto stores an image list as a text file with the extension .IML.

There are two common ways of creating an image list:

• Link image timing file(s) with trajectory information. This requires that the time stamps of the 
trajectories in TerraPhoto match with the time stamps stored for each raw image in an image 
timing file. 

The process includes two steps:

1. Import trajectories into TerraPhoto using the commands Set directory and Import files 
of the TerraPhoto Trajectories window. See Manage Camera Trajectories for detailed 
information.

2. Compute an image list from the image timing file(s) using the Compute list command 
of the TPhoto Main window.

• Import exterior orientation files. This requires that the format of the exterior orientation files 
is defined in Exterior orientation formats of the TerraPhoto Settings. The files are imported 
and converted into a TerraPhoto image list using the Load list command of the TPhoto Main 
window.

If the data was collected with a Lynx system or a Pictometry system, the image list can be created 
automatically from the system output files. See previous Section Mission definition for more 
information.

Thumbnails

Thumbnails are images of reduced resolution and used for a faster display of the raw images. They 
are created by Create thumbnails command from the Utility pulldown menu in the TPhoto 
Main window. Thumbnails for multiple resolution ratios can be created in one processing step.

Thumbnails are used by:

• Define color corrections display
• Active full view in tie point mode
• Define color points display

It is strongly recommended to create thumbnails at the beginning of the processing workflow, 
bacause they speed up the image display for these processes essentially.
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The best method of getting camera calibration parameters for TerraPhoto is to derive the 
parameters from a calibration data set using TerraPhoto itself. When the calibration data set is 
captured, the camera is operated in conditions similar to the actual project data collection. In 
addition, the calibration task serves as good verification of the overall accuracy of all system 
components.

Calibration data sets are usually collected at specific locations. These calibration sites should 
provide optimal conditions for the data collection. They are described in Sections Calibration site 
on page 61 for airborne systems and Calibration site on page 64 for mobile ground-based 
systems.

If you do not have any calibration document to start from, you need to derive initial values for the 
calibration parameters yourself. This is outlined in Section Starting values from scratch on page 
49.

Another way is to convert system-specific calibration parameters into a TerraPhoto calibration 
file. There are several common system calibration formats implemented in TerraPhoto that enable 
the conversion. The conversion is done by using the Tools / Convert from command in the 
TerraPhoto camera dialog. It is usually required to improve the converted calibration values 
with the normal calibration workflow in TerraPhoto.

The result of the camera calibration is a set of calibration values that work nicely from one project 
to another. It is still expected that you have to fine tune misalignment angles for each mission as 
the IMU initialization offset probably causes a small systematic error.

TerraPhoto camera calibration parameters
The TerraPhoto camera model specifies the following dimensions and parameters of the camera:

• Resolution of images - this is defined by Image width and Image height.
• Dimensions of the image plate - this is defined by Plate width and Plate height. For digital 

cameras the values are the same as for Image width and height.
• Timing offsets - timing corrections to add to the camera event times when computing an 

image list. They are defined by Timing offset and Exposure.
• Lever arm - an offset vector to add to trajectory positions when computing an image list. The 

offset vector points from trajectory positions to the focal point of the camera and is defined by 
Lever X, Lever Y, and Lever Z.

• Camera misalignment - orientation difference between IMU and camera. Defined by 
Heading, Roll, and Pitch misalignment angles.

• Principal point position - position of the focal point relative to the image center. This is 
defined by X, Y, and Z image coordinates.

• Lens distortion - a function that models the difference between the lens and a perfectly 
spherical shape. There are different models available whose constant parameters depend on 
the type of the function.

Camera parameter groups

TerraPhoto adjusts camera parameters in groups instead of solving all parameters at the same time 
with a single routine.

The Misalignment angles form one group that you can solve separately. This makes sense as the 
misalignment angles depend on the camera mount and thus, they change every time the camera is 
removed and reinstalled.

The second parameter group deals with the internal geometry of the camera. This group includes 
the Principal point and lens distortion. These parameters should not change as long you do not 
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disassemble the camera and there is no internal movement of the parts inside the camera.

The third parameter group relates to Timing and Exposure problems. TerraPhoto provides some 
basic capabilities for solving timing issues manually but it is primarily written for data sets where 
image timing and raw positioning is good.

Misalignment angles
Heading, roll, and pitch misalignment values define the difference between the values reported by 
the inertial measurement unit (IMU) and the true camera orientation. These values represent how 
the camera is mounted into the aircraft and are not dependent on the internal structure of the 
camera as most of the other camera parameters.

If the values are completely unknown, you should try to derive initial values with the help of 
Camera Views. It is possible to achieve about 0.1 degree accuracy with this method.

To improve the misalignment values, you need to enter some tie points. See Chapter Working 
with Tie Points for detailed information. As soon as you have entered a few points, you can use 
the Output report command in the Tie points window in order to create a report which contains 
the optimal values. The application determines what misalignment values produce the smallest 
mismatch distances for the tie points and writes these values in the report.

The adjustment of the misalignment angles to optimal values is an iterative process. As soon as 
you have a handful of images well-defined with tie points (e.g. 5-6 ground tie points per image for 
airborne data), you should achieve fairly good misalignment angles. The more images are well-
defined, the more stable the misalignment angles become until they do not change any more unless 
you make changes to other camera parameters.

Roll and pitch misalignment angles correlate highly with principal point x and y parameters for 
airborne data sets collected from one altitude above ground. For cameras in landscape orientation, 
a small change of the roll angle has almost the exact same effect as moving the principal point x 
position slightly. A small change of the pitch angle has almost the exact same effect as moving 
principal point y position.

For corridor projects, if images have been collected in only one survey direction, tie points provide 
a reliable solution only for the heading misalignment angle. Roll and pitch misalignment angles 
have a very small effect on the tie point matching in such data sets. In this case, camera views are 
the only way to verify roll and pitch misalignment angles.

Principal point and lens distortion
Principal point and lens distortion define how much the lens differs from a perfect spherical shape 
and what is the position of the CCD plate compared to the lens. The parameters define the internal 
geometry of the camera.

The values of the parameters should remain pretty stable from one mission to another. You should 
use a good calibration data set for deriving these values. An ideal data set is collected at a suitable 
calibration site, includes close to 100% overlap between images of different strips, and provides 
many clearly identifiable objects for placing tie points.

In order to solve principal point and lens distortion, you need to collect a good number of tie points 
that are well distributed over the raw images. In airborne missions, if the flight pattern is optimal 
with 100% overlap, Ground tie points for 20 images should be enough. If the images are captured 
with smaller overlap, tie points are needed in more images.

In mobile missions, tie lines of the type Straight line are best suited for solving the principle point 
z and the lens distortion with a Zero radius function. Good tie lines are placed along image edges 
and as long as possible. There should be a few Straight lines close to all four image edges.

The optimal values for principal point and lens distortion are computed by the Tools / Solve 
parameters command of the Camera dialog.
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Lens distortion models
The lens distortion can be modeled as Zero radius function, Function or Balanced function 
which are very similar to each other. All three models include equations for radial distortions and 
for tangential distortions.

Radial distortion of the Zero radius function model:

dx = -rx * ((A  * (d2 - R2)) + (B * (d4 - R4))) 
dy = -ry * ((A  * (d2 - R2)) + (B * (d4 - R4))) 

Radial distortion of the Function model:

dx = -rx * ((A  * d2) + (B * d4) + (C * d6)) 
dy = -ry * ((A  * d2) + (B * d4) + (C * d6)) 

Radial distortion of the Balanced function model:

dx = -rx * (K0 + (K1 * d2) + (K2 * d4)) 
dy = -ry * (K0 + (K1 * d2) + (K2 * d4)) 

Tangential distortion of all three models:

dx = P1 * (d2 + 2.0*rx*rx) + 2 * P2 * rx * ry
dy = P2 * (d2 + 2.0*ry*ry) + 2 * P1 * rx * ry

In all of the above equations:

dx is shift from original pixel to correct location
dy is shift from original pixel to correct location
rx is pixel coordinate relative to focal point
ry is pixel coordinate relative to focal point
d is pixel distance to focal point

A is Radial A3 setting
B is Radial A5 setting
C is Radial A7 setting
R is Zero radius setting
K0 is K0 setting
K1 is K1 setting
K2 is K2 setting
P1 is Tangential P1 setting
P2 is Tangential P2 setting

In addition to the three model above, the lens distortion can also be modeled as Homogenous 
function. The function does not include equations for radial distortions.

Finally, the lens distortion can be modeled as a Grid of xy shift vectors. The correction vectors 
are expressed as 1/100th of a pixel.

Timing and Exposure
The timing offset parameters take effect when you use Compute list command from the Images 
pulldown menu for creating a TerraPhoto image list. The values are zero if the time stamps in 
image timing files do not have a constant error.

There is no tool in TerraPhoto for directly solving timing offset problems. If you suspect a 
constant time offset, you can use a manually-driven strategy to find the best offset value. This 
simply involves that you test different timing offset values and determine what value results in the 
smallest mismatches for tie points. Whenever you change the timing offset, you have to optimize 
the pitch misalignment angle at the same time in order to compensate for the change.
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Starting values from scratch

In most cases, you start with an existing camera calibration file that was used for a previous 
project. This reduces the effort of the calibration significantly because most of the camera 
parameters should be stable or very close to previous values.

If the camera is used for the first time with TerraPhoto, you need to create a new camera 
calibration file. Some system providers deliver calibration values from a system calibration that 
can be converted into TerraPhoto calibration values. See Tools / Convert from command from 
the Camera dialog for more information.

If system calibration values can not be used, you need to start the calibration in TerraPhoto from 
scratch. There are a few calibration parameters for which you have to define initial values before 
you start with the actual calibration work:

• Image width and Image height (image size in pixels)
• Plate width and Plate height (= image size in pixels for digital cameras)
• Orientation
• Timing offset (usually 0.0)
• Lever arm XYZ fields
• Principal point z
• Zero radius

You should set all other fields to zero.

Lever arm
The lever arm vector is one of the parameters which correlates highly with other parameters. It is 
best to measure the lever arm vector separately and not try to solve it from an airborne calibration 
data set.

The lever arm vector defines the offset from the input trajectory information to the focal point of 
the camera. Depending on the exact position for which the trajectory is computed, the lever arm 
vector describes the offset between the camera and the IMU, the GPS receiver, or the laser 
scanner. If the trajectory is computed for the camera, all lever arm components are zero.

An accuracy level of about 1 centimeter is sufficient for the lever arm information. If you fine tune 
the misalignment angles for each flight session, you can compensate a small inaccuracy of the 
lever arm vector.

Principal point z
You can compute a reasonable initial value for the Principal point z if you known the 
approximate focal length of the camera in millimeters and the CCD pixel size. The equation is:

Principle point z = -FocalLength / PixelSize

For example, if focal length is 50 mm and pixel size is 0.0068 mm, the principle point z value is:

-50 / 0.0068 = -7353

Zero radius
The Zero radius function is the preferable model for radial lens distortion. The initial value for 
the Zero radius should fit inside the image and can be calculated by taking slightly less than half 
of the image width or height, whatever is smaller.

Examples:

• Image size is 7228 * 5428 pixels, use 2500.
• Image size is 3056 * 2032 pixels, use 1000.
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TerraPhoto camera dialog
The camera calibration values are defined in the Camera dialog of TerraPhoto that is opened by 
the Define Camera tool. Additionally, the dialog contains pulldown menu commands for opening 
and saving the camera calibration into a file, for solving camera parameters, converting from and 
to system-specific calibration files, and assigning bad and poor polygons to cameras.

Setting: Effect:
Camera Name of the camera for which the parameters are shown in the 

dialog. The camera names are available if a mission is loaded into 
TerraPhoto. For creating a new camera file, select Free definition.

Description Description of the camera.
Image width Width of an image in pixels.
Image height Height of an image in pixels.

Margin Distance from image boundaries that are ignored for processing. 
Given in pixels.
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Plate width Width of the CCD plate or film. Same value as Image width for 
digital cameras.

Plate height Height of the CCD plate or film. Same value as Image height for 
digital cameras.

Orientation

General orientation of an airborne camera relative to the flight 
direction:
• Top forward - the top edge of images points forward.
• Bottom forward - the bottom edge of images points forward.
• Right forward - the right edge of images points forward.
• Left forward - the left edge of images points forward.
• Mobile, side looking - setting for all cameras of mobile 

ground-based systems.

Panoramic

If on, the calibration values are for a panoramic camera. This 
removes input fields for principle point X and Z, and for lens 
distortion from the camera dialog. This is only active if 
Orientation is set to Mobile, side looking.

Position
Defines the center of a rectified image for mobile system cameras. 
The value highly correlates with the Rectify center value. This is 
only active if Orientation is set to Mobile, side looking.

Rectify center Defines the center of a rectified image for mobile system cameras. 
The value is expressed in percent from the bottom edge of an 
image. The value highly correlates with the Position value. This is 
only active if Orientation is set to Mobile, side looking.

Timing offset Time value in seconds that is added to the time stamps of raw 
images if an image is computed with the Compute list command.

Exposure Timing difference between xyz position and attitude in Compute 
list menu command. Zero value means that xyz position and 
attitude are interpolated from the same position on the trajectory. 
Positive value means that attitude is computed from a later position 
on the trajectory.

Lever arm X Lever arm vector component. A positive value points to the right. 
Given in meter.

Lever arm Y Lever arm vector component. A positive value points forward. 
Given in meter.

Lever arm Z Lever arm vector component. A positive value points up. Given in 
meter.

Heading Heading misalignment angle. A positive value indicates clockwise 
rotation. Given in degree.

Roll Roll misalignment angle. A positive value indicates left wing up 
rotation. Given in degree.

Pitch Pitch misalignment angle. A positive value indicates nose up 
rotation. Given in degree.

X Principal point x position relative to the image center.
Y Principal point y position relative to the image center.
Z Principal point z position as a negative value.
Define as Function type that models the lens distortion. See Lens distortion 

models for more information.
Radial A3, A5 Constants for radial lens distortion functions.
Zero radius Radius at which the lens distortion of a Zero radius function is 0.
Radial A7 Constant for the radial lens distortion model of type Function.
K0 ... K4 Constants for lens distortion models of types Balanced function 

and Homogenous function.

Setting: Effect:
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The measurement unit for Plate width, Plate height and principal point X, Y, Z coordinates can 
be pixel or millimeter or some other unit but the same must be used for all these parameters. Pixel 
is the recommended unit as it is easiest to understand.

Tangential P1, P2 Constants for lens distortion functions.
Columns Number of columns used for solving lens distortion by a Grid.
Rows Number of rows used for soving lens distortion by a Grid.

Setting: Effect:
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File / Open

Open command reads previously saved calibration values from a file on the hard disc.

File / Save

Save command saves the calibration values to the same file from which they have been opened 
before.

File / Save as

Save As command saves the calibration values into a new file. TerraPhoto stores the calibration 
values in a text file with the extension .CAL.
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Tools / Solve parameters

Solve parameters command computes optimal values for principle point coordinates and lens 
distortion functions. The computation is based on tie points. The process can use active tie points 
or tie points saved into a file.

To solve principal point and lens distortion parameters:

1. Collect a good number of tie points.
2. Select Solve parameters command from the Tools pulldown menu.

This opens the Solve camera parameters dialog:

3. Select settings and click OK.

The software computes the values for the selected parameters. It updates the values in the 
Camera dialog.

4. Select File / Save or File / Save as commands from the File pulldown menu in order to save 
the calibration values into a file.

5. If active tie points were used for solving the parameters, click the Apply button in the 
Camera dialog in order to recompute the tie points.

Setting: Effect:
Solve for Camera(s) for which parameter values are computed:

• Active camera - camera that is set in the Camera field of 
the Camera dialog.

• All cameras in mission - all cameras that are defined for the 
active mission.

Use Source of tie points used for the computation:
• Active tie points - tie points that are active in TerraPhoto.
• Tie point file - tie points saved in a file on the hard disc.

Tie points Directory and name of the file storing the tie points. This is only 
active if Use is set to Tie point file.

Solve principle point xy If on, the software computes the optimal value for the principle 
point X and Y coordinates.

Solve principle point z If on, the software computes the optimal value for the principle 
point Z coordinate.

Solve lens distortion If on, the software computes the optimal values for the lens 
distortion parameters.

Using Source tie points/lines for computing the lens distortion values:
• Tie points - tie points are used.
• Straight lines - only tie lines of type Straight line are used.

This requires that the lens distortion is defined as Zero radius 
function and Straight lines must be available in the tie point 
file.
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Tools / Convert from

Convert from command is used to convert system-specific calibration values into TerraPhoto 
calibration values. Many system providers deliver a document for their camera system that 
includes the values of the system calibration.

TerraPhoto implements the conversion of several common types of system calibrations:

Sometimes the calibration of other systems contain the same parameters as one of the 
implemented conversions. Therefore, it is recommended to check the implemented conversions 
even if the system is from another provider.

The conversion does usually not include the size of the images and the overall orientation of the 
camera in the system. Only some calibration documents contain a lever arm vector. These values 
must be set manually in the Camera dialog.

To convert camera values from a system-specific calibration document:

1. Open the Camera dialog.
2. Select Free definition in the Camera field.
3. Define the image size in pixels in the Image width and Image height fields.
4. Define the same values for Plate width and Plate height.
5. Select the camera orientation in the Orientation field.
6. If necessary, define the lever arm vector in Lever arm X, Lever arm Y, and Lever arm Z 

fields.
7. Select Convert from command from the Tools pulldown menu and choose the correct 

system calibration type.

This opens the Conversion dialog:

The settings in the dialog depend on the selected calibration type. They should be explained 
in the calibration document delivered by the system provider.

8. Define values and click OK.

• DiMAC • Riegl VMX
• iWitness • Rollei
• Leica RCD • Trimble MX8
• Matlab • US / Applanix
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This converts the calibration values into TerraPhoto equivalents. The converted values 
usually need to be improved by following the normal TerraPhoto calibration workflow.

9. Select File / Save or File / Save as commands from the File pulldown menu in order to save 
the calibration values into a TerraPhoto .CAL file.

The system-specific calibration values can be saved into a text file. Use the Save as command 
from the File pulldown menu in the Conversion dialog. This creates a file with the extension 
.CSV. The text file can be opened by the Open command from the File pulldown menu.

For certain camera systems, there is another option for the automatic creation of the camera 
calibration file(s). More precisely, TerraPhoto is able to import the output files of these camera 
systems which provide the information necessary for creating the TerraPhoto files. The following 
system output files are supported:

• Lynx system index files - see Import Lynx Survey command.
• Pictometry system files - see Import Pictometry Survey command.
• Mitsubishi system files - see Tools / Import Mitsubishi cameras command.
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Tools / Import Mitsubishi cameras

Import Mitsubishi cameras command can be used to create a TerraPhoto camera calibration file 
for Mitsubishi Mobile Mapping Systems (MMS). The system provider delivers two text files, one 
for the configuration of the system on a vehicle, and the other for the actual camera calibration 
values.

To import Mitsubishi MMS cameras:

1. Select Import Mitsubishi cameras command from the Tools pulldown menu.

This opens the Import Mitsubishi Cameras dialog:

2. Define values and click OK.

This converts the calibration values into TerraPhoto equivalents. The .CAL files are saved in 
the given folder.
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Tools / Convert to

Convert to command is used to convert TerraPhoto calibration values into system-specific 
calibration values. TerraPhoto implements the conversion into several common types of system 
calibrations:

The lens distortion model used in TerraPhoto determines if the calibration values can be converted 
into a specific system calibration or not. The converted values can be save into a text file.

To convert camera values into system-specific calibration values:

1. Select Convert to from the Tools pulldown menu.

This opens the Convert to outside calibration dialog:

2. Select a calibration to which you want to convert.
3. Define settings and click OK.

This opens the Camera calibration window that shows the converted calibration values. 
From this window, a text file can be saved or printed by using commands from the File 
pulldown menu. The commands in the View pulldown menu can be used to change the size 
of the window.

• iWitness
• Leica RCD
• Rollei
• US / Applanix

Setting: Effect:
Convert to Target calibration system. The availability in the list depends 

on the lens distortion function in the Camera dialog.
Pixel size CCD or film pixel size. Required to convert pixels into 

millimeters.
Radial step Interval for writing the radial lens distortion table. This is only 

active if Convert to is set to US / Applanix calibration.
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Tools / Assign poor polygons

Assign poor polygons command is used to define areas in images of one camera that should be 
avoided in rectification processes. Such areas may be caused, for examples, by dust on the camera 
lens or by other small artefacts which lead to small flaws at the same location in all images.

Such areas are marked in one raw image by a polygon. Then, the polygon can be defined as “poor 
polygon” for a camera in the Camera dialog. Areas inside poor polygons are excluced from 
automatic tie point and color point searches. In rectification processes, they are filled from other 
images whenever possible.

The polygons are stored in the camera calibration files. The coordinates of the vertices of the 
polygons are listed for each polygon separately in the calibration file of the effected camera.

To assign a poor polygon:

1. Select Manage Raster References in order to open the Manage Raster References window 
of TerraPhoto.

2. Attach a raw image as raster reference using Attach files command from the File pulldown 
menu.

3. Select Modify attachment command from the Edit pulldown menu.
4. In the Modify attachment dialog, define the following values:

• Easting origin = 0.0000 Pixel size = 1.00000
• Northing origin = 0.0000 Pixel size = 1.00000

5. Select Fit / Selected command from the View pulldown menu. Place a data click inside a 
MicroStation top view in order to display the image.

6. Digitize a polygon around the area that should not be used from the images of the camera. 
Any MicroStation tool for creating shape elements can be used.

You may create several polygons that can be defined as poor polygons in one step.

7. Select the polygon using any MicroStation Selection tool.
8. Select Define Camera tool in order to open the Camera dialog.
9. Select the correct camera name in the Camera field.
10. Select Assign poor polygons command from the Tools pulldown menu.

This defines the selected polygon as poor polygon. The number of Poor areas is displayed 
in the Camera dialog.

11. Select File / Save or File / Save as commands from the File pulldown menu in order to save 
the polygons into a camera calibration file.
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Tools / Assign bad polygons

Assign bad polygons command is used to define areas in images of one camera that are unusable 
for TerraPhoto processes. Such areas may occur, for examples, if a camera always sees a part of 
the aircraft or car on which the system is mounted.

Such areas are marked in one raw image by a polygon. Then, the polygon can be defined as “bad 
polygon” for a camera in the Camera dialog. Areas inside bad polygons are excluced from 
automatic tie point and color point searches, from rectification processes, and from the extraction 
of RGB colors for laser points.

The polygons are stored in the camera calibration files. The coordinates of the vertices of the 
polygons are listed for each polygon separately in the calibration file of the effected camera.

To assign a bad polygon:

1. Select Manage Raster References in order to open the Manage Raster References window 
of TerraPhoto.

2. Attach a raw image as raster reference using Attach files command from the File pulldown 
menu.

3. Select Modify attachment command from the Edit pulldown menu.
4. In the Modify attachment dialog, define the following values:

• Easting origin = 0.0000 Pixel size = 1.00000
• Northing origin = 0.0000 Pixel size = 1.00000

5. Select Fit / Selected command from the View pulldown menu. Place a data click inside a 
MicroStation top view in order to display the image.

6. Digitize a polygon around the area that can not be used from the images of the camera. Any 
MicroStation tool for creating shape elements can be used.

You may create several polygons that can be defined as bad polygons in one step.

7. Select the polygon using any MicroStation Selection tool.
8. Select Define Camera tool in order to open the Camera dialog.
9. Select the correct camera name in the Camera field.
10. Select Assign bad polygons command from the Tools pulldown menu.

This defines the selected polygon as bad polygon. The number of Bad areas is displayed in 
the Camera dialog.

1. Select File / Save or File / Save as commands from the File pulldown menu in order to save 
the polygon into a camera calibration file.
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Airborne camera calibration

Calibration site

Any site with easily identifiable features on the ground is a good choice for airborne camera 
calibration. You would normally choose an urban area with roads and parking lots or an airfield 
where there are a lot of paint markings on asphalt.

If the actual project area includes such a place that fulfills the requirements of a calibration site, it 
is possible to use data from this place for calibration purposes. It just requires that the place is 
covered by the recommend Flight pattern in order to collect suitable calibration data.

TerraPhoto needs a ground model of the calibration site. Therefore, you should collect laser data 
during the same flight. However, you can also use a ground model from another flight.

It is beneficial but not required to have some ground control measurements from the site. They can 
be utilized to eliminate any systematic elevation shifts in the ground model before it is used in 
TerraPhoto.

Flight pattern

For calibration, it is easiest to cover one small area with multiple crossing flight lines. This results 
in nearly 100% overlap between some of the images.

The same location needs to be captured from at least two different flight altitudes. This helps to 
differentiate some of the camera parameters from each other. The camera parameters highly 
correlate with each other if images from only one altitude are available.

The following figures illustrate the minimum flight pattern:

An ideal data set can be produced by flying the same site at three different altitudes, for example 
500 m, 1000 m, and 2000 m.

Flight pattern in a top view. Flight pattern in a perspective view.
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Calibration workflow

The calibration process can be devided into three phases. The aim of the first phase is the rough 
positioning of the images based on reference data. In this phase, mainly the correct geographical 
location of the images and the overall orientation of the camera are checked. The second phase 
involves the manual and half-automatic placement of tie points. They are used to calibrate the 
misalignment angles and the principle point z value. In the third phase, the final calibration values 
are fixed by solving all possible camera parameters based on the tie points.

Phase 1: Camera view
A camera view makes it possible to derive reasonable values for the camera misalignment angles 
and the principal point z. A camera view is basically a perspective view that shows the world as 
seen through a camera when it was recording an image. You can compare a single raw image with 
laser points or 3-dimensional vector data. If the image does not match the reference data, you can 
change the camera parameters in order to reach a better visual match.

If the images are not even close to the reference data, you should check if the geographical 
position of the images in the image list is correct. Camera views are also an option for validating 
that all data of a project covers the same geographical location and that no errors occured in 
coordinate transformations.

Camera views are described in detail in Section Create camera view on page 268. In this phase 
you may achieve an accuracy level of about 0.1 degree for misalignment angles.

Phase 2: Tie points for solving misalignment angles and principle point z
Tie points provide a method for calibrating most of the camera parameters. This is an iterative 
process. Some of the parameters can be adequately solved with a very small number of tie points 
while other parameters require a larger number of tie points and a data set suitable for the task. A 
higher number of tie points achieves a more accurate and a more reliable solution.

In the beginning, it is more laboursome to enter tie points as the positioning of the images is bad. 
If more tie points are available, the calibration values can be gradually improved which in turn 
makes it faster to collect more tie points and to filter out bad tie points. The quality of the tie points 
is crucial to the reliability of the calibration. Therefore, it is essential to remove bad tie points 
during the calibration process.

As soon as you have entered a few ground tie points, it is possible to solve some of the camera 
parameters. You should start with the misalignment angles and then move to the principal point 
z. The other parameters have a much smaller effect on positional accuracy.

1. Enter tie points, enter more tie points, or filter out bad tie points.

Enter Ground tie points whenever possible. Use Air tie points only if there is no way to 
place Ground tie points.

Start with the manual tie point entry mode. See Tie point entry modes.

For detailed information about placing tie points see Chapter Working with Tie Points on 
page 76, especially commands from the Point pulldown menu and the Pixel pulldown 
menu.

2. Solve and apply misalignment angles using Output report command in the Tie points 
window.

3. Go back to step 1 and continue until the modification of misalignment angles does not 
improve the average mismatch of the tie points anymore.

4. Solve principal point z using Tools / Solve parameters command in the TerraPhoto 
camera dialog.

5. Recompute the tie points by using the Apply button in the Camera dialog.
6. Go back to step 1 until images are well-defined by tie points. See Tie point values and Tie 
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point distribution.

If the mismatch distances for tie points become smaller (about 2-3 * pixel size of the raw 
images), try to switch to half-automatic tie point entry mode. See Tie point entry modes.

Continue with steps 1 to 5 until the values for the misalignment angles and principle point z 
do not change significantly anymore. The second phase should result in reasonably good 
mismatch distances in tie points (about pixel size of the raw images).

Phase 3: Solve misalignment angles, principle point xyz, and lens distortion
The third phase of the workflow solves all camera parameters that can be calibrated with tie points.

1. Solve and apply misalignment angles using Output report command in the Tie points 
window.

2. Solve all other solvable parameters using Tools / Solve parameters command in the 
TerraPhoto camera dialog and apply the changes to the tie points.

The application adjusts roll and pitch misalignment angles if it modifies principal point x and 
y values. The adjustment of the misalignment angles compensates the modification of the 
other parameters.

You may still check for bad tie points using the Find worst command from the Tie points 
window.

3. Go back to step 1 and continue until there is no more improvement and the values are stable.

The third phase produces the final calibration parameters.
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Mobile camera calibration

Calibration site

Any site with large buildings on two or more sides is a good choice for mobile camera calibration. 
The buildings should have a plane wall with easily identifiable features (such as windows, facade 
paintings, etc.) facing the road without obstacles in front of the wall. Long sharp edges in the 
images are especially useful for calibrating principle point z and lens distortion of mobile cameras.

Paint markings on asphalt add another valuable features for the calibration task. There should be 
enough space on the calibration site to turn around, drive back and forth, and maybe even drive 
crossing paths.

If the actual project area includes such a place that fulfills the requirements of a calibration site, it 
is possible to use data from this place for calibration purposes. It just requires that the place is 
covered by the recommend Drive pattern in order to collect suitable calibration data.

Drive pattern

For calibration, it is easiest to cover one small area with multiple drive paths. This results in nearly 
100% overlap between some of the images. The same building walls should be captured by each 
camera from at least two different distances.

The following figure illustrates an example drive pattern for a system with two side-looking 
cameras:

Calibration workflow

The calibration process can be devided into three phases. The aim of the first phase is the rough 
positioning of the images based on reference data. In this phase, mainly the correct geographical 
location of the images and the overall orientation of the cameras are checked. The second phase 
involves the manual placement of tie points. They are used to calibrate the misalignment angles. 
In the third phase, further tie points and straight tie lines are placed in order to solve principle point 
z and lens distortion parameters in addition to fine tuning the misalignment angles.

Drive pattern in a top view. Blue and red triangles indicate the 
views of two side-looking cameras.
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Phase 1: Camera view
A camera view makes it possible to derive reasonable values for the camera misalignment angles 
and the principal point z. A camera view is basically a perspective view that shows the world as 
seen through a camera when it was recording an image. You can compare a single raw image with 
laser points or 3-dimensional vector data. If the image does not match the reference data, you can 
change the camera parameters in order to reach a better visual match.

If the images are not even close to the reference data, you should check if the geographical 
position of the images in the image list is correct. Camera views are also an option for validating 
that all data of a project covers the same geographical location and that no errors occured in 
coordinate transformations.

Camera views are described in detail in Section Create camera view on page 268. In this phase 
you may achieve an accuracy level of about 0.1 degree for misalignment angles.

Phase 2: Tie points for solving misalignment angles
Tie points provide a method for calibrating most of the camera parameters. This is an iterative 
process. Some of the parameters can be adequately solved with a very small number of tie points 
while other parameters require a larger number of tie points and a data set suitable for the task. A 
higher number of tie points achieves a more accurate and a more reliable solution.

In the beginning, it is more laboursome to enter tie points as the positioning of the images is poor. 
If more tie points are available, the calibration values can be gradually improved which in turn 
makes it faster to collect more tie points and to filter out bad tie points. The quality of the tie points 
is crucial to the reliability of the calibration. Therefore, it is essential to remove bad tie points 
during the calibration process.

1. Enter tie points, enter more tie points, or filter out bad tie points.

Enter Air tie points first. The calibration becomes more reliable if you also enter some 
Known tie points, for example, based on objects detectable in the laser point cloud.

For detailed information about placing tie points see Chapter Working with Tie Points on 
page 76, especially commands from the Point pulldown menu and the Pixel pulldown 
menu.

2. Solve and apply misalignment angles using Output report command in the Tie points 
window.

3. Go back to step 1 and continue until the modification of misalignment angles does not 
improve the average mismatch of the tie points anymore.

If the calibration is started with values of a system-specific calibration, around 20 Air tie 
points and 5 - 10 Known tie points should be enough to get reasonable values for the 
misalignment angles.

Phase 3: Solve misalignment angles, principle point z, and lens distortion
The third phase of the workflow solves lens distortion and principle point z values. It also fine 
tunes the misalignment angles.

1. Place a good number of Straight tie lines for each camera. See Add straight line 
command.

2. Check the distribution of tie points and lines by using the Draw pixel distribution 
command. If necessary, add more tie points/lines.

The Straight lines should be placed close to the image boundaries along edges of objects 
(for example building edges). The edges, which are straight in the real world, are curved in 
the images due to the lens distortion. Long and curved edges are best for solving the lens 
distortion.

3. Open the Camera dialog and set the lens distortion model to Zero radius function.
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4. Set Radial A3 and A5, and Tangetial P1 and P2 to zero. Set the Zero radius to 
approximately half of the image height or width, whatever is smaller.

Example: if the image size is 1624 x 1236, set Zero radius to 600.

5. Solve the lens distortion using Straight lines for all cameras of the mission with Tools / 
Solve parameters command in the TerraPhoto camera dialog and apply the changes to 
the tie points.

6. Solve principal point z for all cameras of the mission using Tools / Solve parameters 
command in the TerraPhoto camera dialog.

This recomputes the tie points and saves the camera files automatically.

You may still check for bad tie points using the Find worst command from the Tie points 
window.

7. Solve and apply misalignment angles using Output report command in the Tie points 
window.

8. Go back to step 6 and continue until there is no more improvement and the values are stable.

The third phase produces the final calibration parameters.
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10 Color corrections
Color corrections in TerraPhoto are an option to improve the overall coloring of raw images. They 
include RGB color balance, intensity, saturation, and contrast modifications that are unique for a 
single raw image. In addition, a grid-based intensity correction can be applied to a raw image in 
order to adjust brightness differences between image corners and center. The correction values are 
stored in the image list. TerraPhoto applies the corrections for different processes on-the-fly:

• tie point mode
• color point display
• perspective views
• rectification

The Define color corrections dialog uses thumbnails for image display if those are available in 
the /TEMP folder of the mission. See Create thumbnails for more information.

Color corrections are useful to correct systematic coloring issues that affect a larger number of raw 
images. Examples are systematic color casts in images of one or more cameras, brightness 
differences between different parts of a project area, saturation and contrast issues in images of 
one or more strips, etc.

Define color corrections dialog
Color corrections are usually applied to the unadjusted image list, especially if the coloring issues 
affect the (half-) automatic placement of tie points. However, color corrections can be applied at 
any time in the processing workflow.

Before starting with color corrections, images can be analyzed using Analyze images command 
from the Utility pulldown menu in the TPhoto Main window. The command results in a report 
of average color, intensity, saturation, and contrast values for each image as well as an average 
value for all or selected images. Therefore, it can be used to get an idea about coloring issues that 
possibly need to be corrected.

The color corrections are defined in the Define color corrections dialog which is opened by the 
Define color corrections command from the Image pulldown menu in the TPhoto Main 
window.

On its left side, the dialog contains controls for displaying the thumbnails of the raw images, for 
selecting images, and for adjusting color values. In addition, the histogram for each color channel 
of a selected image is shown. On the right side, the thumbnails of all images of the active image 
list are displayed.

Color corrections are always applied to images that are selected in the list of thumbnails in the 
dialog. An image can be selected by a data click on the thumbnail. Several images are selected in 
the common way by pressing the <Ctrl> or the <Shift> key while clicking on the image 
thumbnails. Images can also be selected by certain criteria, such as the camera name, the group 
number, a time stamp interval, or inside a fence.
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Display

Display button is used to modify the appearance of the thumbnail list on the right side of the 
dialog.

To change the display of the thumbnails:

1. Click on the Display button in the Define color corrections dialog.

This opens the Thumbnail display dialog:

2. Choose settings and click OK.

The optimal display settings depend mainly on the screen size and resolution. It is 
recommended to select a resolution ratio for which thumbnails have been created.

Setting: Effect:
Ratio Resolution ratio for thumbnail display.
Columns Number of columns in the thumbnail list.
Rows Number of rows in the thumbnail list.
Show image number If on, the image number is shown on the bottom of each thumbnail.
Show group number If on, the group number is shown on the bottom of each thumbnail.
Show tie status If on, the tie status is shown on the bottom of each thumbnail. In 

addition, the buttons for Changing the tie status of images appear 
at the bottom of the left side of the dialog.

Show rectify status If on, the rectify status is shown on the bottom of each thumbnail. 
In addition, the buttons for Changing the rectify status of images 
appear at the bottom of the left side of the dialog.

Show quality If on, the quality value is shown on the bottom of each thumbnail. 
In addition, the user controls for Changing the quality value of 
images appear at the bottom of the left side of the dialog.

Show intensity correction If on, the grid-based intensity correction values are shown as 
overlay of each thumbnail.
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Select by

Select by button is used to select images for color corrections automatically. The button opens a 
dialog which lets you set specific criteria for image selection.

To select images automatically by criteria:

1. Click on the Select by button in the Define color corrections dialog.

This opens the Select images by criteria dialog:

2. Define settings and click OK.

Show and identify selected images

To select a single image from view:

1. Click on the Identify button in the Define color corrections dialog.
2. Move the mouse pointer inside a MicroStation view.

The footprint of the image closest to the mouse pointer is highlighted.

3. Place a data click in order to select the highlighted image in the thumbnail list of the Define 
color corrections dialog.

To show the location of selected images:

1. Select one or more images in the Define color corrections dialog.
2. Click the Show location button in Define color corrections window.
3. Move the mouse pointer inside a MicroStation view.

The footprints of the selected images are highlighted. Place a data click inside the view in 
order to center the view to the highlighted images.

Setting: Effect:
Camera If on, images captured by the given camera are selected for color 

corrections. The list includes all cameras of the active mission.
Fence If on, images Inside or Outside a fence are selected for color 

corrections. This is only active if a MicroStation fence is drawn or 
a shape is selected.

Group If on, images that belong to the specified group are selected for 
color corrections. The group number is stored for each raw image 
in the image list.

Time stamp If on, images captured within the specified time stamp interval are 
selected for color corrections.
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Color corrections

There are six values which can be modified in order to correct coloring issues in the raw images: 
red, green, blue color channels, intensity, saturation, and contrast.

General process to apply color corrections:

1. Select one or more image thumbnails for which you want to apply color corrections.
2. Fill in values you want to change.
3. Click on the Apply button next to each setting to see the affect in the thumbnail display and 

to write color correction values to the image list.
4. Continue until all color corrections are applied.
5. Save the image list using Save list or Save list As commands from the Images pulldown 

menu in the TPhoto Main window in order to save the color corrections into an image list 
file.

You can check the result of color corrections by choosing Define color points command from 
Rectify pulldown menu in TPhoto Main window. This creates a preview of the ortho mosaic 
using the color corrections on-the-fly. Use Update view tool for MicroStation views in order to 
apply changes to the preview.

Color balance
Red, Green, and Blue add the given correction values to the red, green, and blue channels of an 
image. The values may range between -255 (no red/green/blue) and +255 (full red/green/blue).

The Gray balance tool button next to the RGB fields can be used to derive correction values for 
the color channels automatically. The software computes correction values for the color channels 
that result in gray coloring at the location selected by the mouse pointer.

The Gray balance tool is especially useful if there is a color cast in images. Then, the tool should 
be used in a part of the image that should be gray but clearly shows the color cast (e.g. a gray road 
surface).

To derive color corrections for gray balance adjustment:

1. Activate the Gray balance tool next to the RGB fields with a data click on the button.
2. Place data clicks in thumbnails at several locations where there are gray objects/surfaces.

This displays correction values next to the RGB fields.

3. Continue until you get an impression of good correction values that result in a balanced 
gray coloring for a number of images.

4. Deacitvate the Gray balance tool with a data click on the button.
5. Select the images for which to apply color corrections.
6. Type the correction values in the Red, Green, and Blue fields and click Apply.

This applies the color corrections to the selected images. Gray objects/surfaces should now 
appear with gray coloring.
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Intensity
Intensity multiplies the given value with the Value in the HSV color model. It is expressed as 
percentage and makes the image brighter or darker. A setting of +40 multiplies the Value with 
1.40, a setting of -25 with 0.75. The possible values range from -100 to +500.

Correction values for intensity can be derived automatically. The .. button next to the intensity 
field opens the Derive intensity correction dialog:

If several images are selected, the intensity correction is derived individually for each image.

Radial Intensity Correciton
In addition to the unique intensity correction for an image, a grid-based correction can be applied 
as well. Then, local correction values are distributed over an image in a grid structure. The 
distribution of the correction values is defined in the Assign distribution correction dialog which 
opens from the Radial intensity button:

If the corner correction is positive, the corners of the image(s) become brighter while the center 
becomes darker. If the corner correction is negative, the corners become darker and the center 
becomes brighter. All correction values average to zero.

Setting: Effect:
Target Target intensity value to move images towards. This is expressed 

as a number ranging from 0 to 100.
Correct Percentage of difference to correct. For example, if an image has 

an intensity value of 36, Target is set to 60 and Correct to 50, the 
image would end up with intensity 48. 

Setting: Effect:
Columns Number of columns in the correction value grid. Numbers can 

range from 3 to 9.
Rows Number of rows in the correction value grid. Numbers can range 

from 3 to 9.
Corner correction Maximum correction value applied to the image corners. 

Expressed as percentage value.
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Saturation and Contrast
Saturation multiplies the given value with the Saturation in the HSV color model. It is expressed 
as percentage and makes the colors of the image stronger or weaker. A setting of +40 multiplies 
the Saturation with 1.40, a setting of -25 with 0.75. The possible values range from -100 to +200. 
The minimum value -100 multiplies with 0.00 and results in a grayscale image.

Contrast moves the RGB values away from the center value, which means that the histogramm 
for each channel is stretched from the center value 128 (positive values) or tightened towards the 
center value 128 (negative values). The possible values range from -100 to +200.

The histogram display on the left side of the Define color correction dialog gives an indication, 
how the changes effect the color value distribution for each color channel. The gray graphs show 
the original color distribution while the red, green or blue graphs display the distribution with the 
current settings.
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Changing the tie status of images

The tie status of image refers to the tie points that are defined for a raw image. The status is either 
‘Check’ or ‘Approved’. Images with status ‘Check’ need more tie points or better distributed tie 
points, while images with status ‘Approved’ have a good number and distribution of tie points. See 
Chapter Working with Tie Points on page 76 for more details about tie points.

The tie status of images can be changed quickly in the Define color corrections dialog.

To change the tie status of images:

1. Use the Display button in order to switch the Show tie status setting on.

The buttons Tie approve and Tie check appear at the bottom of the left side of the Define 
color corrections dialog.

2. Select the image(s) for which to change the tie status.
3. Click on the respective button in order to change the status to Approved or Check.

The tie status of images can be changed using a key-in command defined in MicroStation. The 
syntax of the key-in command for changing the status to Approved is:

tie set status approved

If the key-in command is defined, for example, for the <F8> key, it can be used to change the 
status of selected image to Approved by just selecting the images and pressing the <F8> key.

The tie status of images can also be changed by selecting the the images in the image list and using 
the Edit command of the TPhoto Main window.
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Changing the rectify status of images

The rectify status of image refers to the usage of images in orthophoto production. The status is 
either ‘Rectify’ or ‘No rect’. Images with status ‘Rectify’ are used for creating orthophotos, while 
images with status ‘No rect’ are ignored. See Chapter Orthophoto Production on page 162 for 
more details about orthophoto production.

The rectify status of images can be changed quickly in the Define color corrections dialog.

To change the rectify status of images:

1. Use the Display button in order to switch the Show rectify status setting on.

The buttons Rectify on and Rectify off appear at the bottom of the left side of the Define 
color corrections dialog.

2. Select the image(s) for which to change the rectify status.
3. Click on the respective button in order to change the status to Rectify or No rect.

The rectify status of images can also be changed by selecting the the images in the image list and 
using the Edit command of the TPhoto Main window.

Changing the quality value of images

Each image has a quality value stored in the image list. By default, the value is 0 for all images. 
Some processing steps require that images are separated by quality. The quality value of images 
can be changed quickly in the Define color corrections dialog.

To change the quality value of images:

1. Use the Display button in order to switch the Show quality setting on.

The Quality field and an Apply button appear at the bottom of the left side of the Define 
color corrections dialog.

2. Select the image(s) for which to change the quality value.
3. Type a value in the Quality field.

Values from 0 - 255 are accepted in the field. The lower the number, the higher the quality 
of an image.

4. Click on the Apply button in order to change the quality value.

The quality attribute of images can be changed using a key-in command defined in MicroStation. 
The syntax of the key-in command for changing the value :

quality set <value>, for example, quality set 3

If the key-in command is defined, for example, for the <F8> key, it can be used to change the value 
of selected image to <value> by just selecting the images and pressing the <F8> key.

The quality attribute of images can also be changed by selecting the the images in the image list 
and using the Edit command of the TPhoto Main window.
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11 Working with Tie Points

Tie point concepts
Not Lite

Tie points play a key role in TerraPhoto data processing workflows. Tie points provide a method 
for solving camera parameters and improving the positional accuracy of images. They are used for 
camera calibration at the beginning of the processing workflow and later, for internal and external 
positional improvements of the actual project data. See Chapters Camera Calibration on page 
46 and Improving Image Positioning on page 118 for detailed information.

Tie points are differentiated into different types. They can occur as point or line features but, for 
reasons of simplicity, the term ‘tie points’ is used for both in this documentation if no separation 
is necessary.

The software handles and uses tie points differently for airborne and mobile ground-based 
missions. For airborne missions, the tie point mode is only available if a ground model is loaded 
in TerraPhoto. For mobile missions, a ground model is not required for working with tie points. 
However, there are a few tie point types which are only available for airborne or mobile missions. 
Finally, there are differences in the aims for which tie points are collected.

Airborne missions:

• Collect a small number of tie points for all cameras of a mission and distributed over the 
whole project area for adjusting misalignment angles in the camera calibration file.

• Collect more tie points until as many images as possible are well-defined by tie points. 
Improve the misalignment angles, principle point coordinates, and lens distortion parameters 
iteratively while working with tie points.

• Collect a big number of tie points for images in order to adjust the positioning for each image 
individually.

Mobile missions:

• Collect a small number of tie points for all cameras of a mission and distributed over the 
whole project area for adjusting misalignment angles in the camera calibration file.

• Collect tie lines of type Straight line for solving the lens distortion values in the camera 
calibration file.

• Collect tie points of types Known depth and/or Depth at regular distances in order to derive 
fluctuating corrections of the trajectory drift in TerraMatch.

TerraPhoto Lite does not have any of the tie point tools.
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Tie point entry windows

If the Define tie points command from the Images pulldown menu in the TPhoto Main window 
is selected, the application changes into the tie point mode. The application makes sure that 
relevant windows are open on the screen. The following windows are needed for working with tie 
points:

• Tie points - window that contains pulldown menus and two list boxes. The upper list box 
displays the active image list and tie point-related attributes for each image. The row selected 
in the upper list box determines the active image. The lower list box displays the list of tie 
points entered for the active image. Each tie point includes one or more tie point pixels, one 
pixel in each image in which the tie point is defined. The list also shows mismatch and 
reliability values for each tie point pixel. The visibility of attributes in the Tie points window 
can be defined by the Fields command.

• Active full - MicroStation view displaying a full raw image. The view uses thumbnails of 
images if they are available in the /TEMP folder of the mission.

• Active detail - MicroStation view displaying a rectified raster from the active image at the 
pixel location of the selected tie point.

• Secondary detail - MicroStation view displaying a rectified raster from a secondary image.
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Tie point types

TerraPhoto distinguishes between different types of tie points/lines:

• Ground point - a common point seen in multiple images. The software does not know the 
coordinates of the point but it knows that it is on the ground or very close to the ground 
elevation. This type is only available for aerial imagery missions.

• Air point - a common point seen in multiple images. The coordinates of the point are not 
known and it may be off from the ground elevation.

• Known xyz point - the coordinates of the point are known. The point is visible in one or 
multiple images.

• Known xy point - easting and northing coordinates of the point are known. The point is 
visible in one or multiple images. This type is only available for aerial imagery missions.

• Depth point - a point seen in multiple images. The depth from the camera position of the 
point is known. This type is only available for mobile imagery missions.

• Known depth point - the coordinates and the depth from the camera position of the point are 
known. The point is visible in one or multiple images. This type is only available for mobile 
imagery missions.

• Line - a common line seen in multiple images. The software does no know the exact position 
of the start and end points of the line but it knows that it is on the ground or very close to the 
ground location. A perpendicular correction to each line is calculated.

• Known line - the easting and northing coordinates of one point along the line are known and 
the line is located on ground elevation. The line is visible in one or multiple images. A 
perpendicular correction to each line is calculated.

• Straight line - a line that represents a straight linear feature in an image of a mobile side-
looking camera. This type is only available for mobile imagery missions.

The availablity of tie point types depend on the system that captured the data: airborne or mobile 
ground-based system.

Ground tie points are typically the most common type of tie point used in TerraPhoto workflow 
for aerial orthorectification projects. Air tie points are most often used to improve the internal 
positioning of mobile imagery. Depth and Known depth tie points can be utilized for deriving 
TerraMatch correction values for trajectory drifts of mobile system projects. Straight lines are 
used for calibrating the lens distortion of mobile side-looking images.

Tie point values

TerraPhoto can adjust the positioning of the images in a way that tie point objects seen in different 
images fall more accurately at the same location. The adjustment process is only reliable if each 
image has a sufficient number of tie points. If an image does not have enough tie points, the 
adjustment process does not necessarily make an improvement. It can even worsen the positioning 
in those parts of the project area where images do not have any tie points.

TerraPhoto computes a sum of tie point values for each raw image in order to indicate if an image 
has enough tie points (i.e. is well-defined) or not. The positional value of a tie point depends on 
its type and is a measure of how fixed the position of the tie point is. TerraPhoto uses the following 
value system:

• Air point, Line 1
• Ground point, Depth point, Known line 2
• Known xyz point, Known xy point, Known depth point 3
• Straight lines do not have a tie point value.

Air points and Lines are the least valuable types as they have the biggest degree of freedom. Their 
position is always computed as an average of the tie point rays and the solution point can move 
freely. Ground points, Depth points, and Known lines provide more value. Their position is 
computed as an average of the tie point rays but it is also fixed on the ground surface. Known 
point types are most valuable as their position is fixed.
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Tie point distribution

The number of tie points and the sum of their values is not the only criterion which should be 
considered when evaluating how well an image is defined by tie points. The distribution of tie 
points within the image is an equally important factor. Tie points close to the corners of the image 
provide the best positional control. Tie points close to the center of the image provide less control.

The ideal case for airborne images is to enter one Ground tie point close to each corner of the 
image. This would create good positional control using only four tie points.

The distribution of tie points within an image is reflected in the coverage value which can be 
displayed in the Tie points window. The coverage is expressed as percentage value. Well-defined 
images have a percentage value bigger than at least 50 % and close to 100 %.

Tie status

The tie status of an image indicates whether more tie points should be entered to this image or not. 
It is an attribute which is stored for each image in the image list. The tie status can be ‘Check’ 
(default) or ‘Approved’. The status Approved indicates that an operator has checked the image and 
decided that no more tie points can or need to be added to this image. Thus, approved images can 
be images that already have a good number of well-distributed tie points, or they are images where 
no tie points can be entered (for example, they are completely covered by dense forest or water).

The tie status of images can be changed in different ways:

• In the Define color corrections dialog - see Changing the tie status of images on page 74 
for more information.

• In the Tie points window - use function key commands to change the status for a selected 
image. The key commands are:

tie set status approved
tie set status check

The tie status can be used to Sort images in the image list in order to display images with tie status 
Check at the beginning of the list.

Poor distribution Good distribution
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Tie point entry modes

Tie points are defined by using different levels of automation. These different levels can be 
described as three entry modes:

• Manual - you enter the tie point manually in all images. The application just displays each 
raw image the sees the tie point location automatically in the detail views.

• Semi-automatic - you enter the tie point manually in the active image. The application finds 
matches in other images automatically. This mode is active if Find matches automatically is 
switched on in Tie points / Automation of the TerraPhoto Settings. This mode applies to 
Ground tie points only.

• Automatic - the application searches for tie points automatically. You start the search by 
selecting Search points command from the File pulldown menu in the Tie points window. 
The automatic search enters only Ground tie points.

Whenever you start working on a new project, you normally start with the manual mode. If 
mismatch distances become relatively small (about 2-3 * pixel size of the raw images), you may 
change to the semi-automatic mode. If that mode is successful in finding correct matches and if 
the camera parameters are stable, you can run the automatic search.

General workflow of entering a tie point

1. Select an image in the upper list box of the Tie points window.

The image is displayed on the Active full view.

2. Select a tie point type from the Point pulldown menu of the Tie points window.
3. Define an appoximate location with a data click in the Active full view. Select a location 

where you think you can place a tie point of the selected type.

For Known tie point types, the known point location must be entered first instead of the 
approximate tie point location.

The selected location in the active image is displayed in the Active detail view.

4. Search for a good location for the tie point in the Active detail view. Place the tie point in 
the Active detail view with a data click.

The tie point is created and displayed in the lower list of the Tie points window. It is defined 
in the active image while all secondary images have empty pixels for this tie point.

The tie point location is displayed in the Secondary detail view.

5. Enter the tie point in all other images in the Secondary detail view. The images are 
displayed one after one in the Secondary detail view whenever the tie point has been 
entered.

In semi-automatic entry mode, Ground tie points are placed automatically in all secondary 
images after they have been entered in the active image. If a tie point location can not be 
found automatically in an image, this image is displayed in the Secondary detail view for 
manual entry. However, the setting for Bad matches in Tie points / Automation of the 
TerraPhoto Settings determines the handling of situations, where tie points can not be found 
semi-automatically.

Alternatively to the mouse pointer, you can navigate in the lists of the Tie points window by using 
the <Arrow-up> and <Arrow-down> keys. The key commands select the previous/next image in 
the list of images or points. A selected tie point pixel can be deleted by using the <Delete> key. 
The usage of keys is automatically focussed on the tie point list if the setting Focus point list 
automatically is switched on in Tie points / Automation of the TerraPhoto Settings.

A detailed description of entering tie points of different types is provided in Section Point 
pulldown menu on page 97.
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File pulldown menu
Commands in the File pulldown menu are used to open and save tie points, import known point 
files, recompute all tie points, output a report, draw tie point distribution and residual vectors, 
search tie points automatically, modify tie point types, clean undefined pixels, and modify the 
image numbers.

To: Choose menu command:
Erase currently defined tie points New
Open a previously saved tie points file Open
Save tie points to an existing file Save
Save tie points to a new file Save As
Import known point coordinates from a text file Import known points
Import known line coordinates from a text file Import known lines
Recompute solution points for tie points Recompute all
Output a report about tie points Output report
Draw the distribution of tie points for a camera Draw pixel distribution
Draw residual vectors for all tie points of a camera Draw residual vectors
Search new tie points in automatic mode Search points
Convert ground into air tie points automatically Fix ground to air
Remove all undefined pixels from all tie point Clean all
Change the image numbering in the tie point file Renumber images
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New

New command erases the active tie points and thus, lets you start the creation of a new tie point 
file. It frees the memory that is occupied by active tie points.

Open

Open command reads previously saved tie points from a file on the hard disc.

Save

Save command saves the tie points to the same file from which they have been opened before.

Save As

Save As command saves the tie points into a new file.

Import known points

Import known points reads points from a text file and inserts them as Known xyz tie points. You 
need to go through the list of images and enter the tie point positions in each image that sees a 
known point location.

The command recognizes space-delimited text files where each line stores the coordinates of one 
known point as:

• Easting Northing Elevation
• Identifier Easting Northing Elevation

To import known points and enter them as tie points:

1. Select Import known points command from the File pulldown menu.

This opens the Import known points dialog, a standard dialog for opening a file.

2. Select the known point text file and click Open.

This reads the known point coordinates from the text file and adds the points as Known xyz 
tie points to the active tie points. The points are added as empty tie point pixels at the end of 
the tie points list.Images that see the known point locations are marked with the asterisk 
character (*) behind the image number in the list of images in the Tie points window.

3. Scroll through the list of images in the Tie points window until you find an image with an 
asterisk behind the image number. Select the image.

This displays the tie points for the selected image in the lower list box of the Tie points 
window.

4. Select a Known xyz tie point in the active image in the tie points list.

The location of the tie point in the active image is displayed in the Active detail view and in 
a secondary image in the Secondary detail view.

5. Select Enter position command from the Pixel pulldown menu.
6. Enter the tie point location with a data click in the active image in the Active detail view.
7. Enter the tie point location with a data click in all other images in the Secondary detail 

view. Use the <Arrow-down> key or the mouse pointer to select the next secondary image 
in the tie points window after placing a tie point in one image.

8. Repeat steps 3 to 7 for all known tie points.
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Import known lines

Import known lines reads coordinates of points on linear features from a text file and inserts them 
as tie lines of type Known lines. There is an option for automatic placement of the lines. 
Alternatively, you need to go through the list of images and enter the tie line positions in each 
image that sees a known line location.

The command recognizes space-delimited text files where each line stores the coordinates of one 
known line as:

• Easting Northing Elevation
• Identifier Easting Northing Elevation

To import known lines and enter them as tie lines:

1. Select Import known lines command from the File pulldown menu.

This opens the Import known lines dialog, a standard dialog for opening a file.

2. Select the known lines text file and click Open.

Another Import known lines dialog opens:

3. Define settings and click OK.

This reads the known line coordinates from the text file and adds them as Known lines to the 
active tie points.

If the Entry mode is set to Auto line search, the software starts the automatic search for tie 
lines and adds them to the tie points list. Otherwise, the known lines are added as empty tie 
line pixels to the tie points list and you need to continue with step 4.

Images that see locations of empty known lines are marked with the asterisk character (*) 
behind the image number in the list of images in the Tie points window.

4. Scroll through the list of images in the Tie points window until you find an image with an 
asterisk behind the image number. Select the image.

This displays the tie points for the selected image in the lower list box of the Tie points 
window. 

5. Select a Known line in the active image in the tie points list.

The location of the tie point in the active image is displayed in the Active detail view and in 
a secondary image in the Secondary detail view.

6. Select Enter position command from the Pixel pulldown menu.
7. Enter the start and end points of the tie line with two data clicks in the active image in the 

Setting: Effect:
Entry mode Method of Known line placement:

• Manual - lines need to be entered manually.
• Auto line search - lines are placed automatically.

Line width Distance from the tie line within which the software tries to place 
tie line pixels automatically. Values can be determined, for 
example, from the width of paint markings on a road.
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Active detail view.
8. Enter the start and end points of the tie line in all other images with two data clicks in the 

Secondary detail view. Use the <Arrow-down> key or the mouse pointer to select the next 
secondary image in the tie points window after placing a tie point in one image.

9. Repeat steps 4 to 8 for all known lines.



Page 85
11 Working with Tie Points
Recompute all

Recompute all command recomputes internal variables of each tie point. This includes projecting 
pixel vectors to the ground and computing the solution point.

The command is not used very often as the application recomputes tie points automatically after 
the most typical actions which invalidate tie point information. It recomputes automatically after 
the following actions:

• Applying changes to camera parameters using Apply in the Camera dialog.
• Adjust image positions using Adjust positions command.
• Open a new image list.

Recompute all must be used after the following actions:

• Modify images using the Edit command.
• Change Positions setting for any of the cameras in the mission definition.



Page 86
11 Working with Tie Points
Output report

Output report command creates a report based on the active tie points. You may use this 
command to accomplish the following:

• Find out how many images have enough tie points and how many do not.
• Find tie points or images with large mismatch distances.
• Find and apply the best misalignment angles for camera(s).
• Find out how well known tie points match to know point coordinates.

To output a tie point report:

1. Select Output report command from the File pulldown menu.

This opens the Tie point report dialog:

2. Define settings and click OK

This computes the report values and opens the Tie point report.

Setting: Effect:
Pixel ray mismatches If on, the report contains mismatch distances for each tie point 

pixel.
Image pull values If on, the report contains the pull direction for each image 

translated into heading, roll, and pitch changes.
Optimal misalignment 
angles

If on, the report includes camera misalignment values which 
produce the smallest tie point mismatches using raw image 
positions.

Known point comparison If on, the report includes a comparison of how well pixel rays of 
known tie points match the known point coordinates. 

Distance Writes pixel ray mismatch in red if it exceeds this value.
Heading Writes heading pull value in red if it exceeds this value.
Roll Writes roll pull value in red if it exceeds this value.
Pitch Writes pitch pull value in red if it exceeds this value.
Elevation Writes elevation pull value in red if it exceeds this value.
Xy Writes xy pull value in red if it exceeds this value.
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Tie point report
The tie point report is displayed in the Tie point report window. The window contains pulldown 
menus and the report information:

Use commands from the File pulldown menu to save the report as a text file and to print the report 
directly. Commands from the View pulldown menu can be used to change the size of the report 
window.

Apply misalignment command from the Tools pulldown menu applies the optimal camera 
misalignment values to the camera calibration file(s) for each camera of the mission. Further, the 
command automatically saves the camera calibration file(s) and recomputes the tie points. This 
should be done if the Final average value in the report is smaller than the Start average value, 
which means that the optimal camera misalignment values improve the image positioning.

Depending on the selected settings in the Tie point report dialog, the report includes the 
following information:

Average point counts per image lists the average number of tie points per image for each tie 
point type. Further, it displays the number of images with tie status Check that are well-defined 
and under-defined according to the given tie point value and coverage limits. The same is shown 
for images with tie status Approved.

Pixel ray mismatches shows a list of all tie points, their geographical coordinates, and the 
mismatch distances in centimeters of each tie point pixel. The tie points are sorted by tie point 
type. The list ends with the average mismatch distance.

Image pull values are reported in a table which lists all images. For each image the number of tie 
points per type and changes in values for heading, roll, pitch, elevation, and xy are displayed. The 
table ends with the average change for each value.

Optimal camera misalignment provides the optimal misalignment angles for each camera of the 
mission. Start average and Final average values allow the comparison between the average 
mismatch with the current camera misalignment angles and with the optimal camera misalignment 
angles. If the value for Final average is smaller than the value for Start average, the new 
misalignment angles should be applied to the camera calibration files.
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Known point comparison lists all known points, their geographical coordinates, and the 
mismatch distances for x,y, and z (if available) between the known points and the Known tie 
points/lines. The table ends with the average values for the mismatch distances. Further, the report 
gives a recommendation for a linear transformation in xy. It shows values that should be added to 
eastings and northings of the image coordinates in order to match the images better to the known 
points. These values can be used to Transform positions of the image list and thus, improve the 
absolute accuracy of the image list. Finally, the Average and Worst mismatch distances between 
known points and Known tie points/lines are shown.
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Draw pixel distribution

Draw pixel distribution command draws a grid into the design file that contains all tie point 
pixels for a camera. The drawing illustrates how well tie points are distributed and points out areas 
where tie points are missing. Thus, it helps to decide whether the lens distortion can be solved with 
the current tie points or not.

To draw the tie point distribution:

1. Select Draw pixel distribution command from the File pulldown menu.

This opens the Draw pixel distribution dialog:

2. Select a Camera for which you want to see the tie point distribution.
3. Define the number of Columns and Rows of the grid.
4. Click OK.

The grid is shown temporarily at the mouse pointer location.

5. Place the grid in a MicroStation view with a data click.

This draws the grid as cell element into the design file using the active level and symbology 
settings of MicroStation.
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Draw residual vectors

Draw residual vectors command draws a grid into the design file that shows the residual pull 
vectors for a camera. The grid illustrates whether the lens distortion is regular or not. Thus, it helps 
to decide if the lens distortion in the camera calibration file can be corrected by a Grid model.

To draw the residual vectors:

1. Select Draw residual vectors command from the File pulldown menu.

This opens the Draw residual vectors dialog:

2. Select a Camera for which you want to see the residual vectors.
3. Define the number of Columns and Rows of the grid.
4. Define a scale factor in the Scale vectors field for enlarging the arrows that represent the 

pull vectors in the grid drawing.
5. Click OK.

The grid is shown temporarily at the mouse pointer location.

6. Place the grid in a MicroStation view with a data click.

This draws the grid as cell element into the design file using the active level and symbology 
settings of MicroStation.
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Search points

Search points command searches for Ground tie points automatically by comparing overlapping 
parts of rectified images.

The process is only successful if the positioning of the images is fairly good. This requires that 
good stable camera parameters are established and mismatch distances for tie points are relatively 
small.

The automatic tie point search typically results in a large number of tie points. The majority of 
those tie points are good but there is also a small percentage of tie points which do not really see 
the same position on the ground. Therefore, bad tie points must be filtered out after the automatic 
search process. Use Filter bad command in order to perform the task automatically with a pretty 
good success rate. Additionally, you can filter out bad tie points with a more manual approach 
using Find worst, Find first bad or Find next bad commands.

To search tie points automatically:

1. Select Search points command from the File pulldown menu.

This opens the Search tie points dialog:

2. Define settings and click OK.

The application starts searching for tie points. A progress window indicates how many 
images have been searched and how many tie points have been found.

The tie point search on a large data set can take a very long time. The speed of the search is 
primarily effected by how well tie points can be found. The more tie points are found, the 
faster the search runs as it does not need to attempt finding new points close to the already 
collected ones. If the routine does not find many points, you probably need to restart the 
process with a higher Match limit setting or establish better camera parameters.
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Setting: Effect:
Search depth Depth of the search. This partially effects how many tie points the 

application searches for each image:
• Full (slow) - largest amount of tie points.
• Medium - medium amount of tie points.
• Partial (fast) - smallest amount of tie points.

Use Area within an image where the software searches for tie points:
• Whole image - within the whole image.
• Selected parts - only in selected parts of an image. The parts 

can be selected for each image separately by using the Define 
button.

Search in Images to search in:
• All images - all images.
• Underdefined image - all images lacking tie points.
• Active image - active image only.
• Given image range - images in a given range of image 

numbers.
Skip approved images If on, images with tie status Approved are not included in the tie 

point search.
Images Image numbers that define the range for searching tie points. This 

is only active if Search in is set to Given image range.
Only inside polygons Tie points are searched only inside shape elements on the given 

design file level.
Exclude polygons No tie points are searched inside shape elements on the given 

design file level.
Use shadow maps If on, the routine uses shadow maps stored in the /TEMP directory 

of the mission. See Compute shadow maps for more information.
Minimum contrast Minimum contrast required at a location where the software tries 

to enter a tie point. The contrast is the difference between the 
maximum and the minimum gray scale value within the 
comparison raster. Normally set to a value between 30 and 100.

Match limit Required match rating for accepting a tie point. A higher value 
allows the application to accept worse matches where the rasters 
from different raw images do not match each other so well. 
Normally set to a value between 6 and 12.

Distance limit Maximum allowed mismatch distance for a tie point pixel to be 
accepted. 

Max terrain angle Maximum allowed terrain angle at a tie point location.
Z tolerance Elevation variation in ground model points. Used in slope 

computation.
Save results automatically If on, the routine saves the tie points at regular intervals into a tie 

point file on a hard disc. 
After every Interval after which to save points automatically. This is only 

active if Save results automatically is switched on.



Fix ground to air

Fix ground to air command changes the type of a tie point from Ground to Air if a given 
mismatch reduction is achieved by the conversion. This is useful, for example, after an automatic 
tie point search where many tie points have been placed on objects above the ground, such as 
bridges.

To change ground tie points into air tie points:

1. Select Fix ground to air command from the File pulldown menu.

The Fix ground to air dialog opens:

2. Define settings and click OK.

The software performs the conversion. An information dialog shows the number of points 
that were changed into Air tie points.

Clean all

Clean all command removes undefined pixels from all tie points.

It performs the same action as the Clean command from the Point pulldown menu, just for the 
complete tie point file.

To remove undefined pixels from all tie points:

1. Select Clean all command from the File pulldown menu.

An alert dialog requests a confirmation for the process.

2. Click OK in order to remove the undefined tie point pixels.

An information dialog shows the amount of removed tie points and tie point pixels.

Setting: Effect:
Require Mismatch reduction in meter that is required for converting a tie 

point.
Require Mismatch reduction in percent that is required for converting a tie 

point.
Keep manual pixels 
unchanged

If on, manually placed tie point pixels are not affected by the 
conversion.
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Renumber images

Renumber images command renumbers all or a given range of images in the tie points file. It 
adds a constant number to the existing image numbers or converts 32-bit image numbers into 64-
bit numbers.

TerraPhoto requires a unique number for images in the active image list which is derived from the 
image file names. These image numbers are stored in the tie point file. If it is necessary to rename 
the image files, the numbers in the image list change. Therefore, it might be necessary to change 
the image numbers in the tie point file as well in order to ensure that tie points still work for the 
renamed images.

The update of image numbers is also required if an old tie point file with image numbers stored as 
32-bit values is used for a new image list file with image numbers stored as 64-bit values 
(TerraPhoto version 010.014 or later).

To renumber images:

1. Select Renumber images command from the File pulldown menu.

This opens the Renumber tie point images dialog:

2. Define settings and click OK.

The new numbering is applied for the tie points. An information dialog shows the amount of 
images that have been renumbered.

3. Save the tie points using Save or Save As commands from the File pulldown menu in order 
to save the tie points with renumberd images into a file.

Setting: Effect:
Action Method of renumbering images for tie points:

• Add constant - a constant value is added to each image 
number.

• Convert to 64 bit - the image numbers are converted into 64-
bit values.

For images Range of image numbers for which the renumbering is applied.
Constant Value that is added to current image numbers. Negative values can 

be used. This is only active if Action is set to Add constant.
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Image pulldown menu
Commands in the Image pulldown menu are used to show the geographical location of the active 
image and to select the active image or the secondary image by geographical location.

To: Choose menu command:
See the geographical location of the active image Show active
Select the active image by geographical location Identify active
Select the secondary image by geographical location Identify secondary
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Show active

Show active command shows the geographical location of the active image.

To see the geographical location of the active image:

1. Select an image in the upper list box of the Tie points window.
2. Select Show active command from the Image pulldown menu.
3. Move the mouse pointer inside a MicroStation view.

The application displays the footprint shape of the selected image.

Place a data click inside the view in order to center the view to the xyz position of the active image.

Identify active

Identify active command lets you select a new active image. The image is selected by its 
geographical location.

To select an active image by geographical location:

1. Select Identify active command from the Image pulldown menu.
2. Move the mouse pointer inside a MicroStation view.

The image footprint of the image closest to the mouse pointer is displayed dynamically.

3. Select an image with a data click inside the view.

This selects the image closest to the mouse pointer as new active image in the Tie points 
window. The image display in the Active full view is updated.

Identify secondary

Identify secondary menu command lets you select a new secondary image. The image is selected 
by its geographical location.

To select a secondary image by geographical location:

1. Select Identify secondary command from the Image pulldown menu.
2. Move the mouse pointer inside a MicroStation view.

The image footprint of the image closest to the mouse pointer is displayed dynamically.

3. Select an image with a data click inside the view.

This selects the image closest to the mouse pointer as new secondary image.
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Point pulldown menu
Commands in the Point pulldown menu are used to add new tie points and to modify, clean, or 
delete the selected tie point.

To: Choose menu command:
Add a ground tie point Add ground
Add an air tie point Add air
Add a depth tie point Add depth
Add a known depth tie point Add known depth
Add a known xyz tie point Add known xyz
Add a known xy tie point Add known xy
Add a tie line Add line
Add a known tie line Add known line
Add a straight tie line Add straight line
Modify information of the selected tie point Edit information
Remove all undefined pixels from the selected tie point Clean
Delete the selected tie point Delete
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Add ground

Add ground command lets you enter a new tie point of type Ground. Ground tie points can be 
placed manually or in semi-automatic entry mode depending on the setting in Tie points / 
Automation of the TerraPhoto Settings.

To enter a new ground point:

1. Select Add ground command from the Point pulldown menu.

The Tie Add Ground dialog opens:

If Display position hint is switched on, the software indicates the approximate location of 
the tie point in secondary images by a small red cross.

2. Identify an approximate location with a data click in the Active full view where you intend 
to enter a Ground point.

The application updates the Active detail view in order to show the selected location as an 
orthorectified image.

3. Enter the tie point position with a data click in the Active detail view. You may move or 
zoom the image in the view in order to find a good tie point location.

The application adds the tie point to the list in the Tie points window. The tie point is 
manually defined in the active image. In semi-automatic entry mode, the software tries to 
place the tie point in all other images automatically. If all tie point pixels are found 
automatically, you can continue with step 2 in order to place the next Ground tie point.

The tie point pixels in the other images are undefined at this stage if you are using the manual 
entry mode or if the semi-automatic entry mode did not find an acceptable match. The 
software selects the next image with an undefined tie point pixel in the list and updates the 
Secondary detail view in order to show the tie point position.

4. Enter the tie point position with a data click in the Secondary detail view.

The application recomputes the solution point for the tie point and displays the current 
mismatch for each image. It selects the next image with an undefined tie point pixel in the 
list and updates the Secondary detail view in order to show the tie point position.

5. Continue with step 4 until all tie point pixels are defined.
6. After entering the last pixel of a tie point, you can continue with step 2 if you want to place 

the next Ground tie point.

If the tie point position can not be defined in one of the secondary images, you should select the 
next undefined pixel for this tie point and continue entering the tie point pixels. Use the Clean 
command from the Point pulldown menu in order to remove undefined pixels from a selected tie 
point.
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Add air

Add air command lets you enter a new tie point which may be above the ground. Air tie points 
can be entered manually only.

To enter a new air point:

1. Select Add air command from the Point pulldown menu.

The Tie Add Air dialog opens:

If Display position hint is switched on, the software indicates the approximate location of 
the tie point in secondary images by a thin red line.

2. Identify an approximate location with a data click in the Active full view where you intend 
to enter an Air point.

The application updates the Active detail view in order to show the selected location as an 
orthorectified image.

3. Enter the tie point position with a data click in the Active detail view. You may move or 
zoom the image in the view in order to find a good tie point location.

The application adds the tie point to the list in the Tie points window. The tie point is defined 
in the active image.

The tie point pixels in the other images are undefined at this stage. The software selects the 
next image with an undefined tie point pixel in the list and updates the Secondary detail 
view in order to show the tie point position.

4. Enter the tie point position with a data click in the Secondary detail view.

The application recomputes the solution point for the tie point and displays the current 
mismatch for each image. It selects the next image with an undefined tie point pixel in the 
list and updates the Secondary detail view in order to show the tie point position.

5. Continue with step 4 until all tie point pixels are defined.
6. After entering the last pixel of a tie point, you can continue with step 2 if you want to place 

the next Air tie point.

If the tie point position can not be defined in one of the secondary images, you should select the 
next undefined pixel for this tie point and continue entering the tie point pixels. Use the Clean 
command from the Point pulldown menu in order to remove undefined pixels from a selected tie 
point.
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Add depth

Add depth command lets you enter a new Depth tie point. Depth tie points are used for deriving 
trajectory drift corrections in data sets from mobile systems. Therefore, the tie points are collected 
in TerraPhoto but used in TerraMatch for finding fluctuating corrections. The derived corrections 
can then be utilized to improve the positioning of images and laser data collected during the same 
survey.

Depth tie point should be entered at regular distances along roads, railroads, or other linear objects 
in order to provide a good source for correcting the drift in the trajectory. You may place a tie 
point, for example, in every 5th or 10th image if the images were captured at a constant driving 
speed. The point is entered only in those images that see a tie point location best.

Depth tie point require depth maps in the /TEMP directory of the mission. See Compute depth 
maps for more information.

To enter a new depth point:

1. Select Add depth command from the Point pulldown menu.

The Tie Add Depth dialog opens:

2. Select Images, in which you want to place the tie point: All possible or Best in each pass. 
The latter option causes that only those images from each drive path are displayed for tie 
point placement that see the tie point location best.

3. Identify an approximate location with a data click in the Active full view where you intend 
to enter a Depth point.

The application updates the Active detail view in order to show the selected location.

4. Enter the tie point position with a data click in the Active detail view. You may move or 
zoom the image in the view in order to find a good tie point location.

The application adds the tie point to the list in the Tie points window. The tie point is defined 
in the active image.

The tie point pixels in the other images are undefined at this stage. The software selects the 
next image with an undefined tie point pixel in the list and updates the Secondary detail 
view in order to show the tie point position.

5. Enter the tie point position with a data click in the Secondary detail view.

The application recomputes the solution point for the tie point and displays the current 
mismatch for each image. It selects the next image with an undefined tie point pixel in the 
list and updates the Secondary detail view in order to show the tie point position.

6. Continue with step 5 until all tie point pixels are defined.
7. After entering the last pixel of a tie point, you can continue with step 3 if you want to place 

the next Depth tie point. Typically, you would select another image before you place the 
next tie point.

You can check the distribution of tie points along the survey area in another MicroStation top 
view. Make sure that the setting Draw points in all top views is switched on in the Tie point view 
setup dialog. The dialog is opened by the Setup command from the View pulldown menu. New 
tie points are displayed in top views after redrawing the view.
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Add known depth

Add known depth command lets you enter a new Known depth tie point for which the x, y, and 
z coordinates are known.

Known depth tie points are used for deriving trajectory drift corrections in data sets from mobile 
systems. Therefore, the tie points are collected in TerraPhoto but used in TerraMatch for finding 
fluctuating corrections. The derived corrections can then be utilized to improve the positioning of 
images and laser data collected during the same survey.

Known depth tie points are entered based on points for which the x, y, and z coordinates are 
known, for example, control points on signal markers, paint markings, etc. on the ground. The 
control points should be measured at regular distances along roads, railroads, or other linear 
objects in order to provide a good source for correcting the drift in the trajectory. The known 
points must be drawn into the design file and should be displayed in a top view for tie point entry. 
Each tie point is entered only in one image that sees the known point location best.

Known depth tie point require depth maps in the /TEMP directory of the mission. See Compute 
depth maps for more information.

To enter a new known depth point:

1. Select Add known depth command from the Point pulldown menu.

The Tie Add Known Depth dialog opens:

2. Define a number for the tie point. The number increments automatically.
3. Select Images, in which you want to place the tie point: All possible, Best in each pass, or 

Best one. The latter two options cause that only image(s) from each drive path or one drive 
path are displayed for tie point placement that see the known point location best.

4. Enter the position of the known point with a data click in a MicroStation view. You can snap 
to a vector element drawn in the design file in order to get the exact coordinates of the 
known point.

The software adds the point to the list in the Tie points window. All tie point pixels are 
undefined at this stage. The software updates the Active detail view in order to show the 
location of the known point.

5. Enter the tie point position with a data click in the Active detail view. You may move or 
zoom the image in the view in order to find the correct tie point location.

The software computes and displays the mismatch between the tie point and the known point 
coordinates. If the tie point is only entered in one image, you can continue with step 4 in order 
to enter the next Known depth tie point.

If the tie point can be entered in additional images, the software selects the next image with 
an undefined tie point pixel in the list and updates the Secondary detail view in order to 
show the tie point position.

6. Enter the tie point position with a data click in the Secondary detail view.

The software computes and displays the mismatch between the tie point and the known point 
coordinates. It selects the next image with an undefined tie point pixel in the list and updates 
the Secondary detail view in order to show the tie point position.

7. Continue with step 6 until all tie point pixels are defined.
8. After entering the last pixel of a tie point, you can continue with step 4 if you want to place 

the next Known depth tie point.
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Add known xyz

Add known xyz command lets you enter a new Known xyz tie point. Known xyz tie points are 
entered based on points for which the x, y, and z coordinates are known, for example, control 
points on the ground. The coordinates of the known points can be defined by snapping to vector 
elements drawn into the design file or by typing a key-in command in the MicroStation key-in line.

To enter a new known xyz point:

1. Select Add known xyz command from the Point pulldown menu.

The Tie Add Known Xyz dialog opens:

2. Define a Number for the new point. By default, the number increments automatically.
3. Enter the position of the known xyz point with a data click in a MicroStation view. You may 

snap to a vector element drawn in the design file in order to get the exact coordinates of the 
known point.

Alternatively, you can type a key-in command with the exact coordinates:
xy=212457.65,670960.11,73.45

The application adds the point to the list of tie points. All tie point pixels are undefined at this 
stage.

The application updates the Active detail view in order to show the known point location.

4. Enter the tie point position with a data click in the Active detail view.

The software computes and displays the mismatch between the tie point and the known point 
coordinates. It selects the next image with an undefined tie point pixel in the list and updates 
the Secondary detail view in order to show the tie point position.

5. Enter the tie point position with a data click in the Secondary detail view.

The software computes and displays the mismatch between the tie point and the known point 
coordinates. It selects the next image with an undefined tie point pixel in the list and updates 
the Secondary detail view in order to show the tie point position.

6. Continue with step 5 until all tie point pixels are defined.
7. After entering the last pixel of a tie point, you can continue with step 3 if you want to place 

the next Known xyz tie point.

If the tie point position can not be defined in one of the secondary images, you should select the 
next undefined pixel for this tie point and continue entering the tie point pixels. Use the Clean 
command from the Point pulldown menu in order to remove undefined pixels from a selected tie 
point.
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Add known xy

Add known xy command lets you enter a new Known xy tie point. Known xy tie points are 
entered based on points for which the x and y coordinates are known, for example, control points 
on the ground without (valid) elevation values. The coordinates can be defined by snapping to 
vector elements drawn into the design file or by typing a key-in command in the MicroStation key-
in line.

To enter a new known xy point:

1. Select Add known xy command from the Point pulldown menu.

The Tie Add Known Xy dialog opens:

2. Define a Number for the new point. By default, the number increments automatically.
3. Enter the position of the known xy point with a data click in a MicroStation view. You may 

snap to a vector element drawn in the design file in order to get the exact coordinates of the 
known point.

Alternatively, you can type a key-in command with the exact coordinates:
xy=212457.65,670960.11

The application adds the point to the list of tie points. All tie point pixels are undefined at this 
stage.

The application updates the Active detail view in order to show the known point location.

4. Enter the tie point position with a data click in the Active detail view.

The software computes and displays the mismatch between the tie point and the known point 
coordinates. It selects the next image with an undefined tie point pixel in the list and updates 
the Secondary detail view in order to show the tie line position.

5. Enter the tie point position with a data click in the Secondary detail view.

The software computes and displays the mismatch between the tie point and the known point 
coordinates. It selects the next image with an undefined tie point pixel in the list and updates 
the Secondary detail view in order to show the tie point position.

6. Continue with step 5 until all tie point pixels are defined.
7. After entering the last pixel of a tie point, you can continue with step 3 if you want to place 

the next Known xy tie point.

If the tie point position can not be defined in one of the secondary images, you should select the 
next undefined pixel for this tie point and continue entering the tie point pixels. Use the Clean 
command from the Point pulldown menu in order to remove undefined pixels from a selected tie 
point.
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Add line

Add line command lets you enter a new tie line on the ground. Lines can be placed manually or 
in semi-automatic entry mode depending on the setting in the command’s dialog.

To enter a new line:

1. Select Add line command from the Point pulldown menu.

The Tie Add Line dialog opens:

2. Select the Entry mode: Manual or Auto image match.
3. Identify an approximate location with a data click in the Active full view where you intend 

to enter a tie line.

The application updates the Active detail view in order to show the selected location as an 
orthorectified image.

4. Enter the position of the line with two data clicks in the Active detail view. You may move 
or zoom the image in the view in order to find a good tie line location.

The application adds the tie line to the list in the Tie points window. The tie line is manually 
defined in the active image. If Entry mode is set to Auto image match, the software tries to 
place the tie line in all other images automatically. If all tie line pixels are found correctly, 
you can continue with step 3 in order to place the next Line.

The tie line pixels in the other images are undefined at this stage if you are using the manual 
entry mode. The software selects the next image with an undefined tie line pixel in the list 
and updates the Secondary detail view in order to show the tie line position.

5. Enter the tie line position with two data clicks in the Secondary detail view.

The application recomputes the solution point for the tie line and displays the current 
mismatch for each image. It selects the next image with an undefined tie line pixel in the list 
and updates the Secondary detail view in order to show the tie line position.

6. Continue with step 5 until all tie line pixels are defined.
7. After entering the last pixel of a tie line, you can continue with step 3 if you want to place 

the next Line.

If the tie line position can not be defined in one of the secondary images, you should select the 
next undefined pixel for this tie line and continue entering the tie line pixels. Use the Clean 
command from the Point pulldown menu in order to remove undefined pixels from a selected tie 
line.
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Add known line

Add known line command lets you enter a new Known line. Known line tie lines are entered 
based on points for which the xyz coordinates of one point along a linear feature are known, for 
example, control points on a linear paint marking. The coordinates can be defined by snapping to 
vector elements drawn into the design file or by typing a key-in command in the MicroStation key-
in line.

Known lines can be placed manually or in automatic entry mode depending on the setting in the 
command’s dialog.

To enter a new known line:

1. Select Add known line command from the Point pulldown menu.

The Tie Add Known Line dialog opens:

2. Select the Entry mode: Manual or Auto line search. Define Line width values if Entry 
mode is set to Auto line search. The Line width defines the distance from the tie line 
within which the software tries to place tie line pixels automatically.

3. Enter the position of the known xyz point with a data click in a MicroStation view. You may 
snap to a vector element drawn in the design file in order to get the exact coordinates of the 
known point.

Alternatively, you can type a key-in command with the exact coordinates:
xy=212457.65,670960.11,73.45

The application adds the tie line to the list in the Tie points window. If Entry mode is set to 
Auto line search, the software tries to place the tie line in all images automatically. If all tie 
line pixels are found correctly, you can continue with step 3 in order to place the next Known 
line.

The tie line pixels are undefined at this stage if you are using the manual entry mode. The 
software selects the active image and updates the Active detail view in order to show the tie 
line position.

4. Enter the tie line position with two data clicks in the Active detail view.

The software selects the next image with an undefined tie line pixel in the list and updates 
the Secondary detail view in order to show the tie line position.

5. Enter the tie line position with two data clicks in the Secondary detail view.

The application recomputes the solution point for the tie line and displays the current 
mismatch for each image. It selects the next image with an undefined tie line pixel in the list 
and updates the Secondary detail view in order to show the tie line position.

6. Continue with step 5 until all tie line pixels are defined.
7. After entering the last pixel of a tie line, you can continue with step 3 if you want to place 

the next Known line.

If the tie line position can not be defined in one of the secondary images, you should select the 
next undefined pixel for this tie line and continue entering the tie line pixels. Use the Clean 
command from the Point pulldown menu in order to remove undefined pixels from a selected tie 
line.
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Add straight line

Add straight line command lets you enter a new tie line that represents a straight horizontal or 
vertical line in an image captured by a side-looking camera. Typically, this tie line type is used in 
calibration to solve Zero radius function lens distortion in images of mobile ground-based 
systems.

The best Straight lines are located close to image boundaries and run over a large distance within 
an image. An image should show an object with long straight lines, for example, a building with 
long edges. A few horizontal and vertical straight lines close to all four edges of images provide 
a good base for solving the lens distortion.

See also Section Mobile camera calibration on page 64 for more information about using 
Straight lines in calibration.

To enter a new straight line:

1. Select an image in the upper list of the Tie points window.

The software updates all views in order to show the active image.

2. Select Add straight line command from the Point pulldown menu.
3. Digitize the straight line as you see it in the image in the Active detail view. Due to the lens 

distortion, the line is not straight but curved in the image.

A straight tie line is defined by at least three vertices. The longer the line can be drawn, the 
better for solving the lens distortion. Place the vertices of the line by data clicks and finish it 
with a reset click.

The application adds the tie line to the list in the Tie points window. The values in the list 
show how much each vertex of the tie line differs from a straight line. The left column shows 
these differences after lens distortion correction, the right column before the correction. The 
values are given in pixels.

4. Continue with step 3 until there are enough Straight lines for solving the lens distortion.

Place Straight lines in different images and for each camera of the mission. You can check the 
distribution of the tie lines by using the Draw pixel distribution command from the File 
pulldown menu. For each camera, there should be lines along all four edges of the grid model.
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Edit information

Edit information command lets you modify the type of the selected tie point. For Known xyz tie 
points, the number and coordinate values can be modified as well.

To modify a tie point

1. Select the tie point in the Tie points window.
2. Select Edit information command from the Point pulldown menu.

The Tie point information dialog opens:

3. Select a new Type from the list.

If Type is set to Known xyz, the Number, Easting, Northing, and Elevation fields become 
active.

4. Define a new number and/or coordinate values for the Known xyz tie point.
5. Click OK.

This changes the tie point type and possibly the attributes of a Known xyz tie point.

6. Use Save or Save As commands from the File pulldown menu in order to save the tie points 
into a file.

Clean

Clean command removes all undefined pixels from a selected tie point. This is useful if not all 
pixels for a tie point are placed.

This command automatically restarts commands for adding tie points. Therefore, you can 
immediately continue with placing the next tie point of the same type.

Clean all command from the File pulldown menu removes all undefined pixels from all tie points 
at once.
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Delete

Delete commands remove tie points from the list. There are different options to define the tie 
points that are deleted:

• Selected point - the tie point selected in the list is removed.
• Inside fence - all tie points that are located inside a MicroStation fence or inside a selected 

shape are removed.
• By criteria - all tie points with certain attribute values are removed.

To delete a selected tie point:

1. Select the tie point in the Tie points window.
2. Select Delete / Selected point command from the Point pulldown menu.

This removes the point from the list.

3. Use Save or Save As commands from the File pulldown menu in order to save the tie points 
into a file.

To delete tie points inside a fence:

1. Draw a fence or polygon around the tie points you want to delete. Select the polygon.
2. Select Delete / Inside fence command from the Point pulldown menu.

A dialog shows the number of tie points inside the fence and requests the confirmation of the 
removal process.

3. Click OK in order to remove the tie point(s) from the list.
4. Use Save or Save As commands from the File pulldown menu in order to save the tie points 

into a file.

To delete tie points with certain attributes values:

1. Select Delete / By criteria command from the Point pulldown menu.

The Delete tie points by criteria dialog opens:

2. Select attributes and values for tie point removal.

The amount of effected tie points and pixels is displayed in the dialog.

3. Click OK.

This removes the tie point(s) from the list.

4. Use Save or Save As commands from the File pulldown menu in order to save the tie points 
into a file.

Setting: Effect:
Image Tie points are removed from:

• Active image - the active image only.
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Use the Delete command from the Pixel pulldown menu in order to remove only selected tie point 
pixels instead of complete tie points.

Type Tie points of the selected type are removed.
Class Tie points are removed according to their entry mode:

• Automatic - automatically placed tie points.
• Manual - manually placed tie points.

Mismatch Tie points with a mismatch bigger than the given value are 
removed.

Setting: Effect:



Page 110
11 Working with Tie Points
Pixel pulldown menu
Commands in the Pixel pulldown menu are used to enter tie point pixel positions, to identify a tie 
point in the list, to delete tie point pixels, and to find tie point pixels with large mismatch distances.

To: Choose menu command:
Enter position for the selected tie point pixel Enter position
Select a tie point pixel by identifying a location Identify in image
Delete the selected tie point pixel Delete
Find the pixel with the largest mismatch distance Find worst
Find the first pixel exceeding given mismatch limit Find first bad
Find the next pixel exceeding given mismatch limit Find next bad
Delete tie point pixels with large mismatch distances Filter bad
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Enter position

Enter position command lets you enter the position of a selected tie point pixel. You can use this 
to enter the position of an undefined pixel or to correct the position of a pixel.

The command is also used to enter the positions of tie points that have been imported using 
Import known points or Import known lines commands.

To enter position for a pixel:

1. Select the tie point pixel in the lower list of the Tie points window.
2. Select Enter position command from the Pixel pulldown menu.
3. Enter the new position with a data click in one of the detail views. If the selected pixel is in 

the active image, enter the new position in the Active detail view, if it is in a secondary 
image, enter the position in the Secondary detail view.

If the position of a tie line is entered or corrected, define the new position with two data 
clicks.

This sets the new position of the tie point pixel and recomputes the solution point for this tie 
point.

Identify in image

Identify in image command lets you identify a tie point with a data click. The corresponding tie 
point pixel is then selected in the list.

To select a tie point by its location:

1. Select Identify in image command from the Pixel pulldown menu.

If the mouse pointer is moved inside a view, the tie point closest to the mouse pointer is 
highlighted.

2. Identify a tie point with a data click. You can identify a point in the Active full view or in 
the detail views.

This selects the tie point pixel closest to the data click in the Tie points window.

Delete

Delete command removes the selected tie point pixel from the list. It keeps all other pixels of the 
tie point unchanged.

To delete a tie point pixel:

1. Select the pixel in the lower list of the Tie points window.
2. Select Delete command from the Pixel pulldown menu.

This removes the pixel from the list.

Use the Delete commands from the Point pulldown menu in order to delete tie points completely.
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Find worst

Find worst command finds the tie point pixel with the largest mismatch distance. If you filter out 
bad tie points, it is recommended to first check the pixel with the largest mismatch distance.

To find the worst tie point pixel:

1. Select Find worst command from the Pixel pulldown menu.

The software finds the tie point pixel with the biggest mismatch, activates the first image 
containing this tie point, and selects the worst pixel in the Tie points window. All views are 
updated in order to show the tie point location.

Find first bad

Find first bad command finds the first tie point pixel in the list that has a mismatch distance 
exceeding a given limit. This command is useful when you want to check all tie points with a 
mismatch distance larger than a certain value.

To find the first bad pixel:

1. Select Find first bad command from the Pixel pulldown menu.

This opens the Find first bad pixel dialog:

2. Define a limit in the Mismatch field. All tie points exceeding this mismatch value are 
considered as bad tie points.

3. Click OK.

The application finds the first tie point pixel with a mismatch distance exceeding the limit, 
activates the first image containing this tie point, and selects the bad pixel in the Tie points 
window. All views are updated in order to show the tie point location.

The tie point search is based on the order in which the tie points have been created. This order is 
not visible on the screen as the point list shows only those points which are located in the active 
image.

Find next bad

Find next bad command finds and selects the next tie point in the list whose mismatch distance 
exceeds the given limit. It utilizes the mismatch limit defined by the Find first bad command.

To find the next bad pixel:

1. Define a mismatch limit using the Find first bad command.
2. Select Find next bad command from the Pixel pulldown menu.

The application finds the next tie point pixel with a mismatch distance exceeding the limit, acti-
vates the first image containing this tie point, and selects the bad pixel in the Tie points window. 
All views are updated in order to show the tie point location.
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Filter bad

Filter bad command removes tie point pixels that do not match other tie points. It runs an iterative 
process where it first adjusts image rotation angles using the tie points. Then, it removes the tie 
point pixel with the largest mismatch distance if this pixel exceeds the given limit.

It is recommended to use this command always after running the Search points command for 
automatic tie point search. Some of the automatically placed points are likely to be bad matches 
and most of them can be removed automatically with this command.

To filter out bad points:

1. Select Filter bad command from the Pixel pulldown menu.

This opens Filter bad pixels dialog:

2. Define a limit for removing bad pixels and click OK.

This starts the filtering process. An information dialog shows the amount of deleted tie points 
and pixels after finishing the process.

Setting: Effect:
Filter ratio A tie point pixel is removed if it has a mismatch distance larger 

than the given Filter ratio. The ratio is expressed as factor of the 
average mismatch distance.

Keep all manual pixels If on, manually placed tie point pixels are not effected by the 
filtering process.
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View pulldown menu
Commands in the View pulldown menu are used to define the view setup, to save the view layout 
for later use, to change the zoom ratio of detail views, and to define which attributes are displayed 
in the list boxes of the Tie points window.

To: Choose menu command:
Setup view usage and size Setup
Save the view layout as the default Save as default
Change the zoom ratio of detail views Detail zoom
Set the visibility of attributes in the Tie points window Fields



Page 115
11 Working with Tie Points
Setup

Setup command defines which views are used for tie point entry as well as display settings for the 
views.

The same dialog is shown if the tie point mode is started and the view setup has not been saved 
before.

To define the view setup for tie point entry:

1. Select Setup command from the View pulldown menu.

This opens the Tie point view setup dialog:

2. Define settings and click OK.

This updates all views according to the settings.

Setting: Effect:
Active full View to use as the Active full view.
Zoom to Zoom ratio for the Active full view. The view can use thumbnails 

created by the Create thumbnails command. The thumbnails must be 
stored in the /TEMP folder of the mission. The zoom ratio should be 
set to a ratio for which thumbnails are available in order to speed up 
the display.

Show overlap If on, the application highlights areas in the active image where no tie 
points can be placed.

Active detail View to use as the Active detail view.
Second detail View to use as the Secondary detail view.
Zoom to Zoom level for detail views. Given as a value relative to the Pixel size.
Pixel size Pixel size used in detail views. The default value is about two thirds 

of the actual size of raw image pixels on the ground.
Sample pixel color If on, pixel sampling is applied to the display of images in the detail 

views. This improves the visual quality of edges.
Draw points in all top 
views

If on, tie points are displayed temporarily in MicroStation top views. 
The display is active as long as the Tie points window is open.
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Save as default

Save as default command saves the view layout as the default for the design file. Then, the same 
view arrangement is used every time when the tie point mode is started.

Detail zoom

Detail zoom commands change the zoom level of detail views. After selecting a new value, the 
detail views are updated. The zoom level is given as value relative to the pixel size used in the 
detail views.

See Setup for additional information.
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Fields

Fields command determines the attribute fields that are visible in the Tie points window. It lets 
you select the visibility of information shown in the two list boxes of the window.

To select visible fields:

1. Select Fields command from the View pulldown menu.

This opens the View tie point fields dialog:

2. Select fields and click OK.

This updates the attribute fields display in the Tie points window.

Field: Description:
Straight line count Amount of Straight lines in the image.
Known line count Amount of Known lines in the image.
Line count Amount of Lines in the image.
Known point count Amount of known tie points in the image. Includes Known xyz, 

Known xy, and Known depth tie points.
Ground point count Amount of Ground points in the image.
Depth point count Amount of Depth points in the image.
Air point count Amount of Air points in the image.
Point value Sum of Tie point values for the image.
Coverage Tie point distribution in the image expressed as percentage value.
Average mismatch Average mismatch distance computed from the tie points in the 

image.
Tie status Tie status of the image. A = Approved, C = Check.
Mismatch distance Mismatch distance for each tie point pixel. Given in subunits of the 

design file.
Reliability Indicates the reliability of a tie point pixel. Given in numbers for 

automatically placed tie point pixels. The smaller the number, the 
more reliable is the pixel.
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The process of improving image positioning for project data starts with fine tuning the calibration 
parameters for all cameras of the mission. This part is very similar to the camera calibration 
workflow described in Chapter Camera Calibration on page 46.

The second part of image positioning improvement adjusts the individual images based on a large 
number of tie points per image. The process is usually called aerotriangulation and effects the 
misalignment angle values of the images themselves. Normally, this is done for airborne imagery. 
Mobile ground-based images can be adjusted only with the help of TerraMatch functionality.

Finally, the absolute accuracy of the images can be verified and possibly improved with the help 
of ground control points (GCPs). For airborne imagery, the GCPs are utilized to determine a 
systematic xy shift. The calculated shift values can then be used in a linear transformation applied 
to the images.

For mobile system imagery, the GCPs are also useful to derive fluctuating drift values for 
individual drive paths. These values are used by TerraMatch in order to compute fluctuating 
corrections. More information can be found in the TerraMatch User’s Guide available at 
www.terrasolid.com.
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Adjust Camera Parameters
The camera calibration file for project data is normally created in a separate calibration step at the 
beginning of the TerraPhoto processing workflow. This is described in Sections Airborne 
camera calibration on page 61 and Mobile camera calibration on page 64. However, it is most 
often necessary to adjust the camera parameters to the actual project imagery. If the calibration 
values are good, the fine tuning should not be a big issue.

Airborne projects

The workflow of improving the camera calibration values is very close to the calibration 
workflows described in Airborne camera calibration.

1. Collect a few Ground tie points in several images manually or half-automatically.
2. Solve and apply misalignment angles using Output report command in the Tie points 

window.
3. Collect more tie points and filter out bad tie points.

If the mismatch distances for tie points become smaller (about 2-3 * pixel size of the raw 
images), try to switch to half-automatic tie point entry mode. See Tie point entry modes.

4. Solve and apply misalignment angles using Output report command in the Tie points 
window.

5. Solve principal point z using Tools / Solve parameters command in the TerraPhoto 
camera dialog.

6. Recompute the tie points by using the Apply button in the Camera dialog.
7. Go back to step 3 until images are well-defined regarding Tie point values and Tie point 

distribution. Continue until the values for the misalignment angles and principle point z do 
not change significantly anymore.

8. Solve all other solvable parameters using Tools / Solve parameters command in the 
TerraPhoto camera dialog and apply the changes to the tie points.

The application adjusts roll and pitch misalignment angles if it modifies principal point x and 
y values. The adjustment of the misalignment angles compensates the modification of the 
other parameters.

You may still check for bad tie points using the Find worst command from the Tie points 
window.

9. Go back to step 8 and continue until there is no more improvement and the values are stable. 
The mismatch of the tie points should be around 1 * pixel size of the raw images or smaller.

Mobile ground-based projects

For mobile cameras, it usually enough to fine tune the misalignment angles. The calibration of the 
other camera parameters require special conditions which are seldom fulfilled in project data. See 
Mobile camera calibration for more information.

1. Enter a few Air tie points.

If known points are available, they can be used as Known xyz tie points as well.

2. Solve and apply misalignment angles using Output report command in the Tie points 
window.

3. Go back to step 1 and continue until the modification of misalignment angles does not 
improve the average mismatch of the tie points anymore.
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Adjust image positions
TerraPhoto can improve the relative positions of individual images by adjusting their 
misalignment angle values. The process is normally called aerotriangulation and requires a large 
amount of tie points for each image. This is only done for airborne project imagery. Images from 
a mobile ground-based camera system can be adjusted with TerraMatch functionality only.

The adjustment of image positions requires that the camera parameters are good and stable for the 
project data.

Airborne projects

1. Collect tie points automatically using the Search points command in the Tie points 
window.

2. Filter out bad tie points using commands from the Pixel pulldown menu.
3. If possible, add additional tie points where the automatic search did not find enough tie 

points.
4. Check and possibly apply misalignment angles using Output report command in the Tie 

points window.
5. Check and possibly apply all solvable parameters using Tools / Solve parameters 

command in the Camera dialog.
6. Go back to step 2 and continue until there are no more bad tie points in the tie points file.
7. Adjust the positions of the individual raw images using the Adjust positions command 

from the Images pulldown menu of the TPhoto Main window.
8. Check for bad tie points using the Find worst command from the Tie points window. Bad 

tie points stand out clearly after image positions have been adjusted.
9. Close the adjusted image list without saving and load the original unadjusted image list.
10. Continue with steps 7 - 9 until there are no more bad tie points in the tie point file.
11. Select Save list As command from the Images pulldown menu of the TPhoto Main 

window in order to save the final adjusted image list into a new file.

Do not adjust an image list several times. Load always the original unadjusted image list before 
you adjust positions of the images.

Mobile ground-based projects

For mobile projects, the relative and absolute image adjustment is usually done in one step. The 
workflow is described in detail in Section Mobile ground-based projects on page 123.
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Ground Control Points
The absolute accuracy of the images can be verified and possibly improved with the help of 
ground control points (GCPs). For airborne imagery, the GCPs are utilized to detect a systematic 
xy shift. The calculated shift values can then be used in a linear transformation applied to the 
images.

For mobile system imagery, the GCPs are also useful to derive fluctuating drift values for 
individual drive paths. These values are used by TerraMatch in order to compute fluctuating 
corrections. More information can be found in the TerraMatch User’s Guide available at 
www.terrasolid.com.

GPCs are placed inTerraPhoto as Known xyz, Known xy, or Known depth tie points. They must 
be entered manually in images that see the GPCs’ locations.

Airborne projects

Add control points to the tie point file
For airborne projects, the GPCs’ coordinates are usually imported from a text file into TerraPhoto. 
The text file must store the coordinates of the GCPs in one of the formats:

• Easting Northing Elevation
• Identifier Easting Northing Elevation

1. Use Import known points command in the Tie points window in order to import the text 
file into the Tie points window.

The software adds the control points as Known xyz tie points. The images that see the 
location of a GCP are marked with the asterisk character (*) next to the image number in the 
upper list of the Tie points window. For each image, the tie points are listed in the lower list.
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2. Select an image marked with an asterisk. Select the first line of a Known xyz tie point in the 
tie points list.

The selected image is displayed in the Active detail view and a secondary image is displayed 
in the Secondary detail view.

3. Select Enter position command from the Pixel pulldown menu in the Tie points window.

The location of the GCP coordinates is marked with a cross if the mouse pointer is moved 
into the Active detail view or the Secondary detail view. This can be used as indication 
where the point is located in the image.

4. Enter the tie point with a data click in the Active detail view.

This places the tie point pixel in the active image. The distance between the tie point location 
in the image and GCP coordinates is shown in the tie point list.

5. Enter the tie point with a data click in the Secondary detail view.
6. Select the next undefined pixel of the tie point in the tie point list with a data click or the 

<Arrow down> key.

Continue with step 5 until all pixels of the tie point are defined.

7. Continue with step 2 until all GPCs are defined as tie points.
8. Use Save As command from the File pulldown menu in order to save the tie points into a 

file.

A good practice is to document an accurate description of the location of a GCPs before starting 
the tie points’ placement. You can also use TerraScan, TerraSurvey, or MicroStation tools to read 
in the GCP text file and draw the points into the design file.

If the elevation coordinate of a GCP is not usable, you can change the type of the tie point to 
Known xy using the Edit information command in the Tie points window.

Calculate xy shift values
The software uses the Known xyz or Known xy tie points for determining whether there is a 
systematic xy shift between the images and the GCPs. It suggests correction values for adjusting 
the positions of the images.

1. Create an Output report from the File pulldown menu in the Tie points window. The 
report must include the Known point comparison option.

The Known point comparison part of the report contains a table that lists all GCPs, their 
coordinates, and the xyz shift distances at each tie point location. Then, it shows the 
recommended correction values that should be added to the easting and northing coordinates 
of the images. Finally, the average and worst shift distances are displayed. For example:

You should add    -0.070 to image eastings
You should add    +0.106 to image northings

Pixel mismatches
Average distance  14.22 cm
Worst distance    23.32 cm

Apply the xy shift to the image list
The correction values given in the tie points output report can be used to transform the image list. 
For this purpose, a transformation has to be defined in TerraPhoto Settings. Then, the 
transformation can be applied to the image list.

1. Open Coordinate transformations / Transformations in TerraPhoto Settings.
2. Define a new Linear transformation.

The recommended corrections values for easting and northing from the output report 
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correspond to the Add constant X and Y values in the Settings dialog.

3. Select Transform positions command from the Images pulldown menu in the TPhoto 
Main window.

4. Apply the transformation to the image list.
5. Use Save list As command from the Images pulldown menu in order to save the image list 

into a new file.

If images and laser points need to be shifted with the same correction values, the 
transformation can be copied from TerraPhoto Settings to TerraScan settings. Then, the 
transformation can be applied to the laser points using TerraScan transformation tools. Use 
the Create camera view command in Terra Photo to check how well laser data and images 
match each other.

Mobile ground-based projects

In general, the absolute accuracy of mobile images can be checked and improved in a similar way 
as for images of Airborne projects. However, most often the mismatch in mobile images is not 
a systematic shift but a drift that changes over time. The mismatch basically depends on the 
accuracy of the trajectory that was used to generate the image list. The trajectory accuracy usually 
varies a lot during a mobile survey due to differences in GPS signal availability.

Therefore, the GCPs are rather utilized to derive fluctuating drift values for individual drive paths. 
These values are then used by TerraMatch in order to compute fluctuating corrections.

For mobile projects, the relative and absolute image adjustment is usually done in one step. If no 
GCPs are available, images can be adjusted only internally. In this case, step 5 in the workflow 
below is not applicable.

1. Create an image list which contains only images of a camera that is oriented downward 
towards the ground. For example, use Delete / By camera command from the Images 
pulldown menu of the TPhoto Main window in order to reduce a complete image list.

2. Add known xyz tie points from TerraMatch tie points drawn into the design file. The points 
represent control point locations in the (unmatched) laser data. Enter the tie points only in 
images ofthe closest drive path.

3. Solve and apply misalignment angles with Output report command for the camera in order 
to match the images to the laser data.

4. Compute depth maps for all images, if not yet available. Use laser points that are Close in 
time, which means that depth maps are created based only on points of the same drive path 
as the images.

5. Add known depth tie points for all available GCPs. Use the best image for placing a tie 
point. The best image sees the GCP location best and thus, it is well suited for placing the 
tie point accurately at the GCP location.

6. Add depth tie points at places where no GCPs are available. The tie points should be placed 
at regular distances (25 - 50 m) in order to get a good control of the trajectory drift.

7. Start TerraMatch and search tie line fluctuations based on image tie points. Apply the 
fluctuating corrections to the image list using TerraMatch Apply corrections tool. See 
TerraMatch User’s Guide available at www.terrasolid.com.
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13 Color Points and Selection Shapes

Concept
The commands in the Color points menu provide methods for improving the quality of rectified 
image or colored point clouds. Besides color points, there are several types of correction shapes 
(called selection shapes) which can be placed using tools from the menu.

When you select Define color points command from the Rectify pulldown menu in the TPhoto 
Main window, the applications changes to color point mode. There are two modes available:

• Ground ortho - for rectified images or orthophotos.
• Point cloud - for colored point clouds, especially mobile laser scanning point clouds.

Color points for image rectification require a ground model loaded in TerraPhoto. The mode can 
not be selected, if there is no ground model available. If the color point mode starts, the software 
builds a triangulated ground model, opens the Color points menu for Ground ortho color points, 
and displays a preview of the ortho mosaic in a MicroStation top view.

Color points for point clouds require a TerraScan project that manages the point cloud and a point 
cloud format that is able to store color values, image numbers, and normal vectors/dimensions for 
each point. The storage of all these attributes is only possible in TerraScan Fast binary format. 
See TerraScan User’s Guide for more information about projects, point cloud formats and 
attributes. If the color point mode starts, the software sets up the display mode for laser points, 
extracts on-the-fly color values for the points, and opens the Color points menu for Point cloud 
color points.

The color point mode is closed when the Color points menu is closed.

The software uses thumbnails for the preview of the orthophoto mosaic in color point mode. The 
thumbnails must be stored in the /TEMP folder of the mission. See Create thumbnails on page 
279 for more information.

Color points

Color points form a triangulated correction model where each color point provides intensity 
(brightness) and RGB color balance corrections at the point’s xy location. The correction model 
for rectified images is illustrated in the figure below.

Color points are stored in text files with the extension .CPT. The files includes the following 
information:

• for each color point: type, xyz coordinate values in current projection system, radius, intensity 
value, RGB values, for Point cloud color points XYZ components of the normal vector

• for each image: weight, intensity value, RGB values, color point xy coordinates in image 
pixels

The xyz coordinate values are recomputed whenever necessary. You do not need to apply 
coordinate transformations to color points.

When color points are loaded in memory, they are drawn temporarily as MicroStation circle 
elements on a design file level. The level and color for drawing color points are defined in Color 
points of TerraPhoto Settings. The drawing disappears if the Color points menu is closed.
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Color points can be placed manually or automatically. The automatic method first searches for a 
large number of potential color points. Then, it rates each point by checking if the point is needed 
and fits into the correction model. Finally, the best points are selected. After an automatic search, 
the color points should be checked and possibly filtered. There are manual editing options as well 
as automatic methods for filtering out bad color points.

There are several types of color points according to the method of color correction computation:

• Average - intensity and color values are averaged from all images at the color point location. 
This is the method used for automatically placed Point cloud color points.

• Grey average - color values are balanced in order to get the averaged grey value.
• Fixed - hue, saturation, and value (HSV color model) components of the color point can be 

set to fixed values. This type can be placed only manually.
• Reference - colors from reference images are use for target color calculation. Requires an 

image attached as TerraPhoto reference at the location of color point. This type can be placed 
only manually.

If object shapes are available, they can be used for Ground ortho color points on roof tops. The 
process can also use shadow maps in order to determine locations where trees or other objects 
cause shadow effects. See Compute shadow maps on page 282 for more information.

Selection shapes

Selection shapes are correction polygons that improve the quality of the final orthophoto mosaic 
or colored point cloud. Basically, they manipulate the seamlines (boundaries) between adjacent 
raw images in the orthophoto mosaic or specify certain images for being used in areas defined by 
the selection shapes.

Common problems in orthophoto mosaics from airborne image data are large objects, like 
buildings, cut by seamlines; small objects, like trees or cars cut by seamlines; areas with 
differences in structure, brightness, texture, etc., such as water under changing light conditions; 
images from different altitudes. In image data of ground-based mobile systems, most problems are 
related to moving objects, for example cars on a road, that are visible in some of the raw images.

Most issues in ground-based mobile point clouds are caused by the changing light conditions for 
the different cameras and by moving objects.
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Selection shapes are distinguished into different types:

• Selection shapes - specify one image to be used inside the shape. Good for larger objects, 
such as buildings, that are cut by raw image boundaries. For Point clouds, also colors from 
multiple images of one line can be used inside the shape.

• Quality shapes - specify an area within which only images with a given quality number are 
used for rectification. Useful, for example, if images from two altitudes and with different 
qualities are available. In images from mobile systems, quality shapes can be used to exclude 
cars or other moving objects by using images from another drive path. Available in Ground 
ortho mode only.

• Smearing shapes - specify an area close to raw image boundaries, where pixels are blurred. 
Good for water surfaces with sun reflexions or fields with low vegetation. Available in 
Ground ortho mode only.

• Auto seamline shapes - specify one image to use inside a small shape. Good for small 
objects, like trees or cars in airborne data sets. Available in Ground ortho mode only.

• Shadow shapes - specify shadow areas in point clouds. Available in Point cloud mode only.

Auto seamlines are created automatically, all other types of selection shapes are placed manually. 
All types of shapes in Ground ortho mode are drawn as MicroStation shape elements into the 
design file. They can be edited with MicroStation tools. Symbology settings of selection shapes 
can be defined in Selection shapes of TerraPhoto Settings.

Shapes in Point cloud mode are only drawn temporarily. Selection shapes manipulate the image 
assignment stored for the laser points.
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File pulldown menu
Commands in the File pulldown menu are used to open and save color points, to recompute color 
points, to search for color points automatically, to filter out bad color points automatically, and to 
change the image numbers in a color points file.

To: Choose menu command:
Erase currently defined color points New
Open a previously saved color point file Open
Save color points to an existing file Save
Save color points to a new file Save As
Recompute color points Recompute all
Search automatically for new color points Search points
Remove bad color points automatically Filter bad
Modify image numbers in the color points file Renumber images
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New

New command erases currently defined color points and starts a new color point file. It removes 
active color points from the memory.

Open

Open command reads previously saved color points from one or multible files on the hard disc.

To open color points:

1. Select Open command from the File pulldown menu.

This opens the Open color points dialog, a standard dialog for opening files.

2. Select one or more files to open.
3. After all files are added to the list of files, click Done.

This loads the color points into memory and displays them in MicroStation views.

Save

Save command saves the color points to the same file from which they have been opened before. 
The command is not available, if color points have been opened from multiple source files.

Save As

Save As command saves the color points into a new file.

Recompute all

Recompute all command recomputes color points. This is necessary if you made changes to raw 
image coloring using Define color corrections command while color points were closed.
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Search points

Search points command starts the automatic color point search. The software can place color 
points of types Average (Gound ortho and Point cloud color points) and Grey average 
(Ground ortho color points) automatically. The search can be restricted to certain areas, images, 
and a color point density.

The automatic method first searches for a large number of potential color points. Then, it rates 
each point by checking if the point is needed and fits into the correction model. Finally, the best 
points are selected. After the automatic search, it might be good to check for bad color points using 
Find worst, Find first bad, or Find next bad commands and/or to filter out bad color points 
automatically using the Filter bad command.

The settings for the automatic search depend on the color point mode. The color point mode is 
selected when the Define color points command is started. See the command’s description or 
Concept of color points and selection shapes for more information about color point modes.

To search color points for (ortho) rectification automatically:

1. Select Search points command from the File pulldown menu.

This opens the Search color points dialog:

2. Define settings and click OK.

If Save results automatically is switch on, the Save auto search results dialog is opened, 
a standard dialog for saving files.

3. Define a location and name for the color points file and click Save.

The application starts searching for color points. A progress window indicates which step is 
processed.

Setting: Effect:
Search type Defines how color points are placed related to the shape of the 

search area:
• Aerial - search within an aerial project area. Color points are 

placed all over the area.
• Along centerline(s) - search along selected linear elements. 

This requires that at least one line or shape element is selected 
in the design file before starting the search.
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To search color points for point clouds automatically:

1. Select Search points command from the File pulldown menu.

This opens the Search color points dialog:

2. Define settings and click OK.

The application starts searching for color points. Depending on the size of the point cloud, 

Create type Type of the color points:
• Average - intensity and color values are averaged.
• Grey average - color values are balanced in order to get the 

averaged grey value.
Images Defines what images are included in the color point computation:

• All overlapping - all images that see the color point location.
• Assigned only - only images which contribute to orthophoto 

pixel colors inside the color point radius. If the color point is 
placed at the seamline of two images, only those two images are 
used to compute the target color. This may exclude unwanted 
coloring effects from more distant images.

• Upto 2 ... 6 closest - up to the given number of images closest 
to the color point location.

Aim for Defines the density and thus, the overall amount of color points:
• Very low density - generates the smalles amount of points.
• Low density - generates fewer points.
• Medium density - generates a medium amount of points.
• High density - generates more points.
• Very high density - generates the highest amount of points.

Search Defines the area for color point search related to raw images:
• Everywhere - searches color points within the whole image.
• Along seamlines - searches only close to image seamlines 

Within the given distance.
Point radius Size of color points. Defines the area that is used for computing the 

color point’s intensity and RGB values.
Inside fence only If on, color points are placed inside a fence only. This requires that 

a MicroStation fence has been drawn before the command is 
started.

Exclude polygons If on, no color points are searched inside shape elements on the 
given design file Levels. Separate several levels by comma.

Use shadow maps If on, the routine uses shadow maps stored in the /TEMP directory 
of the mission. See Compute shadow maps for more information.

Save results automatically If on, the routine saves color points in regular intervals into the 
active color point file. If a new file is started, the software asks for 
a location and file name for storing the color points.

Setting: Effect:
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the process may take some time.

Setting: Effect:
Laser points Defines the source of the point cloud:

• Loaded points - points loaded in TerraScan.
• Active project - points referenced by a TerraScan project.

Point radius Size of color points. Defines the area that is used for computing the 
color point’s intensity and RGB values. Color points should be big 
enough to contain a few pixels in the raw images also at a longer 
distance in order to allow the averaging of colors.

Aim for Defines the density and thus, the overall amount of color points:
• Very low density - generates the smalles amount of points.
• Low density - generates fewer points.
• Medium density - generates a medium amount of points.
• High density - generates more points.
• Very high density - generates the highest amount of points.

Inside fence only If on, color points are placed inside a fence only. This requires that 
a MicroStation fence has been drawn before the command is 
started.

Save results Defines how color points are saved:
• No automatic save - color points are not saved immediately 

into a file on a hard disk.
• One file - all color points are stored into one file. The file is 

created automatically when the color point search is started.
• File for each block - a separate color point file is stored for 

each block of the TerraScan project. This is recommeded for 
big projects in order to allow more structured manual work 
after the automatic search.

This is only active if Laser points is set to Active project.
Folder Storage directory for color point files. This is only active if Save 

results is set to File for each block.
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Filter bad

Filter bad command removes color points that cause big brightness or color corrections, or that 
do not have other color points with approximately the same normal direction closeby.

It is recommended to use this command after running the automatic color point search with the 
Search points command or the automatic placement of color point clones for mobile images using 
the Add clones command. Some of the automatically placed clones are likely to be placed at 
locations where there are moving objects in some of the images.

Before and after filtering bad color points automatically, it is recommended to use Find worst 
command from the Point pulldown menu several times in order to get an idea about the location 
with the biggest brightness and color corrections.

To filter out bad color points:

1. Select Filter bad command from the File pulldown menu.

This opens Filter bad color points dialog:

2. Define limits for removing bad points and click OK.

This starts the filtering process. An information dialog shows the amount of completely and 
partly deleted color points after finishing the process.

3. Save the color points using Save or Save As commands from the File pulldown menu in 
order to save the color points into a file.

Setting: Effect:
Brightness correction If on, a color point is removed if it causes a brightness value 

correction larger than the given value. The limit value is expressed 
as factor of the average brightness correction.

Color correction If on, a color point is removed if it causes an RGB value correction 
larger than the given value. The limit value is expressed as factor 
of the average color correction.

Normal vector If on, a color point is removed if there is less than the given amount 
of points within the given distance from this color point. This is 
only available for Point cloud color points.

Remove inside fence only If on, only color points inside a fence are effected. This requires 
that a MicroStation fence has been drawn before the command is 
started.
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Renumber images

Renumber images command renumbers all or a given range of images in the color points file and/
or for selection shapes. It adds a constant number to the existing image numbers.

TerraPhoto requires a unique number for images in the active image list which is derived from the 
image file names. These image numbers are stored in the color points file and for selection shapes. 
If it is necessary to rename the image files, the numbers in the image list change. Therefore, it 
might be necessary to change the image numbers in the color points file and for selection shapes 
as well in order to ensure that they still work for the renamed images.

To renumber images:

1. Select Renumber images command from the File pulldown menu.

This opens the Renumber color point images dialog:

2. Define settings and click OK.

The new numbering is applied for the color points and/or selection shapes. An information 
dialog shows the amount of images that have been renumbered.

3. Save the color points using Save or Save As commands from the File pulldown menu in 
order to save the color points with renumberd images into a file.

Setting: Effect:
Apply to Defines what data is effected by the renumbering process: Color 

points and shapes, Color points only, or Shapes only.
For images Range of image numbers for which the renumbering is applied.
Add to number Value that is added to current image numbers. Negative values can 

be used.
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Point pulldown menu
Commands in the Point pulldown menu are used to add, edit, and delete color points, and to filter 
out bad color points manually.

To: Choose menu command:
Add a color point manually Add
Add clones of a color point Add clones
Edit a color point Edit
Delete color points Delete
Find the color point with the biggest correction values Find worst
Find the first color point with a certain correction value Find first bad
Find the next color point with a certain correction value Find next bad
Adjust color point corrections inside a fence Equalize inside fence
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Add

Add command lets you add a new color point manually.

To add a new color point:

1. Select Add command from the Point pulldown menu.

This opens the Add Color Point dialog:

2. Select settings for the new color point.
3. Enter the position of the color point with a data click inside a view.
4. Update the view in MicroStation in order to make color changes visible.
5. Save the color points using Save or Save As commands from the File pulldown menu in 

order to save the color points into a file.

The Add Color Point tool from the Color Points toolbar performs the same action.

Setting: Effect:
Type Type of the color point:

• Average - intensity and color values are averaged at the 
location of the color point.

• Grey average - color values are balanced in order to get the 
averaged grey value.

• Fixed - values for hue, saturation and value can be set 
manually. See Edit on page 137 for more information.

• Reference - colors from reference images are use for target 
color calculation. Requires an image attached as TerraPhoto 
reference at the location of color point.

Images Defines what images are included in the color point computation:
• All overlapping - all images that see the color point location.
• Assigned only - only images which contribute to orthophoto 

pixel colors inside the color point radius. If the color point is 
placed at the seamline of two images, only those two images are 
used to compute the target color. This may exclude unwanted 
coloring effects from more distant images.

• Upto 2 ... 6 closest - up to the given number of images closest 
to the color point location.

• Select in dialog - images can be chosen in a dialog. See Edit 
command for more information.

Radius Size of the color point. Defines the area that is used for computing 
a color point’s intensity and RGB values.
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Add clones
Ground ortho only

Add clones command creates clones of color points. The location of one color point clone is 
defined by a data click. Then, the software creates color points automatically in each image at the 
same location determined by the color point pixel coordinates.

The command provides an automatic way of creating color points for mobile images captured 
along a road. The color point clones work well if the images were captured at a constant driving 
speed and if the system was driven without much left/right variation within a lane.

After the automatic placement of color points, it is recommended to check for bad color points 
using Find worst, Find first bad, or Find next bad commands. A more automatic approach of 
filtering out bad color points can be done using the Filter bad command.

To add color point clones:

1. Select Add clones command from the Point pulldown menu.

This opens the Add Clone Color Points dialog:

2. Select settings for the color point clones.
3. Enter the position of one color point with a data click inside a view.

This starts the creation of the color point clones. A progress bar shows the progress of the 
process.

4. Save the color points using Save or Save As commands from the File pulldown menu in 
order to save the color points into a file.

The Add Clone Color Points tool from the Color Points toolbar performs the same action.

Setting: Effect:
Type Type of the color points:

• Average - intensity and color values are averaged at the 
location of the color point.

• Grey average - color values are balanced in order to get the 
averaged grey value.

Images Defines what images are included in the color point computation:
• All overlapping - all images that see the color point location.
• Assigned only - only images which contribute to orthophoto 

pixel colors inside the color point radius. If the color point is 
placed at the seamline of two images, only those two images are 
used to compute the target color. This may exclude unwanted 
coloring effects from more distant images.

• Upto 2 ... 6 closest - up to the given number of images closest 
to the color point location.

• Select in dialog - images for each clone must be chosen in a 
dialog. See Edit command for more information.

Radius Size of color points. Defines the area that is used for computing a 
color point’s intensity and RGB values.
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Edit

Edit menu command lets you modify a color point.

To edit a color point:

1. Select Edit command from the Point pulldown menu.
2. If the mouse pointer is moved into the view, the color point closest to the mouse pointer is 

highlighted.
3. Select the color point for editing by a data click.

This opens the Color point dialog:

Left side: List of images involved in the color point calculation. The left point shows the 
coloring before color correction, the right point after correction.

Right side: Image preview, input fields for color point attributes.

4. Make modifications to the color point and click OK.
5. Update the view in MicroStation in order to make changes visible.
6. Save the color points using Save or Save As commands from the File pulldown menu in 

order to save the color points into a file.

Setting: Effect:
Weight Indicates, how much a source image influences the average target 

color. To set the weight for an image, select it in list of images on 
the left side of the dialog. Images close to the color point have a 
big default weight value. More distant images have a smaller 
default weight value.

Delete image Deletes the selected image from color point computation.
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The Edit Color Point tool from the Color Points toolbar performs the same action.

Radius Modifies the size of the color point. This effects the color point in 
all images.

Target Modifies the type of the color point:
• Average - intensity and color values are averaged at the 

location of the color point.
• Grey average - color values are balanced in order to get the 

averaged grey value.
• Fixed - values for Hue, Saturation, and Value can be set 

manually.
• Reference - colors from reference images are use for target 

color calculation. Requires an image attached as TerraPhoto 
reference at the location of color point.

Hue Hue value of the color point between 0 and 359. This is only 
available for color points of type Fixed.

Saturation Saturation value of the color point between 0 and 100. This is only 
available for color points of type Fixed.

Value Value value of the color point between 0 and 100. This is only 
available for color points of type Fixed.

Setting: Effect:
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Delete

Delete commands remove color points from the file. There are different options to define the color 
points that are deleted:

• One point - a manually selected color point is removed.
• Inside fence - all color points that are located inside a MicroStation fence or inside a selected 

shape are removed.
• Outside fence - all color points that are located outside a MicroStation fence or outside a 

selected shape are removed.
• Inactive images - all color points that use inactive images are removed.

To delete one color point:

1. Select Delete / One point command from the Point pulldown menu.

If the mouse pointer is moved inside a view, the color point closest to the mouse pointer is 
highlighted. In addition, images that are used in the color point are marked with a line.

2. Identify the color point which you want to delete with a data click.

You can continue by identifying the next color point you want to delete.

3. Update the view in MicroStation to make changes visible.
4. Save the color points using Save or Save As commands from the File pulldown menu in 

order to save the color points into a file.

The Delete Color Point tool from the Color Points toolbar performs the same action.

To delete color points inside/outside a fence:

1. Draw a fence with MicroStation Place fence tool around color points you want to delete.

OR

1. Draw a shape with any MicroStation tool around the color points you want to delete. Select 
the shape.

2. Select Delete / Inside fence command from the Point pulldown menu.

This opens an alert dialog that shows how many points are deleted and asks for confirmation.

3. Click Yes in order to delete the color points.
4. Update the view in MicroStation to make color changes visible.
5. Save the color points using Save or Save As commands from the File pulldown menu in 

order to save the color points into a file.

The procedure is analog for deleting points outside a fence.

To delete color points in inactive images

1. Select Delete / Inactive images command from the Point pulldown menu.

This opens an alert dialog that shows how many points are deleted and asks for confirmation.

2. Click Yes in order to delete the color points.
3. Update the view in MicroStation to make color changes visible.
4. Save the color points using Save or Save As commands from the File pulldown menu in 

order to save the color points into a file.

The process deletes color points from images with their Rectify status set to No. See Edit 
command for modifying the status of one or more images.
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Find worst

Find worst command finds the color point with the largest brightness or color correction. If you 
filter out bad color points, it is recommended to first check the point with the largest corrections.

To find the worst color point:

1. Select Find worst command from the Point pulldown menu.

This opens the Find worst color point dialog:

2. Select the type of correction for which you want to see the color point with the largest 
correction: Brightness correction or Color correction.

3. Click OK.

The software updates the view in order to show the color point with the biggest correction. 
The color point is highlighted with a cross as long as the mouse pointer is located inside the 
view.

The dialog for Editing the color point can be opened directly by another data click as long as the 
color point is highlighted.

Find first bad

Find first bad command finds the first color point at a location where a raw image has an intensity 
value larger or smaller than a given limit. This command is useful when you want to check color 
points that are effected by very bright or dark images.

To find the first bad color point:

1. Select Find first bad command from the Point pulldown menu.

This opens the Find first bad color point dialog:

2. Select what kind of images you want to check: Bright raw image or Dark raw image.
3. Define a limit in the Intensity field.
4. Click OK.

The software finds the first color point with a larger or smaller intensity value than the given 
limit. The view is updated in order to show the color point location. The color point is 
highlighted with a cross as long as the mouse pointer is located inside the view.

The dialog for Editing the color point can be opened directly by another data click as long as the 
color point is highlighted.
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Find next bad

Find next bad command finds and selects the next color point in the list with a larger/smaller 
intensity value than the given limit. It utilizes the intensity limit defined by the Find first bad 
command.

To find the next bad color point:

1. Define an intensity limit using the Find first bad command.
2. Select Find next bad command from the Point pulldown menu.

The application finds the next color point with a larger or smaller intensity value than the 
given limit. The view is updated in order to show the color point location. The color point is 
highlighted with a cross as long as the mouse pointer is located inside the view.

The dialog for Editing the color point can be opened directly by another data click as long as the 
color point is highlighted.
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Equalize inside fence
Point cloud only

Equalize inside fence command applies a color adjustment to color points inside a fence or 
selected polygon. As a result, the coloring of the point cloud around the effected color points looks 
more unique.

To equalize colors inside a fence:

1. Draw a MicroStation fence or shape element around the area you want to adjust. Select the 
shape element.

2. Select Equalize inside fence command from the Point pulldown menu.

This manipulates the color points inside the fence or selected polygon.

3. Save the color points using Save or Save As commands from the File pulldown menu in 
order to save the color points into a file.
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Image pulldown menu
Commands from the Image pulldown menu are used to improve the quality of the final 
orthophotos by placing selection shapes, quality shapes, and/or smearing shapes. There are 
different tools for assignment or placement of the different types of shapes. Additionally, there is 
a tool for automatic seamline search.

The settings for selection shapes are defined in Selection shapes of the TerraPhoto Settings.

To: Choose menu command:
Create selection shapes from polygons Assign selection polygons
Create quality shapes from polygons Assign quality polygons
Create smearing shapes from polygons Assign smearing polygons
Create shadow shapes from polygons Assign shadow polygons
Create a selection shape by mouse pointer movement Paint selection
Create a selection shape by mouse clicks Place selection
Search for seamline shapes automatically Search seamlines
Update shapes from the design file Update from design
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Assign selection polygons
Ground ortho only

Assign selection polygons command creates Selection shapes from selected polygons drawn in 
the design file.

This is useful if you have polygons of buildings or building roofs. If they are assigned as Selection 
shapes, the area designated by one polygon is rectified from a single raw image if possible.

To assign selection polygons:

1. Draw and select polygon(s) with MicroStation tools.
2. Select Assign selection polygons from the Image pulldown menu.

This opens the Assign polygons dialog:

3. Select settings and click OK.

This assigns the image to each selected polygon which best covers the area of the polygon.

If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings, 
it also creates a copy of the original polygon(s) on the design file level that is defined for 
storing Selection shapes.

4. Update the view in MicroStation to make changes visible.

Setting: Effect:
Expand by Value by which polygons are expanded. A negative value can be 

used in order to shrink the polygons.
Skip polygon if No image is assigned to a selected polygon if:

• Default assignment is one image - the area inside the polygon 
is covered by only one image.

• No image sees complete polygon - the area inside the polygon 
is not covered completely be a single image.
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Assign quality polygons
Ground ortho only

Assign quality polygons command specifies an area to be rectified from images with a certain 
quality number. The tool requires the differentiation of several quality numbers for raw images. 
See the Edit command for modifying the quality numbers of one or more images.

For example, if an area is covered by aerial images from two different altitudes, images from the 
lower altitude might have a better quality and should be used whenever possible. This can be 
managed by using quality shapes around the area covered by the low altitude images. Images from 
a higher altitude are only use outside the quality shapes.

Another usage example for mobile images of a road is to remove moving objects from orthophotos 
of the road surface. If the objects are seen in images of one drive path, quality shapes can define 
that images from another drive path are used. To achieve that, images from each drive path must 
have different quality numbers.

To assign quality polygons:

1. Draw and select polygon(s) with MicroStation tools.
2. Select Assign quality polygons from the Image pulldown menu.

This opens the Assign quality polygons dialog:

3. Select settings and click OK.

This assigns images with a specified quality to the polygon(s).

If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings, 
it also creates a copy of the original polygon(s) on the design file level that is defined for 
storing Quality shapes.

4. Update the view in MicroStation to make changes visible.

Setting: Effect:
Use Defines which images are used inside quality shapes:

• Best quality - images with the best quality value are used.
• Specific quality - only images with the given quality value are 

used. If no such images are available, the area is filled with 
background pixels.

Quality Quality value of images used inside quality shapes. This is only 
active if Use is set to Specific quality.
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Assign smearing polygons
Ground ortho only

Assign smearing polygons command specifies areas where image pixels are blurred close to 
image seamlines.

This is useful for places where not only the color changes at image seamlines but also the texture. 
Examples are water areas with sun reflection or fields with small vegetation under changing light 
conditions.

To assign smearing polygons:

1. Draw and select polygon(s) with MicroStation tools.
2. Select Assign smearing polygons from the Image pulldown menu.

This opens the Assign smearing polygons dialog:

3. Define a Distance setting and click OK.

This blurs pixels within the defined distance on both sides of image seamlines.

If Force symbology settings are switched on in Selection shapes of theTerraPhoto Settings, 
it also creates a copy of the original polygon(s) on the design file level that is defined for 
storing Smearing shapes.

4. Update the view in MicroStation to make changes visible.
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Assign shadow polygons
Point cloud only

Assign shadow polygons command specifies areas where the point cloud coloring is effected by 
shadows. Within such polygons, the software applies a brightness correction in order to reduce the 
effect of shadows.

To assign shadow polygons:

1. Draw and select polygon(s) with MicroStation tools.
2. Select Assign shadow polygons from the Image pulldown menu.

This applies the brightness correction to the color points and updates the view.
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Paint selection
Ground ortho only

Paint selection command lets you draw a Selection shape by moving the mouse pointer over an 
area. The tool works like a brush tool. The Selection shape is drawn around all pixels that are 
touched by the brush.

To paint a selection polygon:

1. Select Paint selection from the Image pulldown menu.

This opens the Paint Selection Shape dialog:

2. Define settings for brush size and image selection.
3. Place a data click and keep the mouse button pressed. Move the mouse pointer over the area 

that you want to be covered by a Selection shape. Release the mouse button to finish the 
shape.

This creates a Selection shape around all pixels touched by the brush.

If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings, 
the shape is drawn on the design file level using the symbology that is defined for Selection 
shapes. Otherwise, the shape is drawn on the active level using active symbology settings of 
MicroStation.

The Paint Selection Shape tool from the Color Points toolbar performs the same action.

Setting: Effect:
Brush size Pixel size of the brush for painting the shape.
Select image with separate 
click

If on, the image used inside the Selection shape is defined by a 
separate data click. If off, the image is defined by the first data 
click when the painting is started.
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Place selection

Place selection command lets you draw a Selection shape by digitizing the shape manually.

The settings for the command depend on the color point mode. The color point mode is selected 
when the Define color points command is started. See the command’s description or Concept of 
color points and selection shapes for more information about color point modes.

To place a selection shape for (ortho) rectification:

1. Select Place selection from the Image pulldown menu.

This opens the Place Selection Shape dialog:

2. Select settings.
3. Digitize a polygon around the area that you want to be covered by a Selection shape.

If the mouse pointer is moved close to the first vertex, the software snaps to this vertex to 
close the polygon.

4. Accept the selection shape with another data click.

This creates a Selection shape around all pixels inside the polygon.

If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings, 
the shape is drawn on the design file level using the symbology that is defined for Selection 
shapes. Otherwise, the shape is drawn on the active level using active symbology settings of 
MicroStation.

To place a selection shape for point clouds:

1. Select Place selection from the Image pulldown menu.

This opens the Place Cloud Selection dialog:

2. Select settings.

Setting: Effect:
Show coverage If on, areas outside the image are highlighted after the image for 

being used for the Selection shape is selected. This shows whether 
the selected image covers the Selection shape area or not.

Select image with separate 
click

If on, the image used inside the Selection shape is defined by a 
separate data click. If off, the image is defined by the first data 
click when the digitization is started.

Setting: Effect:
Color from Defines from which images the color values are extracted inside 

the selection shape:
• Single image - you select the best image for point cloud 

coloring.
• Multible images - you select the line from which images are 

used for point cloud coloring.
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3. Digitize a polygon around the area that you want to be covered by a Selection shape.

If the mouse pointer is moved close to the first vertex, the software snaps to this vertex to 
close the polygon.

This opens the Selection images dialog:

If Single image has been selected in step 2, the dialog shows a list of all images in the active 
image list that see the location of the selection shape.

If Multiple images has been selected in step 2, the dialog shows a list of cameras per line in 
the active image list that see the location of the selection shape. Use the Deduce line 
numbers command in order to get correct line numbers for images.

4. Select an image or camera from the list.

This updates the point cloud coloring according to the selection.

5. If the best image or camera for coloring the points is selected, click OK.

This applies the new image assignment to the laser points.

The placement of a shape vertex can be undone by clicking the reset button during the 
digitalization process.

The Place Selection Shape tool from the Color Points toolbar performs the same action.
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Search seamlines
Ground ortho only

Search seamlines command creates Auto seamline shapes automatically along image seamlines.

This is useful for small objects in aerial images, like trees or cars, that are cut by image seamlines.

To search seamlines:

1. Select Search seamlines from the Image pulldown menu.

This opens the Search Seamlines dialog:

2. Define settings.
3. Start the search with a data click inside the view.

If Search is set to Between two images, the search starts after the images have been defined 
by two data clicks.

The application starts to search Auto seamline shapes. A progress bar shows the progress of 
the process. The search for a large data set may take a while.

Update from design
Ground ortho only

Update from design command rebuilds selection shape information from design file elements.

Normally, this command is not needed because TerraPhoto automatically recognizes 
modifications of design file elements.

Setting: Effect:
Search Defines the area for creating Auto seamline shapes:

• Between two images - creates shapes along the seamline 
between two images. The two images are defined by data clicks 
inside the images.

• Inside fence - creates shapes along seamlines inside a fence.
• Image number range - creates shapes for images within a 

defined image number range.
• Whole dataset - creates shapes for all images.

Max size Maximum size of Auto seamline shapes.
Numbers Numbers that define the range of images for which Auto seamline 

shapes are created. This is only active if Search is set to Image 
number range.
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View pulldown menu
Commands in the View pulldown menu are used to set the display mode for the orthophoto 
preview(s), to zoom to a specific resolution ratio, and to show the area covered by one image.

To: Choose menu command:
Change display settings for views Display mode
Zoom to a defined resolution ratio Zoom to
Show the area covered by a single image Show coverage
Show color points that cause a color correction at a 
certain location

Correction points
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Display mode

Display mode command is used to define what elements are drawn in the orthophoto or colored 
point cloud previews, if the color point mode is active.

To set the display mode for (ortho) rectification:

1. Select Display mode from the View pulldown menu.

This opens the Color Point Display Mode dialog:

2. Select settings and click Apply or All views.

This updates the display in the selected view or in all MicroStation views.

To set the display mode for point clouds:

1. Select Display mode from the View pulldown menu.

This opens the Color Point Display dialog:

2. Select settings and click Apply or All views.

This updates the display in the selected view or in all MicroStation views.

Setting: Effect:
View View for which the settings are applied.
Raster Defines, how images are shown in the view(s):

• None - nothing is displayed.
• Orthophotos - the rectified raw images are displayed. If 

thumbnails are available, they are used for the display.
• Image assignment - the areas covered by different raw images are 

displayed with different colors.
• Image quality - the areas covered by different raw images are 

displayed with a color according to the image’s quality number. 
The quality number determines the color number used from the 
active color table of MicroStation.

Draw points If on, color points are shown in the view.
Draw seamlines If on, image seamlines are shown in the view.
Selection shapes If on, all types of selection shapes are shown in the view.
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Setting: Effect:
View View for which the settings are applied.
Display Defines, how points is displayed:

• Do not display - nothing is displayed.
• Colored points - points colored by RGB coloring.
• Image assignment - points colored by the image assignment 

attribute.
Draw color points If on, color points are shown in the view.
Draw seamlines If on, image seamlines are shown in the view.
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Zoom to
Ground ortho only

Zoom to command zooms the view to a predefined resolution ratio.

To zoom to a predefined resolution ratio:

1. Select one of the Zoom to / 1:x commands from the View pulldown menu.

If the mouse pointer is moved inside the view, a rectangle with the new view extent is 
displayed.

2. Place a data click inside the view.

This updates the view display in order to show the preview with the selected resolution ratio 
and centered to the location of the data click.

The preview display is faster if the resolution is set to a ratio for which thumbnails are available. 
See Create thumbnails command for more information.

Show coverage
Ground ortho only

Show coverage displays the area cover by one single image. The image is defined by a data click. 
The area outside this image is masked with a temporary red transparent color filling.

To show the coverage of an image:

1. Select Show coverage command from the View pulldown menu.
2. Move the mouse pointer inside the view.

The footprint of an image is highlighted dynamically if the mouse pointer is inside the image.

3. Place a data click inside an image.

The area outside the selected image is masked. You can remove the mask by clicking the 
reset mouse button.
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Correction points

Correction points highlights color points that effect the coloring of an image at the mouse pointer 
location. The highlighted color points can then be selected for editing or removal.

To highlight color points:

1. Select Correction points command from the View pulldown menu.
2. Move the mouse pointer to a location where the coloring looks strange.

This highlights dynamically the color points that contribute to the coloring at the mouse 
pointer location. It also opens the View Correction Points dialog:

3. Select in the Action field whether you want to Edit a point or Delete.
4. Select one of the color points with a data click.

If Action is set to Edit point, this opens the Color point dialog for editing the point. See 
Edit command for more information.

If Action is set to Delete, this deletes the selected color point.
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Tool pulldown menu
Commands from the Tool pulldown menu are used to draw seamlines into the design file, to 
transform selection shapes from one projections system to another, and to derive sun hot spot 
corrections.

To: Choose menu command:
Draw seamlines into the design file Draw seamlines into design
Transform selection shapes Transform selection shapes
Derive corrections for sun hot spots in images Derive image corrections
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Draw seamlines into design
Ground ortho only

Draw seamlines into design command draws image seamlines as polygons into the design file. 
This illustrates where each raw image is used in the final orthophoto mosaic. In addition, a label 
can be created for each polygon.

To draw seamlines into design:

1. Select Draw seamlines into design command from the Tool pulldown menu.

This opens the Draw seamlines into design dialog:

2. Select settings and click OK.

The application draws the seamline polygons into the design file. A processing window 
counts the number of images for which seamlines are drawn.

Setting: Effect:
Draw area Defines which seamlines are drawn into design file:

• Whole dataset - seamlines of all images.
• Selected tiles - seamlines are drawn if they are inside selected tile 

shapes. This requires the selection of at least one tile shape before 
the command is started.

Level Design file level on which the seamline polygons are drawn.
Line color Outline color and weight of seamline polygons. Uses the active color 

table of MicroStation and standard line widths.
Fill colors Fill colors of seamline polygons. The colors are used in the given 

order for consecutive seamline shapes. Uses the active color table in 
MicroStation.

Fill gaps If on, gaps between images up to the defined number of pixels are 
filled.

Level Design file level on which labels of seamline polygons are drawn.
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Write Defines the content of the labels:
• No label - no labels are drawn.
• Image number - numbers of the raw images.
• File name - file names of the raw images.
• Unique end of file name - the part of raw image file names that is 

unique for each raw image.
Symbology Label color and weight. Uses the active color table of MicroStation 

and standard line widths. Font type and size are defined by the active 
MicroStation settings for text styles.

Setting: Effect:
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Transform selection shapes
Ground ortho only

Transform selection shapes command can be used to apply a transformation to all selection 
shapes in a design file. The transformation must be defined in Coordinate transformations / 
Transformations of the TerraPhoto Settings.

To transform selection shapes:

1. Select Transform selection shapes command from the Tool pulldown menu.

This opens the Transform selection shapes dialog:

2. Select a transformation from the Transform pulldown list.
3. Click OK.

This transforms the coordinates of all selection shapes into the new projection system.
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Derive image corrections
Ground ortho only

Derive image corrections command derives a brightness distribution correction for images. The 
correction removes systematic effects from raw images caused by sun hot spots. The effect can 
occur in airborne images where the sun is brightening up a part of each raw image depending on 
the flight line direction. It shows up, for example, in the final orthophoto mosaic as a striped 
pattern in small-scale displays.

Before the software is able to derive correct brightness corrections depending on the flight line 
direction, the raw images must be assigned to groups. The groups are created based on the sun 
direction. See Assign groups command for detailed information about raw image groups.

Additionally, color points must be available. The brightness distribution correction is actually a 
grid of correction values derived from color point values. The systematic brightness distribution 
correction is stored as percentage values for each image in the image list file. The color points are 
modified and recomputed as well.

To derive image corrections:

1. Select Derive image corrections command from the Tool pulldown menu.

This opens the Derive image corrections dialog:

2. Select settings and click OK.

This starts the derivation of the correction values. Afterwards, the color points are 
recomputed. A processing window shows the steps that are performed.

When the process has finished, an information dialog is show.

3. Save the color points using Save or Save As commands from the File pulldown menu in 
order to save the recomputed color points into a file.

4. Save the image list using Save list or Save list As commands in order to save the image list 
into a file including the systematic brightness correction values.

Setting: Effect:
Intensity distribution If on, a brightness distribution correction is derived:

• For whole data set - same distribution for all images.
• Per group - same distribution for images of the same group 

(depending on the sun direction when an image was captured)
Grid columns Number of columns in the grid of correction values.
Grid rows Number of rows in the grid of correction values.
Intensity correction If on, a brightness correction is derived for all images.
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TerraPhoto is commonly used for creating a seamless, positionally accurate orthophoto mosaic as 
the final product. Many steps in the TerraPhoto workflow prepare a data set for this aim. The 
rectification itself is an automatic process.

This chapter describes typical settings that you would use for producing orthophotos of two 
different quality levels. “Quick” orthophotos may be produced for internal purposes only. “Final” 
orthophotos are the actual end product that is delivered to the customer. These two levels of 
orthophotos are produced by selecting different parameters for the rectification process.

The creation of an orthophoto mosaic requires tiles which represent the orthophoto boundaries. 
Tiles can be produced by Place tile array command or Place Tile Array tool in TerraPhoto, or by 
any MicroStation tool that produces rectangular shapes. The rectification is started by the Rectify 
mosaic command from the Rectify pulldown menu in TPhoto Main window.

Settings for quick orthophotos

It is often useful to create orthophotos in a fast way for internal use before all the work for best-
quality orthophotos is completed. This is done, for example, to use orthophotos in the background 
for the manual editing of laser data classification. Accurate orthophotos require a correct ground 
model but the correct classification of ground laser points is often difficult to achieve without 
some imagery in the background of the point cloud. 

Quick orthophotos are produced based on a ground model from automatically classified laser 
points and roughly adjusted raw images. There is no need to take too much effort for improving 
the positioning of raw images or to involve color corrections and selection shapes in the 
production of quick orthophotos.

The recommended settings for quick orthophotos are shown below. Only Sample pixel color is 
switched on in the Options group of the Rectify selected tiles dialog. Additional settings would 
produce better-quality results but they would also slow down the rectification process and require 
more processing steps in preparation. The ECW compressed format results in handy raster files 
that are fast in the display as TerraPhoto raster references.
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Settings for final orthophotos

Orthophotos produced as end products for delivery require more processing steps and input 
information. This includes a correct ground model, accurate positioning of the raw images, color 
corrections, selection shapes, and possibly 3D vector models of objects on the surface for 
producing true-orthophotos.

Typical settings for final orthophotos are shown below. There are now more options used in the 
Options group of the Rectify selected tiles dialog. They make the rectification process slower but 
result in better-quality orthophotos.

Format is set to GeoTIFF which results in raster files without any loss of quality caused by 
compression.

Use surface objects makes use of closed shapes that are drawn on the given design file levels. It 
produces true-orthophotos where the shapes are utilized to get the correct position of objects 
above the ground, such as building roofs and bridges.

Use color points defines a Color points file. The file contains color balancing information in 
order to eliminate brightness and color differences between neighbouring images.

Use selection shapes involves all types of Selection shapes stored in the design file. Selection 
shapes manipulate seamlines between images or define the usage of certain raw images in 
specified areas.
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Tool Reference
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TerraPhoto Settings
Settings control the way how tools and commands of TerraPhoto work. They are organized in log-
ical categories. The Settings dialog is opened by the Settings tool.

Settings folder / category: Settings category
Coordinate transformations / Builtin projection 
systems

Angle systems

Coordinate transformations / Transformations Attitude computation
Coordinate transformations / US State Planes Color points
Coordinate transformations / User projection 
systems

Define Color Corrections

Reference images / Default visibility ECW compression
Reference images / Raster references Exterior orientation formats
Tie points / Automation Histogram adjustment
Tie points / Display Laser points
Tie points / Entry Memory usage
Video / Display Mobile rectification
Video / Misalignment Operation

Selection shapes
TFW and JGW files
Tile naming schemes
Trajectory formats
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Coordinate transformations / Builtin projection systems

Builtin projection systems category in Coordinate transformations folder defines what 
projection systems are available for transformations. This effects lists in dialogs for transforming 
from WGS84 longitude and latitude coordinates to planar coordinate systems. Currently 
supported target systems are listed in the following table:

Setting: Effect:
Belgium LB72/
BEREF2003

If on, transformation to LB72/BEREF2003 can be applied.

Deutsche Bahn GK If on, transformation to Deutsche Bahn GK1 - GK5 can be 
applied.

Finnish KKJ If on, transformation to KKJ using the selected Equation can 
be applied.

Finnish ETRS-TM35FIN 
and ETRS-GK

If on, transformation to ETRS-TM35FIN and ETRS-Gauss-
Krueger zones 19 - 31 can be applied.

Northern Ireland If on, transformation to Northern Ireland system can be applied.
Republic of Ireland If on, transformation to Ireland Transverse Mercator system 

can be applied.
Japan If on, transformation to Japanese zones 1 - 19 can be applied.
Netherlands RD/NAP 2008 If on, transformation to RD/NAP system can be applied.
South Africa If on, transformation to South Africa LO system can be applied.
Swedish RT90 If on, transformation to Swedish RT90 system can be applied.
Swedish SWEREF99 If on, transformation to SWEREF99 system can be applied.
UK National Grid If on, transformation to UK National Grid can be applied.
UTM WGS North If on, transformation for given UTM Zones on the northern 

hemisphere can be applied.
UTM WGS South If on, transformation for given UTM Zones on the southern 

hemisphere can be applied.
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Coordinate transformations / Transformations

Transformations category in Coordinate transformations folder contains a list of coordinate 
transformations which can be used to transform the position of laser data, trajectories, and other 
data.

You can Add, Edit, and Delete transformation by using the corresponding buttons in the Settings 
dialog. The Copy button copies the selected transformation to the clipboard. With the Paste 
button you can paste a transformation from the clipboard. The Derive button can be used for 
Deriving a transformation from a set of control point pairs.

Seven types of coordinate transformations are supported:

• Linear transformation
• Equation transformation
• Known points transformation
• Xy multiply transformation
• 3D translate & rotate transformation
• 3D Affine transformation
• Projection change transformation

To define a new transformation:

1. Open the Transformations category in the Coordinate transformations folder.
2. Click Add in the Settings dialog.

This opens the Transformation dialog.

3. Type a Name for the transformation and select a transformation Type. Define the other 
settings depending on the transformation type.

4. Close the Settings dialog in order to save the modified settings for TerraPhoto.

Linear transformation
Linear transformation scales and/or translates coordinate values. You can assign a coefficient 
and a constant offset for each coordinate axis. The target coordinates are computed by multiplying 
the original coordinates with the given coefficient and by adding a given constant value.

Setting: Effect:
Multiply by - X Coefficient for multiplying the easting coordinate.
Multiply by - Y Coefficient for multiplying the northing coordinate.
Multiply by - Z Coefficient for multiplying the elevation coordinate.
Add constant - X Value to add to the easting coordinate.
Add constant - Y Value to add to the northing coordinate.
Add constant - Z Value to add to the elevation coordinate.
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Equation transformation
Equation transformation lets you define mathematical equations for computing new easting, 
northing, and elevation values from the source easting, northing, and elevation coordinates. You 
can also enter equations for up to six intermediate variables which are computed in order V1, V2, 
..., V6 before evaluating new coordinates X, Y and Z.

Known points transformation
Known points transformation lets you specify the coordinates of two known points in the 
original coordinate system (survey coordinates) and their respective coordinates in the target 
system (design file coordinates).

Setting: Effect:
V1, V2, ..., V6 Optional equations for calculating intermediate variables 

V1, V2, V3, V4, V5, and V6.
X, Y, Z Equations for calculating the easting, northing, and 

elevation coordinates. The mathematical equation may 
contain:
• Sx - survey file X coordinate.
• Sy - survey file Y coordinate.
• Sz - survey file Z coordinate.
• Intermediate variables V1, V2, V3, V4, V5, and V6.
• Mathematical functions such as sin(a), cos(a), tan(a), 

exp(a), log(a), log10(a), pow(a,b), sqrt(a), ceil(a), fabs(a) 
and floor(a) where a and b are floating point values.
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Xy multiply transformation
Xy multiply applies a transformation using equations:

NewX = dx + a * Sx + b * Sy
NewY = dy + c * Sx + d * Sy
NewZ = dz + e * Sz

where dx, dy, dz, a, b, c, d, and e are constant parameters of the transformation and Sx, Sy, Sz are 
the original (survey) coordinates. This is often used as 2D Helmert type of transformation.

Setting: Effect:
Survey X, Y, Z First known point in the original coordinate system.
X, Y, Z Second known point in the original coordinate system.
Design X, Y, Z First known point in the target coordinate system.
X, Y, Z Second known point in the target coordinate system.



Page 170
15 Toolbox tools
3D translate & rotate transformation
3D translate & rotate applies a three dimensional translation and rotation to coordinates.

3D Affine transformation
3D Affine applies separate translation, rotation and scaling for each coordinate axis. The 
transformation is defined by equations:

NewX = dx + (1.0 + mx) * X + rz * Y - ry * Z
NewY = dy + (1.0 + my) * Y - rz * X + rx * Z
NewZ = dz + (1.0 + mz) * Z + ry * X - rx * Y

where dx, dy, dz, mx, my, mz, rz, ry, and rz are constant parameters of the transformation and X, 
Y, Z are the original coordinates.

Setting: Effect:
Dx, Dy, Dz Values to add to X, Y, Z coordinates.
Ox, Oy, Oz X, Y, Z coordinates of the rotation center point.
Rx, Ry, Rz Rotation angle in radians around X, Y, Z axes.
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Projection change transformation
Projection change transforms coordinates from one projection system to another. The software 
transforms the X, Y, Z coordinates from the source projection system back into WGS84 
geocentric X, Y, Z and then computes the transformation into the target projection system.

All projections systems that are active in Coordinate transformations / Builtin projection 
systems, Coordinate transformations / US State Planes, or defined in Coordinate 
transformations / User projection systems are available for a projection change transformation.

If you already applied a geoid correction, you should run a reverse geoid correction to the data set 
before using a projection change transformation. This is essential in cases where the source and 
the target systems use different ellipsoids or datums. A geoid correction or a reverse geoid 
correction is only applied automatically if the UK National Grid system is used in the 
transformation.

Setting: Effect:
Dx, Dy, Dz Values to add to X, Y, Z coordinates (translation).
Mx, My, Mz Factors to scale the data along the X, Y, Z axes.
Rx, Ry, Rz Rotation angle in radians around X, Y, Z axes.

Setting: Effect:
From Source projection system.
To Target projection system.



You can copy transformations from one Terra application to another. Select the transformation in 
the Settings dialog and click on the Copy button to copy the definition to the clipboard. Click on 
the Paste button in the other Terra application to paste the definition.

Deriving a transformation
You can also derive transformation parameter values from point pairs. This requires that identical 
control points (point pairs) are available in source and target coordinate values. The points must 
be stored in text files. The number of required control point pairs depends on the transformation 
type.

To derive a transformation, click on the Derive button in the Settings dialog. This opens the 
Derive transformation from points dialog:

The transformation derivation can be tested by using the Test button. This computes the parameter 
values and displays the result in a report window. To create the transformation, click on the 
Create button. This opens the Transformation dialog that displays the derived parameter values. 
Type a Name for the transformation and click OK in order to add the transformation to the list in 
the Settings dialog.

Modify Coordinate values to modify:
• Xyz - modifies all coordinates.
• Xy only - no changes to elevation values.

Setting: Effect:
Type Type of the derived transformation:

• 2D transformation - parameter values for a 2D Helmert 
transformation are derived.

• 3D translate & rotate - parameter values for a 3D 
translation and rotation transformation are derived.

• 7 parameter affine - parameter values for a 3D affine 
transformation (7 parameters) are derived.

• 9 parameter affine - parameter values for a 3D affine 
transformation (9 parameters) are derived.

Use Points used for deriving the transformation:
• All point pairs - uses all control point pairs.
• Inside source fence only - points inside a fence in the 

source coordinate system are used.
• Inside target fence only - points inside a fence in the 

target coordinate system are used.
Source Text file that contains the point pair coordinates in the 

source system.
Target Text file that contains the point pair coordinates in the target 

system.

Setting: Effect:
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Coordinate transformations / US State Planes

US State Planes category in Coordinate transformations folder contains a list of US State Plane 
projection systems using the NAD83 datum. Check the toggle box of those state plane systems 
you want to use.

You can view the parameters of a system by using the View button. In case you need to change 
the parameters of a built-in US State Plane definition, you can use the Copy button to copy/paste 
the system into Coordinate transformations / User projection systems.
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Coordinate transformations / User projection systems

User projection systems category in Coordinate transformations folder contains a list of user 
defined projection systems. You can define your projection system based on Transverse 
Mercator / Gauss-Krueger, Lambert conic conformal or Hotine oblique mercator projection.

A projection system definition can be divided into three distinct parts:

• Ellipsoid - defined by Semi-major axis and Inverse flattening.
• Datum - defined by seven parameter Bursa/Wolfe transformation.
• Projection - defined by the projection type, true origin, false origin, scale factor at the central 

meridian, and distance unit.

The list of user projection system displays a toggle box for each row. The toggle box indicates 
whether a projection system is active or not. Only active projection systems can be selected when 
applying a transformation. To activate or deactivate a projection system, place a data click inside 
its toggle box in the list.

You can Add, Edit, and Delete user projection systems by using the corresponding buttons in the 
Settings dialog. The Copy button copies the selected projections system definition to the clip-
board. With the Paste button you can paste a projection system definition from the clipboard.

To define a new projection system:

1. Open the User projection systems category in the Coordinate transformations folder.
2. Click Add in the Settings dialog.

This opens the Projection system dialog:

3. Define settings and click OK.
4. Activate the projection system.
5. Close the Settings dialog in order to save the modified settings for TerraScan.

Setting: Effect:
Name Descriptive name for the projection system.
Semi-major axis Semi-major axis of the target ellipsoid.
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You can copy user projection systems from one Terra application to another. Select the system in 
the Settings dialog and click on the Copy button to copy the definition to the clipboard. Click on 
the Paste button in the other Terra application to paste the definition. You can also paste the def-
inition in a text editor in order to save it into a text file.

Inverse flattening Inverse flattening of the target ellipsoid.
Shift X Datum X shift from WGS84 to the target system in meter.
Shift Y Datum Y shift from WGS84 to the target system in meter.
Shift Z Datum Z shift from WGS84 to the target system in meter.
Rotation X Datum rotation around the X axis in arc seconds.
Rotation Y Datum rotation around the Y axis in arc seconds.
Rotation Z Datum rotation around the Z axis in arc seconds.
Scale correction Datum scale correction as parts per million. The actual scale factor 

is computed as 1.0 + (0.000001 * ScaleFactor).
Projection type Type of the projection system: Transverse Mercator/Gauss-

Kruger, Lambert conic conformal, or Hotine oblique 
mercator.

Origin longitude Longitude of the true origin in decimal degrees.
Origin latitude Latitude of the true origin in decimal degrees.
False easting Map coordinate easting of the true origin.
False northing Map coordinate northing of the true origin.
Scale factor Scale factor on the central meridian.
Unit Distance unit: Meter, International foot, US Survey Foot, or 

International yard.

Setting: Effect:
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Reference images / Default visibility

Default visibility category in Reference images folder defines the MicroStation views for which 
TerraPhoto raster references are switched on for display by default. This is used by Attach files 
and Attach directory commands in the Manage Raster References window.

Reference images / Raster references

Raster references category in Reference images folder defines the ratios of lower resolution 
versions of raster references and how references are displayed when viewed from a far distance.

A full resolution version of an image is required only when the display is zoomed close to the pixel 
detail level. When viewing images from further away, the application can use smaller versions of 
the images and thus, fit more of those images in the image cache.

Lower resolution versions are not used with ECW images.

Tie points / Automation

Automation category in Tie points folder defines how semi-automatic tie point search works. See 
Tie point entry modes on page 80 for more information. Another setting relates to the usage of 
keyboard keys for navigating in the tie point lists.

Setting: Effect:
Medium ratio Subsampling ratio of medium resolution versions. Default is 2.
Low ratio Subsampling ratio of low resolution versions. Default is 4.
Thumbnail ratio Subsampling ratio of thumbnail versions. Default is 8.
Beyond factor Zoom factor beyond which the raster images are no longer drawn. 

Default is 1000 which is a reasonable setting for ECW images.
Draw rectangle If on, the application draws a rectangle using the given line color and 

line width for each raster image if the zoom factor is smaller than the 
value given in the Beyond factor field. 

Fill rectangle If on, the application fills the rectangle with the given color for each 
raster image if the zoom factor is smaller than the value given in the 
Beyond factor field.

Setting: Effect:
Find matches automatically If on, the application searches matching positions in secondary 

images automatically for Ground tie points.
Search width Size of the comparison raster to find matching tie point 

positions.
Match limit Limit for how good or bad matches are accepted for tie points. 

Good matches have a lower value, bad matches have a higher 
value. Default setting is 10.

Bad matches Action to take for matches which are worse than the Match 
limit:
• Set manually - applications leaves the tie point pixel 

undefined and displays the secondary image for the user to 
enter the pixel manually.

• Reject - bad matches are ignored and not shown to the user.
Focus point list automatically If on, the focus of key commands stays on the tie point list in 

the Tie point window. Thus, the <Arrow up> and <Arrow 
down> keys can be used immediately after a tie point has been 
placed to select tie point pixels in the Tie point window.
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Tie points / Display

Display category in Tie points folder contains values which determine whether an image is well-
defined by tie points or not. See Tie point values on page 78 and Tie point distribution on page 
79 for more information. The settings effect the display color of tie point attributes in the Tie 
points window. Further, you can define a color for highlighting image areas where no tie points 
can be placed.

Tie points / Entry

Entry category in Tie points folder defines settings for entering tie points.

Setting: Effect:
Point value Required sum of Tie point values for an image to be 

considered well-defined.
Coverage Required Tie point distribution value for an image to be 

considered well-defined. The better the tie points are 
distributed over an image, the higher is the coverage value.

Distance Limit for displaying large mismatch distances of tie points in 
red.

R, G, B RGB color values for highlighting image areas where no tie 
points can be placed. Values can range between -255 and +255. 
Negative values cause transparency of the highlight color.

Setting: Effect:
Default Default distance from a mobile camera for placing a new tie 

point.
Maximum Maximum distance from a mobile camera for placing a new tie 

point.
Hilite known point location If on, Known xyz and Known xy tie point locations are marked 

with a cross in the tie point entry views.
Reset when image loses point 
values

If on, the Tie status attribute of an image is reset from 
Approved to Check if the image’s tie point value becomes 
smaller then the value defined in Tie points / Display.
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Video / Display

Display category in Videos folder defines display settings for the Display Video tool.

Video / Misalignment

Misalignment category in Videos folder defines the misalignment angles of video cameras 
compared to the IMU. The vertical video and forward video parameters refer to the corresponding 
definitions for Video 1 and Video 2 in Edit information dialog.

Setting: Effect:
Zoom factor Size of the video display on screen relative to the original 

resolution of the video.
Step size Length of the video sequence to display when stepping forward 

or backward.
Fast forward Speed factor for fast forward playing mode.
Display video location If on, the location of the video along a trajectory line is 

dynamically displayed in a MicroStation view. The location is 
marked with a rectangle.

Level Design file level for the dynamic display of the video location.
Symbology Color and line width for the dynamic display of the video 

location. Uses the active color table of MicroStation and 
standard line weights.

Altitude Height in meter above ground on which the rectanlge for the 
dynamic display of the video location is drawn.

Width Width in meter of the rectangle for the dynamic display of the 
video location.

Height Height in meter of the rectangle for the dynamic display of the 
video location.

Setting: Effect:
Heading Heading misalignment value for a vertical video (Video 1).
Roll Roll misalignment value for a vertical video (Video 1).
Pitch Pitch misalignment value for a vertical video (Video 1).
Heading Heading misalignment value for a forward video (Video 2).
Roll Roll misalignment value for a forward video (Video 2).
Pitch Pitch misalignment value for a forward video (Video 2).
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Angle systems

Angle systems category let you define angle systems. The definition includes the unit of the 
angles, the direction of zero for heading, and the directions of increasing heading, roll, and pitch 
angles.

A new angle system can be defined by using the Add button in the TerraPhoto Settings dialog. 
An existing system is modified by selecting the system and using the Edit button. A data click on 
the Delete button deletes a selected angle system.

Setting: Effect:
Name Descriptive name for the angle system.
Unit Format of the input angles:

• Radians - 2*pi - angle values are given in radians. The 
software normalizes the values between -pi and +pi.

• Degree - 360 - angle values are given in degree. The software 
normalizes the values between -180 and +180 degree.

• Gones - 400 - angle values are given in gones. The software 
normalizes the values between -200 and +200 gones.

Heading zero Defines the direction where heading is zero: North, East, South, 
or West.

Heading increase Defines the direction of increasing heading values: Clockwise or 
Counter clockwise.

Roll increase Defines the direction of increasing roll values: Left wing up or 
Right wing up.

Pitch increase Defines the direction of increasing pitch values: Nose up or 
Nose down.
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Attitude computation

Attitude computation category defines how to compute camera rotation from input angles. This 
effects mainly the creation of image lists using the Compute list command.

Three angles is not enough to explicitly define a rotation. In addition, the order in which those 
angles are applied must be fixed as well. Most IMU systems use the order Heading Pitch Roll.

Color points

Color points category defines symbology settings for drawing color points and display settings for 
drawing image assignment instead of ortho images.

Define Color Corrections

Define Color Corrections category determines how many image rows are skipped when using 
the <Page up> and <Page down> keys in the Define color corrections dialog dialog. The setting 
applies only if the image thumbnails in the Define color corrections dialog are displayed in a 
single row.

ECW compression

ECW compression category defines how coordinate information is written to ECW files.

Setting: Effect:
Order Order in which to apply angles. The possible choices are:

• Heading roll pitch
• Heading pitch roll - this is the standard order used by common 

IMU systems.
• Roll pitch heading
• Pitch roll heading
• Roll heading pitch
• Pitch heading roll

Setting: Effect:
Level & Color Design file level number and color for drawing color points 

temporarily into the design file. The list of colors contains the 
active color table of MicroStation.

Beyond factor Minimum zoom factor for displaying rectified images in color 
points mode. If the zoom factor is smaller, the image assignment is 
drawn instead.

Setting: Effect:
Move Determines the number of image rows that are skipped when using 

the <Page up> or <Page down> keys to scroll through the image 
list in the Define color corrections dialog.

Setting: Effect:
Write as Sign of Y step: Negative values or Positive values.
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Exterior orientation formats

Exterior orientation formats category lets you define formats for importing exterior orientation 
information from text files. The format definition determines the order of the attributes that are 
stored in the text file, the delimeter that separates attribute fields, and possibly a character which 
marks comment lines.

A new format can be defined by using the Add button in the TerraPhoto Settings dialog. An 
existing format is modified by selecting the format and using the Edit button. A data click on the 
Delete button deletes a selected format.

You can load an example text file by using the Load example command from the File pulldown 
menu. With the commands from the View pulldown menu the dialog can be resized to enable the 
import of text files with 8 fields, 10 fields, or 15 fields.

Setting: Effect:
Format name Descriptive name for the exterior orientation format.
Delimeter Character used to separate attribute fields in the text file: Space, 

Tabulator, Comma, or Semicolon.
Comment char Character that introduces a comment in the text file. Lines 

beginning with this character are ignored when information is 
read from the text file.

No field Selection of what attribute is stored in the field:
• No field - no field definition.
• Ignore - the column in the text file is ignored.
• Image name - names of images.
• Image number - numbers of images.
• Time - time stamps of image positions.
• Easting, Northing, Elevation - X, Y, Z coordinates of image 

positions.
• Heading, Roll, Pitch - misalignment angles of images.
• Omega, Phi, Kappa - orientation angles of images.
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Histogram adjustment

Histogram adjustment category determines values for automatic histogram adjustment. The 
settings are used in the Adjust images command.

The adjustment routine first builds a histogram of pixel intensity values for red, green, and blue 
channels separately. For each color channel, it determines a boundary location at the low end and 
at the high end of the histogram. A percentage value defines the lowest and highest intensity pixels 
that are outside the boundary. Then, the intensity values are remapped so that the low end 
boundary and the high end boundary are moved to the specified values.

Laser points

Laser points category defines how ground model points are displayed if they are loaded into 
TerraPhoto directly from a binary file. Additionally, the maximum triangle length in the ground 
model TIN is defined.

Settings: Effect:
Boundary Percent of pixels on the lowest and highest ends of the histogram 

that are outside the boundary.
Move to - low value Value to which the low-end boundary is moved.
Move to - high value Value to which the high-end boundary is moved.

Setting: Effect:
Order Defines whether points are drawn on the screen Before or After 

MicroStation draws vector elements.
Level Design file level on which the points are drawn. You can control 

the visibility of the points by switching the level on or off.
Color Color of the points. Uses the active color table of MicroStation.
Weight Size of the points. Uses MicroStation line weights.
Max length Maximum triangle length of the ground model TIN. If there are no 

points within a distance larger than Max length, the ground in that 
area is considered to be undefined.
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Memory usage

Memory usage category defines how much memory the application can use for caching images.

The combined size of reference images is often much larger than the amount of available memory. 
TerraPhoto keeps recently used raster images in memory and can therefore display those images 
very fast. The application needs to read an image from the hard disk only if it is not already in the 
cache when it needs to be drawn on the screen.

You should set the image cache size to be 10% to 50% of your computer’s physical memory if 
you are viewing GeoTIFF images. A larger cache size results in a better performance for image 
display.

ECW images are separately cached by the ECW library routines. If you are viewing ECW images 
only, set the image cache size to a relatively small value (8 - 32 MB). The image cache is then 
used to keep copies of uncompressed raster fragments.

Mobile rectification

Mobile rectification category defines the maximum distance from a camera of a mobile ground-
based system within which images are used for rectification. The distance depends on the height 
of the camera above the ground.

Operation

Operation category defines what happens when TerraPhoto is started, whether it is unloaded 
when the TPhoto Main window is closed, and how many processor threads can be used by 
TerraPhoto.

Setting: Effect:
Size Image cache size in megabytes.
Free all Button to remove everything from the image cache and thus, empty 

the memory.
Maximum Maximum number of ECW files kept open at the same time. Default 

value is 200.

Setting: Effect:
Max distance Distance from a camera within which images are used for 

rectification. The distance is expressed as factor of the camera’s 
height above the ground.

Setting: Effect:
Create Applications menu If on, TerraPhoto creates an Applications pulldown menu in 

MicroStation’s menu bar at startup. This menu contains commands 
for opening TerraPhoto tool boxes and windows.

Open Main window If on, the application opens the TPhoto Main window at startup.
Open Main tool box If on, the application opens the Main tool box at startup.
Main window is closed If on, TerraPhoto is unloaded when TPhoto Main window is 

closed.
Maximum Defines the maximum amount of processor threads used by 

TerraPhoto.



Selection shapes

Selection shapes category defines the level assignments and symbology settings for the different 
types of selection shapes. TerraPhoto distinguishes several selection shape types which are useful 
for different kinds of image corrections: manually placed shapes, automatically placed shapes 
(auto seamline shapes), quality shapes, and smearing shapes. See Selection shapes on page 125 
for more information.

You can use the Apply to file button at any stage in order to force all selection shapes in the active 
design file to match the given level and symbology settings.

TFW and JGW files

TFW and JGW files category defines the exact position of the origin of TIFF and JPEG files. 
The origin determines the referencing point of a raster file and is stored in an external 
georeferencing file.

Setting: Effect:
Force symbology If on, new selection shapes are created on the specified design file 

level using the given symbology.
Manually placed Level number, color, and fill type of manually placed shapes.
Auto seamline Level number, color, and fill type of automatically placed shapes 

(auto seamline shapes).
Quality Level number, color, and fill type of Quality shapes.
Smearing Level number, color, and fill type of Smearing shapes.
Apply to file Enforces the given level and symbology settings for all existing 

selection shapes in the active design file.

Setting: Effect:
Input files Location of the origin of TIFF/JPEG files with external 

georeferencing files: Pixel corner or Pixel center. The setting 
effects image files attached as raster references in TerraPhoto.

Output files Location of the origin of TIFF/JPEG files with external 
georeferencing files: Pixel corner or Pixel center. The setting 
effects image files that are created with TerraPhoto.
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Tile naming schemes

Tile naming schemes category lets you define your own tile naming formats.

This is useful, for example, to create specific names for ortho photo tiles which then can be used 
for naming the ortho photos. The definition allows you to insert tile corner coordinates into a name 
used in rectification.

The application can recognize and insert the following fields in a name text string:

• #emin - Easting coordinate of the lower left corner.
• #nmin - Northing coordinate of the lower left corner.
• #emax - Easting coordinate of the upper right corner.
• #nmax - Northing coordinate of the upper right corner.
• #number - Incremental number for tiles. The tile numbers increase by 1.
• #text - Selected text inside the tile.

A new format can be defined by using the Add button in the TerraPhoto Settings dialog. An 
existing format is modified by selecting the format and using the Edit button. A data click on the 
Delete button deletes a selected format.

Setting: Effect:
Description Descriptive name for the tile naming format.
Format Text string that defines the format and thus, the tile name. Use the 

Append button in order to add defined fields to the format.
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Trajectory formats

Trajectory formats category defines formats for importing trajectory information from text files. 
The format definition determines the order of the attributes that are stored in the text file, the 
delimeter that separates attribute fields, and possibly a character which marks comment lines.

A new format can be defined by using the Add button in the TerraPhoto Settings dialog. An 
existing format is modified by selecting the format and using the Edit button. A data click on the 
Delete button deletes a selected format.

You can load an example text file by using the Load example command from the File pulldown 
menu. With the commands from the View pulldown menu the dialog can be resized to enable the 
import of text files with 8 fields, 10 fields, or 15 fields.

Setting: Effect:
Format name Descriptive name for the trajectory format.
Delimeter Character used to separate attribute fields in the text file: Space, 

Tabulator, Comma, or Semicolon.
Comment char Character that introduces a comment in the text file. Lines 

beginning with this character are ignored when information is 
read from the text file.

No field Selection of what attribute is stored in the field:
• No field - no field definition.
• Ignore - the column in the text file is ignored.
• Time - time stamps of trajectory positions.
• Easting, Northing, Elevation - X, Y, Z coordinates of 

trajectory positions.
• Heading, Roll, Pitch - misalignment angles of trajectory 

positions.
• X, Y, Z accuracy - accuracy estimates for easting, northing, 

elevation coordinates.
• Heading, Roll, Pitch accuracy - accuracy estimates for 

heading, roll, pitch angles.



Page 187
15 Toolbox tools
General tool box
Tools in the General tool box are used to define TerraPhoto Settings, to define camera 
parameters, to manage raster references, to convert files from one raster format to another, to 
manage camera trajectories, to view videos assigned to trajectories, and to access license 
information and the TerraPhoto User’s Guide.

To: Use:

Modify user settings Settings

Define coordinate range and resolution Define Coordinate Setup

Define camera parameters Define Camera

Open a window for managing raster references Manage Raster References

Set raster reference visibility by view contents Set References By View

Toggle visibility of a single raster reference Set Reference

Convert files from one raster format to another Convert Raster Files

Manage camera trajectories Manage Camera Trajectories

Display video sequence Display Video

View information about TerraPhoto About TerraPhoto

View on-line help Help On TerraPhoto
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Settings

Settings tool lets you change a number of settings that control the way TerraPhoto works. 
Selecting the tool opens the TerraPhoto Settings dialog.

The settings are grouped into logical categories. Selecting a category in the list displays the 
appropriate controls next to the category list.

The different categories and related settings are described in detail in Section TerraPhoto 
Settings.
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Define Coordinate Setup

Define Coordinate Setup tool sets up coordinate system values that a Terra Application uses for 
laser points and images. It determines the coordinate range inside which all data must be located 
and the resolution to which coordinate values are rounded. The coordinate setup is stored into the 
active design file and is used by all Terra Applications.

Terra Applications use signed 32 bit integer values for storing coordinates of laser points and 
images. This has the advantage of using only 12 bytes of memory for the coordinate information 
of each point. You can control how accurately coordinate values are stored by defining how big 
each integer step is.

If, for example, one integer step is equal to one millimeter, all coordinate values are rounded to 
the closest millimeter. At the same time it would impose a limitation on how far apart points can 
be or how big the coordinate ranges are. Millimeter steps produce a coordinate cube which has a 
size of 232 millimeters or 4294967.296 meters. If the origin of the coordinate system is at [0.0, 0.0, 
0.0], the coordinate ranges are limited to values between -2147483 and +2147483. If necessary, 
you can fit the coordinate ranges to your data by modifying the Easting and Northing coordinates 
of the coordinate system origin.

If one integer step is equal to one centimeter, the coordinate values can range from -21 million to 
+21 million which is large enough for most coordinate systems.

To define the coordinate setup:

1. Select the Define Coordinate Setup tool.

This opens the Define Coordinate Setup dialog:

2. Define settings and click OK.

This modifies the coordinate system values used by all Terra Applications in the active 
design file.

MicroStation SE and MicroStation J
Each design file contains a definition of a 32 bit integer coordinate system which MicroStation 
uses internally for vector elements. All applications share the same coordinate setup with 
MicroStation. When you change the coordinate setup with Define Coordinate Setup tool, it 
changes the design file coordinate system.

Since Terra Applications’ version 009.00x these MicroStation versions are no longer supported.
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MicroStation V8 and V8i
MicroStation V8 uses 64 bit values for storing vector elements. Terra Applications use a 
coordinate setup which is separate from the design file coordinate system. Their default coordinate 
setup defines 100 integer steps for each master unit. You can use Define Coordinate Setup tool to 
change the coordinate setup which the application stores in the design file but it does not affect 
MicroStation itself or the vector elements.
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Define Camera

Define Camera tool lets you create and modify a TerraPhoto camera file.

A detailed description of the parameters and menu commands in the Camera dialog, as well as 
information about camera calibration workflows can be found in Chapter Camera Calibration 
on page 46.

To define camera parameters:

1. Select the Define Camera tool.

This opens the Camera dialog.

2. If the mission contains one or 
more cameras, select the camera 
in the Camera field.

3. Define settings.
4. Click on the Apply button in 

order to apply the modified 
camera parameters to active tie 
points and image displays.

5. Select Save or Save As 
commands from the File 
pulldown menu in order to save 
changes into a camera calibration 
file.
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Manage Raster References

Manage Raster References tool opens a window for managing raster references. The Manage 
Raster References window contains menu commands for attaching, detaching, viewing, and 
manipulating raster files.

To open the window for managing raster references:

1. Select the Manage Raster References tool.

This opens the Manage Raster References window:

See Chapter Commands for Raster References on page 315 for detailed descriptions of the 
menu commands.

Set References By View

Set References By View tool switches on the visibility of all raster references that are completely 
or partly within a MicroStation top view and switches off all other raster references which are 
completely outside the view. The tool requires that images have been attached as raster references 
in TerraPhoto by using the Manage Raster References tool.

To switch on all raster references within view contents:

1. Select the Set References By View tool.
2. Select a top view with a data click.

This sets the visibility of raster references in the selected view.

Set Reference

Set Reference tool switches the visibility of a single raster reference in a view on or off. The tool 
requires that images have been attached as raster references in TerraPhoto by using the Manage 
Raster References tool.

To toggle the visibility of a single raster reference:

1. Select the Set Reference tool.

If the mouse pointer is moved inside a top view, the boundaries of raster references are 
displayed dynamically.

2. Place a data click inside the rectangular area covered by a raster reference.

This switches the visibility of the raster reference on or off.
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Convert Raster Files

Convert Raster Files tool converts raster files from one image format to another. The tool can also 
be used to adjust the brightness of images, to transform the positions of images, to modify the 
background color, or to change the image orientation between landscape and portrait.

To convert raster files:

1. Select the Convert Raster Files tool.

This opens the Source files dialog, a standard dialog for selecting files.

2. Add the raster file(s) to the list of files to process and click Done.

This opens the Convert Raster Files dialog:

3. Define settings and click OK.

This converts the images and creates new files in the Output directory. A progress bar 
shows the progress of the process.

Setting: Effect:
Write as Format of the output files. Supported file formats include: 

BMP, ECW compressed, GeoTIFF, JPEG, JPEG2000, Raw 
RGB, and TIFF. Some of the following settings depend on the 
selected format.

Target ratio Compression ratio for ECW or JPEG2000 files.
Datum Datum information that is written in the header of ECW and 

JPEG2000 files. Commonly used datum names can be selected 
by using the Select button.

Projection Projection information that is written in the header of ECW and 
JPEG2000 files. Commonly used projection names can be 
selected by using the Select button.

Create TFW|JGW file If on, external georeference files are created for GeoTIFF and 
JPEG files. The files have the extension .TFW|.JGW.
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Coord system Coordinate system information that is written in the header of 
GeoTIFF files. Commonly used coordinate system names and 
numbers can be selected by using the Select button.

Coordinates Coordinate transformation to apply to image positions. The 
transformation can result in translation of position and scaling 
of pixel size but no rotation is supported. The list contains 
transformations that are defined in Coordinate 
transformations / Transformations of TerraPhoto Settings.

Color depth Defines how color values are stored in the output file: 24 bit 
color or Grey scale.

Rotate Rotation applied to converted raster files:
• Clockwise - 90 degree clockwise.
• Counter clockwise - 90 degree counter clockwise.
• 180 degrees - 180 degree.
• Clockwise to landscape - 90 degree clockwise if the source 

image has portrait orientation.
• Counter clockwise to landscape - 90 degree counter 

clockwise if the source image has portrait orientation.
Output directory Directory into which the converted images are stored.
Delete original files If on, the original raster files are deleted after conversion.
Convert background color If on, the background color is changed From RGB values To 

RGB values.
Overall to average of images If on, the application computes the average brightness of all 

source images and adjust each converted image to that average 
brightness.

Fit automatically If on, the histogram of each image is fitted automatically.
Brightness If on, the brightness of each image is modified by adding the 

given values in the RGB fields to the red, green, and blue color 
components separately.

Contrast If on, the contrast of each image is modified by adding the 
given percentage value in the By field.

Enlarge If on, the resolution of the converted images is reduced by 
merging source image pixels into larger pixels. The value given 
in the By factor field determines how many pixels are merged 
horizontally and vertically.

Setting: Effect:
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Manage Camera Trajectories

Manage Camera Trajectories tool opens the TerraPhoto Trajectories window. The windwo 
displayes the active trajectories and contains menu commands for handling trajectory information 
in TerraPhoto.

Trajectory information is required by the following processing steps:

• creating an image list by using the Compute list command.
• placing tie points of type Depth and Known depth.
• setting up and displaying a video by using the Display Video tool.

To view information about active trajectories:

1. Select the Manage Camera Trajectories tool.

This opens the Trajectories window:

If there are active trajectories in TerraScan, the title bar of the window displays the active 
trajectory folder. Further, the window shows the list of trajectory files that are stored in the active 
trajectory folder.

The menu commands of the Trajectory window are described in detail in Chapter Manage 
Trajectories on page 292.
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Display Video

Display Video tool searches and displays a video sequence from a given geographical location. 
You can identify the geographical position with a data click. The application projects the given 
xyz location to the closest trajectory which has a video file linked to it and displays the 
corresponding sequence.

Before you can use this tool, you must link a digital video file to a trajectory using the Edit 
information command in the Trajectories window.

To display a video sequence:

1. Select the Display Video tool.

The Display Video dialog opens:

2. Define settings.

3. Identify a geographical position from which you want to see a video sequence.

This opens the Video Viewer window and starts the display of the video:

If the display of the video does not run automatically, start the video with the controls in the Video 
Viewer window. The display depends a bit on the format and the size of the video. See also 
Verticle video and Forward video commands in the Trajectories window for viewing videos.

Setting: Effect:
Display video Video file that is displayed:

• Vertical - file that is defined as Video 1 in the Trajectory 
information dialog.

• Forward - file that is defined as Video 2 in the Trajectory 
information dialog.

Clip length Determines the length of the video sequence that is displayed. The 
video display stops after the given amount of seconds.
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Video Viewer
The Video Viewer window provides some controls for displaying a video or for seeking a new 
position from which to start the video display.

The length of the sequence for playing stepwise backward or forward as well as the speed of 
the video display in fast mode are defined in Video / Display of TerraPhoto Settings.

To show the geographical location of a video position, click on the Show button and move 
the mouse pointer inside a view. The current position of the video is highlighted by a cross.

To display a video from a geographical location, click on the Seek button and define the 
location with a data click inside a MicroStation view. Click on a Play button in order the start 
the video display from the given location. Depending on the video format and size it may 
take a few seconds until the display starts.

To: Use:

Play a short sequence backward

Stop playing

Play a short sequence forward

Play the video forward continuously

Play the video in fast forward mode

Show the geographical location of the current video 
position in a MicroStation view Show

Display the video from a given geographical 
position Seek
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About TerraPhoto

About TerraPhoto tool opens a dialog which shows information about TerraPhoto and about the 
license.

From this dialog you can open the License information dialog:

Use the Request license button to start the online registration for node-locked licenses.

More information about license registration is available on the Terrasolid web pages: 
www.terrasolid.com/registration.php.

Help On TerraPhoto

Help On TerraPhoto tool launches Acrobat Reader for accessing this User’s Guide in PDF format. 
The PDF must be stored in the /docs folder of your Terra Software installation directory.

If you installed TerraPhoto in the default directory C:\TERRA, the User’s Guide must be stored 
in C:\TERRA\DOCS\TPHOTO.PDF.

The PDF has hypertext links built in, so you can jump between topics by clicking on the topic 
names highlighted in green color.

Accessing the PDF also requires that you have the Acrobat Reader installed on your computer. 
The software looks for a file named ACRORD32.EXE. If the file can not be found, you are asked 
to locate the file on the hard disk manually.
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Render tool box
Tools in the Render tool box are used to create rendered views, to save rendered views as image 
files, to create flythru movies, to place single RPC trees, to change normal directions for surface 
shapes, and to export building models.

See also Chapter Creating Rendered Views and Movies on page 25 for a detailed description of 
rendered images and flythru movie creation.

To: Use:

Define level settings for rendering Define Rendering Settings

Display a rendered view Display Rendered View

Save a rendered view as image file Save Rendered View

Create a flythru movie Create Flythru Movie

Build a movie from previously saved frames Build Movie From Frames

Place RPC trees manually Place Rpc Tree

Fix building normal vectors Fix Building Normals

Select another raw image for wall texture Change Texture Image

Export a city model file Export City Model
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Define Rendering Settings

Define Rendering Settings tool defines settings for rendering views with TerraPhoto tools.

This concerns levels in the active design file or in a reference design file that are used to drape the 
raster references on when a view is rendered. These levels have to contain vector models of 
objects, e.g. building roofs, which are used for draping.

The backside color refers to the display of backsides of 3D planes. When 3D planes are rendered, 
the normal direction of the plane determines the frontside and backside of the plane. Textures and 
lightning are usually applied to the frontside of planes, while backsides are displayed using a 
constant color and in shadow.

Further, the settings define how raster materials are used as textures and how laser points are 
drawn in relation to vector elements.

To define rendering settings:

1. Select Define Rendering Settings tool.

This opens the Rendering settings dialog:

2. Define settings and click OK.

The settings are used by the TerraPhoto tools Display Rendered View and Save Rendered 
View, as well as in frame and movie creation with Create Flythru Movie tool.

Setting: Effect:

Design levels Levels in the active design file used for draping raster references 
on vector elements. Separate several levels by comma.

Reference levels Levels in attached reference design file used for draping raster 
references on vector elements. Separate several levels by comma.

Backside color

Display color for the backside of 3D planes:
• Element color - the color of the element is used.
• Red - backsides are displayed in red color.
• Green - backsides are displayed in green color.
• Blue - backsides are displayed in blue color.

Raster materials

Defines how raster files are used as textures:
• Do not use - no textures are displayed.
• Use thru MicroStation - texture files are used in MicroStation 

rendering. This requires that the material files are available in 
MicroStation.

• Use directly - texture files are used in TerraPhoto rendering.

Laser points
Determines the distance of laser points behind vector elements in 
rendered views. This effects only the display of the points in views 
created with TerraPhoto rendering tools.
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Display Rendered View

Display Rendered View tool applies TerraPhoto rendering to a MicroStation view.

For more information about rendering in TerraPhoto, see Section Rendered Views on page 25. 
Some settings for rendered views can be defined by the Define Rendering Settings tool.

To render a view:

1. Select Display Rendered View tool.
2. Click inside a view.

This displays the rendered view.
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Save Rendered View

Save Rendered View tool saves a rendered view into an image file. The view must be open in order 
to save it.

The tool can be used to create geotagged TIFF files. The geotag contains the latitude and longitude 
coordinates of the view that is saved. If the view is a orthographic view, the coordinates of the 
view’s center point are stored. If the view is a perspective view, the coordinates of the camera 
location are stored. The geotagged TIFF files can then be combined in another software into a 
.KMZ package for being displayed in Google Earth, for example.

For more information about rendering in TerraPhoto, see Section Rendered Views on page 25. 
Some settings for rendered views can be defined by the Define Rendering Settings tool.

To save a rendered view:

1. Select Save Rendered View tool.

This opens the Save Rendered View dialog:

2. Define settings and click OK.

This opens the Rendered view raster file dialog, a standard dialog for saving files.

3. Define a directory and a file name for storing the image.
4. Click Save to save the image.

Setting: Effect:
View Defines the MicroStation view which is saved into an image.

Mode 

Defines the mode for capturing an image of the view:
• Render - TerraPhoto rendering is applied to the view. This 

excludes text elements from the captured image.
• Capture - a screen capture is created of the view. This includes 

text elements.

Width Width of the image in pixels. The default value is the view width 
when the tool is started.

Height Height of the image in pixels. The default value is the view height 
when the tool is started.

Format Format of the stored image. Supported formats are BMP, ECW, 
JPEG, and TIFF + GeoTag.

Ratio Compression ratio for ECW images. This is only active if Format 
is set to ECW.



Page 203
15 Toolbox tools
Projection

Projection system that is used to write the GeoTag information for 
a TIFF image. The list contains all projection systems that are 
active in Coordinate transformations / Builtin projection 
systems, Coordinate transformations / US State Planes, or 
Coordinate transformations / User projection systems of 
TerraPhoto Settings. This is only active if Format is set to TIFF 
+ GeoTag.

Setting: Effect:
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Create Flythru Movie

Create Flythru Movie tool defines settings for the creation of flythru movies. It requires a selected 
linear element as camera path. The tool provides commands for the definition of target vectors, 
view and speed settings, some preview options, as well as the opportunity to save frames as .TIF 
files or a movie as .AVI file.

For a detailed description of the creation of flythru movies and menu commands, see Section 
Flythru Movies on page 31.

To create a flythru movie:

1. Digitize and select a path element.
2. Select Create Flythru Movie tool.

This opens the Create Flythru Movie dialog:

3. Create target vectors using Create vectors from the Target pulldown menu.
4. Define values for display and speed settings.
5. Set up the display of data in the view selected for rendering. Preview frames in order to 

check the setup at different locations along the camera path.
6. Modify the camera path and target vectors, if necessary. Use Update from design 

command from the Target pulldown menu in order to apply modifications to the flythu.
7. Save frames or a movie using Save frames or Save movie commands from the File 

pulldown menu.

Setting: Effect:
View MicroStation view that is used for rendering the frames.
Camera angle Field-of-view angle of the camera.

Front clipping
Distance up to which the content of the frame is clipped in the 
foreground. Data is rendered in the range between Front and Back 
clipping.

Back clipping
Distance after which the content of the frame is clipped in the 
background. Data is rendered in the range between Front and 
Back clipping.
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Render mode

Rendering method for frames:
• Low quality - TerraPhoto rendering with low image quality.
• Medium quality - TerraPhoto rendering with medium image 

quality.
• High quality - TerraPhoto rendering with high image quality.
• Capture - elements are rendered as they are displayed on the 

screen (like a screen capture). This method may include text 
elements.

Video speed Speed of the resulting movie in frames per second.
Default speed Traveling speed of the viewer in meter per second.
Frame Frame number for being displayed in a preview.

Preview mode
Display mode for previews:
• Wireframe - elements are drawn as wireframe graphics.
• Render - elements are rendered.

Preview Displays the frame with the given Frame number in the given 
View.

Show loc Shows the location of the given Frame number as dashed line in a 
MicroStation view if the mouse pointer is moved inside the view.

Identify Sets the Frame number based on a data click close to a location 
along the camera path.

Setting: Effect:
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Build Movie From Frames

Build Movie From Frames tool creates a movie from previously saved frames. It lets you load 
frame image files, cut, copy, and paste frames, and record the frames into an .AVI file.

For a more detailed description of menu commands provided by the tool, see Section Creation of 
movies from frames on page 36.

To build a movie from frames:

1. Select Build Movie From Frames tool.

This opens the Build Movie From Frames dialog:

2. Load frame images with Import files or Import directory commands from the File 
pulldown menu.

3. Check the frames. Apply changes, if necessary.
4. Select Save as command from the File pulldown menu to save the movie.

Depending on the amount of frames, the import of files and the saving process may take some 
time.
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Place Rpc Tree

Place Rpc Tree tool enables the manual placement of RPC trees. The tree’s location, height and 
width can be set based on images and laser data.

The tool creates RPC cells which are linked with RPC files on the hard disk. The default directory 
set in TerraPhoto for storing RPC files is C:/TERRA/RPC. If such a folder does not exist, the 
application asks for browsing to another directory when the tool is selected. If a view is rendered, 
the cells are replaced by the RPC files. The tool requires that RPC files are available.

For more information about RPC trees and rendering, see Section TerraPhoto Rendering on 
page 28.

To place RPC trees:

1. Select Place Rpc Tree tool.

This opens the Place Rpc Tree dialog:

2. Select a Tree cell and the placement method.
3. Define the base center point of the cell by a data click.
4. If the placement method is set to Mouse, define the tree height and/or width.

RPC tree cells can be placed automatically based on laser data by using the tree detection tool of 
TerraScan.

Setting: Effect:
Tree cell Name of the RPC tree cell that is placed.

Height

Placement method for the tree cell height:
• Automatic - defined by the original cell height.
• Keyin - defined by a keyin value.
• Mouse - defined by a mouse click.

Width

Placement method for the tree cell width:
• Automatic - defined by the original cell width.
• Keyin - defined by a keyin value.
• Mouse - defined by a mouse click.
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Fix Building Normals

Fix Building Normals tool enforces the normal direction of 3D planes to point to the outside of, 
for example, building models. This is useful to fix errors in the normal direction of wall polygons 
in order to ensure the correct textureing of the walls.

To check the normal direction of a 3D polygon, the Backside coloring setting in Define 
Rendering Settings dialog should be set to a constant color. Then, the Display Rendered View tool 
can be used to display a rendered view. Wall polygons displayed with the backside color at the 
outside of the building model do not have a correct normal direction for wall texturing.

The software can determine the inside and outside of polygons based on different methods. It can 
analyze how adjacent polygons touch each other, what side of the polygon is seen by raw images 
of an active image list, or what side is displayed in a view towards the viewer. The usage of raw 
images requires that a mission, a ground model, and an images list are loaded into TerraPhoto.

To fix normals of 3D planes:

1. Select the building model(s) for which the normals need to be fixed.
2. Select Fix Building Normals tool.

The Fix Building Normals dialog opens:

3. Select a Method for normal correction.
4. Accept the selection with another data click inside the view.

This fixes normals for all selected polygons to point to the outside of a building model.

Setting: Effect:

Method

Defines how the software determines the inside and outside of 
polygons:
• Swap all - the normal direction is reversed for each selected 

polygon.
• Fix using geometry - touching polygons are compared and 

determine what is inside/outside.
• Fix using images - images of an active image list are used to 

determine inside/outside. The software assumes that the images 
see the outside of a polygon better than the inside.

• Fix using view - the view orientation determines the inside/
outside. The software assumes that the viewer sees the outside 
of a polygon in a selected view.

Max distance
Maximum distance between an image position and the polygon for 
which to determine the normal direction. This is only active if 
Method is set to Fix using images.
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Change Texture Image

Change Texture Image tool lets you interactively change the raw image used for creating a wall 
texture. The tool opens a list of raw images which cover a selected building wall. From this list, 
you can select a raw image from which you want to create a texture.

The tool requires that textures files are already available. A new texture file overwrites the existing 
texture file for this wall.

The tool’s dialog contains a Save All button which can be used to save texture files from all 
available images for a wall into a folder. The folder is created as subdirectory of the folder in 
which the original texture files are stored. It is named with the prefix IMAGES_ and the name of 
the original wall texture, for example IMAGES_WALL0005681 for all possible texture files of 
WALL0005681.TIF. This may be useful, if you need to merge different parts of a wall from 
several images in order to get one texture file that covers the wall completely. In this case, you can 
use any image processing software for merging the different parts of the wall and then, replace the 
original texture file.

To change a texture image interactively:

1. Select Change Texture Image tool.
2. Identify the wall for which to change the texture with a data click.
3. Accept the selection with another data click.

This opens the Change Texture Image dialog:

4. Select an image from the list of raw images in the dialog.

This displays the wall texture created from the selected image. In addition, all building 
models are rendered using existing textures.

5. Choose the raw image from which you want to create the wall texture.
6. Click Apply.

This creates the new texture file. You can continue with step 2.
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Export City Model
Note Lite

Export City Model tool exports selected building models into a standardized text file. The 
supported file format is Collada (.DAE).

The selected building models are either exported into one Collada file of into separate files for 
each building model. Wall texture files are copied into a separate folder. In addition, textures for 
roofs can be created from images that are attached as raster references in TerraPhoto’s Manage 
Raster References window.

To export a city model into Collada file(s):

1. Select the building model(s) to be included in the export file.
2. Select Export City Model tool.

The Export City Model dialog opens:

3. Define settings and click OK.

This exports the selected building model(s) into Collada file(s). The .DAE file(s) are stored 
in the given Directory in a folder “models”. The wall and possibly roof texture files are 
stored in the given Directory in a folder “images”.

Setting: Effect:
Format Format of the export file: Collada.

Buildings

Defines how building models are stored:
• All into one file - all selected building models are written into 

one Collada file.
• Into separate files - a separate Collada file is written for each 

selected building model.

Write surfaces
Method of surface storage in the Collada file format:
• As polygons - surfaces are defined as polygons.
• As triangles - surfaces are defined as triangles.

Roof slope
Determines what polygons are exported as walls and roofs. Any 
polygon with a slope smaller than the given value is considered a 
roof polygon.

Write roofs If on, roof polygons are included in the export file.
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Roof textures from 
references

If on, texture files for roof polygons are created from raster 
references. This is only active if raster files are attached in 
TerraPhoto’s Manage Raster References window.

Write walls If on, wall polygons are included in the export file.

Write wall textures If on, wall texture files are included in the export file and stored in 
the export folder.

Directory
Directory on the hard disk where the export files are stored. Inside 
this directory the software creates the models and images folders 
for storing the Collada and texture files, respectively.

File name
Name of the Collada file. The default extension of collada files is 
.DAE and added to the file name automatically. This is only active 
if Buildings is set to All into one file.

File prefix

Text added at the beginning of each Collada file name. The name 
is completed by an increasing number for each building model and 
the extension .DAE. This is only active if Buildings is set to Into 
separate files.

Append selected text to 
file name

If on, selected text elements are added to the Collada file names. 
This is only active if text elements are selected and if Buildings is 
set to Into separate files.

Setting: Effect:
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Color Points tool box
Tools from the Color Points tool box are used to add, edit, or delete color points, to paint or place 
selection shapes, and to set images active or inactive. The same actions can be performed by using 
commands from the Color points menu.

It is required to start the color points mode in TerraPhoto in order to use the tools. The mode is 
started by using Define color points command from the Rectify pulldown menu in the TPhoto 
Main window. This creates a preview of rectified images on the ground model and opens the 
Color points menu.

See Chapter Color Points and Selection Shapes on page 124 for more detailed information about 
color points and selection shapes.

To: Use:

Add a single color point Add Color Point

Add color points and produce clones Add Clone Color Points

Edit a single color point Edit Color Point

Delete a single color point Delete Color Point

Paint a selection shape Paint Selection Shape

Place a selection shape Place Selection Shape

Set an image active or inactive for rectification Change Image Rectify Setting
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Add Color Point

Add Color Point tool performs the same action as the Add command in the Point pulldown menu 
from the Color points menu.

Add Clone Color Points

Add Clone Color Point tool performs the same action as the Add clones command in the Point 
pulldown menu from the Color points menu.

Edit Color Point

Edit Color Point tool performs the same action as the Edit command in the Point pulldown menu 
from the Color points menu.

Delete Color Point

Delete Color Point tool performs the same action as the Delete / One point command in the Point 
pulldown menu from the Color points menu.

Paint Selection Shape

Paint Selection Shape tool performs the same action as the Paint selection command in the Image 
pulldown menu from the Color points menu.

Place Selection Shape

Place Selection Shape tool performs the same action as the Place selection command in the Image 
pulldown menu from the Color points menu.
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Change Image Rectify Setting

Change Image Rectify Setting tool changes the status of an image between active and inactive. An 
inactive image is still present in the image list but is excluded from the orthorectification process. 
The image status is saved in the image list.

The tool is useful, for example, for testing which images can be deleted from the image list without 
causing a gap or to exclude images from the ortho mosaic while keeping them as part of the tie 
point solution.

To change image active setting:

1. Select the Change Image Rectify Setting tool.

This opens the Change Image Rectify Setting dialog:

2. Select settings.
3. Move the mouse pointer inside a MicroStation view.

The image footprint closest to the mouse pointer location is shown. An active image footprint 
is displayed with continuous lines while an inactive image footprint is displayed with dashed 
lines.

4. Switch the image status between active and inactive with data clicks inside the image 
footprint.

5. Save the image list using Save list or Save list As commands from the Images pulldown 
menu in order to save the changes into an image list file.

Setting: Effect:

Change

Defines what status changes are possible:
• To inactive – only active to inactive.
• To active – only inactive to active.
• Toggle – changes from active to inactive and vice versa.

Camera
Name of the camera for which image status changes are applied. 
Alternatively, the status of images from any camera can be 
modified.

Quality Quality number. Status changes effect only images with the given 
quality. Quality 0 enables changes to all images.
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Tile tool box
Tools in the Tile tool box are used to place tile rectangles for orthophoto mosaics.

To: Use:

Place a tile rectangle for orthorectification Place Tile

Place an array of tile rectangles Place Tile Array

Move location of tile rectangles Move Tile
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Place Tile
Not Lite

Place Tile tool places a single tile rectangle. When used in orthorectification, the application 
creates one orthorectified raster file covering the area of each tile rectangle.

This tool is very similar to MicroStation’s Place Block tool. The only difference is that the 
rectangle size is specified by a pixel size and the number of pixels for width and height. In 
addition, the corner points of the rectangles can be fixed to be at coordinate values which are 
multiples of the given pixel size.

To place a tile rectangle:

1. Select the Place Tile tool.

This opens the Place Tile dialog:

2. Define settings.

If the mouse pointer is moved inside a top view, the rectangle is displayed dynamically at the 
mouse pointer location.

3. Place the tile rectangle with a data click inside a top view.

This draws the rectangle into the design file using the active level and symbology settings.

Place Tile Array
Not Lite

Place Tile Array tool performs exactly the same action as the Place tile array command from the 
Utility pulldown menu of the TPhoto Main window.

Placing a tile array works only if a mission, a ground model, and an image list are loaded into 
TerraPhoto.

Move Tile
Not Lite

This tool is not implemented yet.

Setting: Effect:

Place by Corner point used to define the tile position with a data click: 
Lower left, Lower right, Upper left, or Upper right.

Pixel size Pixel size to use for computing the tile width and height.
Width Tile width in pixels.
Height Tile height in pixels.

Align to pixel step If on, the corner position of the tile is fixed to coordinates that are 
a multiple of the given pixel size.
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16 Main Window Menu Commands

Mission pulldown menu
Commands from the Mission pulldown menu are used to define mission parameters, to open a 
previously saved mission, to save the active mission, and to close TerraPhoto.

To: Choose menu command:
Setup a new mission definition New mission
Open a previously saved mission from a file Open mission
Modify settings of the active mission Edit mission
Save a mission definition Save mission
Save a mission definition to a new file Save mission As
Setup a mission from a Lynx survey index file Import Lynx Survey
Setup a mission from a Pictometry index file Import Pictometry Survey
Close TerraPhoto Exit
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New mission

New mission command opens the dialog for defining a new mission. A mission definition 
contains descriptive information, a scale factor, ouput directories for storing specific types of files 
during the TerraPhoto workflow, and camera definitions. A mission definition is stored into a file 
with the extension .MIS.

The output directories are used by TerraPhoto to store specific file types:

• Temporary files - files for internal use in TerraPhoto processing. This includes thumbnails, 
shadow maps, and depth maps.

• Rectified images - image files produced by the Rectify images command.
• Ortho mosaic - image files produced by the Rectify mosaic command.

A mission may include several cameras. For each camera, a camera calibration file is required. 
See Define Camera tool for more information. Further, the camera definition determines the 
format and storage folder(s) of the raw images, the method of deducing unique image numbers 
from the raw image file names, and a positional accuracy attribute for images of this camera.

To create a mission definition:

1. Select New mission command from the Mission pulldown menu.

This opens the Mission dialog:

2. Select the Platform of your system: Airborne or Mobile.
3. (Optional) Fill in descriptive information into the fields in the Description group.
4. Select a coordinate system in the Scale from list from which to use the Scale factor. 

Alternatively, define a Scale factor value manually.
5. Define a directory for storing Temporary files. Use the Browse button to select a folder 

from the hard disk.
6. Define a directory for storing Rectified images. Use the Browse button to select a folder 
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from the hard disk.
7. Define a directory for storing Ortho mosaic files. Use the Browse button to select a folder 

from the hard disk.
8. Click Add to specify camera(s) used in the mission.

This opens the Mission camera dialog:

9. Define settings for the camera.

Repeat steps 8 and 9 if multiple cameras are used in the mission. Use the Copy and Edit 
buttons in order to speed up the definition of multiple cameras.

10. Click OK to close the Mission camera dialog.
11. Click OK to close the Mission dialog.
12. Select Save mission As command from the Mission pulldown menu to save the mission 

definition into a file.

Setting: Effect:
Name Descriptive name for the camera.
Camera file Location and name of the camera calibration file.
Positions Relative positional accuracy of images from this camera. This 

setting has an effect if multiple cameras are used. The application 
tries to modify less accurate image positions more in adjustment 
routines.



Page 220
16 Main Window Menu Commands
Numbering Rule for how to extract a unique image number from the raw image 
file name:
• Last number in file name – last sequence of digits.
• Last two numbers – last two sequences of digits.
• Last three numbers – last three sequences of digits.
• Last four numbers – last four sequences of digits.
• Line + image number – strip and a number.
• Last letter + number – last letter and a number.
• Last number + letter + number – the last number and letter in 

file name and a number.
• Eagle Eye numbering - system-specific numbering method.
• Mitsubishi numbering - system-specific numbering method.
• First number - first sequence of digits.
• First two numbers – first two sequences of digits.
• First three numbers – first three sequences of digits.
• First four numbers – first four sequences of digits.

Format Raster format of the raw images. The image list does not have to 
specify the default extension as part of the image names.

Channels Number of channels in the raw images. If the number is bigger than 
3, the RGB fields become available. Select a channel number that 
is displayed in place of TerraPhoto’s red, green, and blue channel. 
This is only active if Format is set to TIFF n*8 bit or TIFF n*16 
bit.

Favor coloring points If on, the Classes field defines point classes that are colored 
perferably from images of this camera. This has an effect for 
extracting color from images to laser points in TerraScan.
Opens the Select classes dialog which contains the list of active 
classes in TerraScan. You can select multiple source classes from 
the list that are then used in the Classes field.

Rotate image for viewing
Image directories Directories that store the raw images.

Setting: Effect:
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Open mission

Open mission command reads information from a previously saved mission file.

Edit mission

Edit mission command lets you modify the definition of the active mission.

To modify a mission definition:

1. Select Edit mission command from the Mission pulldown menu.

This opens the Mission dialog.

2. Edit the settings in the dialog.

They are described in detail in Section New mission on page 218.

3. Click OK.
4. Select Save mission command in order to save the changes to the mission file on the hard 

disk.

Save mission

Save mission command saves the mission definition into the same file from which it has been 
opened before.

Save mission As

Save mission As command saves the mission definition into a new file.
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Import Lynx Survey

Import Lynx Survey command reads information from a Lynx index file and creates a mission 
file, an image list, and (optional) camera files.

The index file is a text file that contains information about the survey, camera parameters, and 
images. The file is created by Optech software delivered with the Lynx system. The camera 
parameters for each camera of the system are converted into a TerraPhoto camera calibration file. 
The time and positional information for the images are converted into a TerraPhoto image list.

To import a Lynx survey index file:

1. Select Import Lynx Survey command from the Mission pulldown menu.

This opens the Import Lynx survey dialog, a standard dialog for opening files.

2. Select the index file and click Open.

The Import Lynx survey dialog opens:

3. Define settings and click OK.

The mission file, an image list file, and possibly camera calibration files are created in the 
given directory. The camera files are named CAMERA1.CAL and CAMERA2.CAL.

Setting: Effect:
Save in folder Directory that stores the mission file, the image list file, and the 

camera files.
Mission name Name of the mission file. The extension must be .mis.
Image list name Name of the image list file. The extension must be .iml.
Calibration Method of handling camera calibration files:

• Import from Lynx file - the camera calibration information is 
read from the index file and new TerraPhoto camera files are 
created.

• Use existing cal files - existing TerraPhoto camera files are used 
and the software does not create new files. The files must be named 
camera1.cal and camera2.cal.

WGS84 Transformation from WGS84 coordinates to a projection system that 
is applied to the image list. You can choose from any of the builtin or 
user-defined projections systems which are set as active in 
TerraPhoto Settings.

Transform User-defined transformation that is applied to the image list. The list 
contains transformations defined in Coordinate transformations / 
Transformations of TerraPhoto Settings.
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Import Pictometry Survey

Import Pictometry Survey command reads information from a text file and creates a mission 
file, an image list, and camera files. The text file can be created, for example, from the .DBF file 
delivered by the Pictometry system software.

The text file must include a specific set of columns which are delimited by tabulator. The two 
options for columns and their labels are:

• NAME, OMEGA, PHI, KAPPA, X COORD, Y COORD, ALTITUDE, X PP OFFSET, Y PP 
OFFSET, FOCAL LENGTH, FOCAL WIDTH, FOCAL HEIGHT, K1, K2, K3, GPS TIME

• IMAGENAME, IMAGEEXT, OMEGA, PHI, KAPPA, CAMERAX, CAMERAY, ALT, PPX, 
PPY, FOCALLEN, IMAGECOLS, IMAGEROWS, K1, K2, K3

The text file must have the extension .CSV. The camera parameters for each camera of the system 
are converted into a TerraPhoto camera calibration file. The time and positional information for 
the images are converted into a TerraPhoto image list.

To import a Pictometry survey index file:

1. Select Import Pictometry survey command from the Mission pulldown menu.

This opens the Import Pictometry survey dialog, a standard dialog for opening files.

2. Select the text file and click Open.

The Import Pictometry survey dialog opens:

3. Define settings and click OK.

The mission file, an image list file, and camera calibration files are created in the given 
directory.

Setting: Effect:
Save in folder Directory that stores the mission file, the image list file, and the 

camera files.
Mission name File name of the mission file. The extension must be .mis.
Image list name File name of the image list file. The extension must be .iml.
Image folder Directory that stores the image files.
Scale from Method of deriving the scale factor:

• Keyin value - the scale factor is defined by the given value in the 
Scale factor field.

• <projection system> - the scale factor is defined by the selected 
projection system. You can choose from any of the builtin or user-
defined projections systems which are set as active in TerraPhoto 
Settings.
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Exit

Exit command closes TerraPhoto and unloads the application.

Pixel size Pixel size of the raw images in millimeter.
Transform User-defined transformation that is applied to the image list. The list 

contains transformations defined in Coordinate transformations / 
Transformations of TerraPhoto Settings.

Setting: Effect:
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Points pulldown menu
Commands from the Points pulldown menu are used to load points into TerraPhoto which are then 
used to create a ground surface model. The software can reference points loaded into TerraScan. 
Alternatively, it can load points directly from files.

To: Choose menu command:
Reference points loaded into TerraScan Load from TerraScan
Load ground points from file(s) into TerraPhoto Load from file
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Load from TerraScan

Load from TerraScan command references points loaded into TerraScan and uses them as a 
ground model for rectifying the images.

To reference points from TerraScan:

1. Select Load from TerraScan command from the Points pulldown menu.

This opens the Select classes dialog displaying active point classes in TerraScan:

2. Select the class(es) which form the rectification surface.
3. Click OK.

The application reports how many points it references in TerraScan tables.

Load from file

Load from file menu command reads ground model points from a file into TerraPhoto’s memory. 
All points in the input file(s) are used to create the ground model for rectifying the images.

Supported file formats include:

• Space-delimited X Y Z text file.
• Space-delimited Code X Y Z text file.
• Space-delimited Pulse X Y Z Intensity text file.
• TerraScan binary 8 bit format.
• TerraScan binary 16 bit format.
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Images pulldown menu
Commands from the Images pulldown menu are used to create and manage the active list, to start 
the tie point mode, and to manipulate attributes of the images of the active image list. The 
commands do always effect the entries of the active image list and not the raw image files.

To: Choose menu command:
Load an image list from file(s) on the hard disk Load list
Compute an image list from trajectory and image timing 
information

Compute list

Close the current image list Close list
Save the active image list Save list
Save the active image list into a new file Save list As
Define color adjustments for raw images Define color corrections
Apply a coordinate transformation to image positions Transform positions
Adjust elevations of images using a geoid model Adjust to geoid
Compute new orientation angles Convert angles
Start the tie point mode Define tie points
Adjust image positions using tie points Adjust positions
Manually add a new image to the image list Add
Modify information of selected image(s) Edit
Delete selected images from the list Delete / Selected images
Delete images of a certain camera from the list Delete / By camera
Delete inactive images from the list Delete / Inactive images
Delete closeby images from the list Delete / Closeby images
Delete redundant overlapping images from the list Delete / Overlapping images
Delete images inside a fence from the list Delete / Inside fence
Delete images outside a fence from the list Delete / Outside fence
Delete image outside the ground model from the list Delete / Outside ground
Delete images outside powerline towers from the list Delete / Non-tower images
Delete image entries without a raster file from the list Delete / Missing file images
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Load list

Load list command reads an image list file and adds it to the active list of images in TerraPhoto.

The command is also used to load an exterior orientation file into TerraPhoto and convert it into 
an image list. This requires the definition of the exterior orientation file format in TerraPhoto 
Settings. See Exterior orientation formats for more information.

Typically, the command is used if the exterior orientation of the images is defined using angles 
omega, phi, and kappa. These angles have to be converted into heading, pitch, and roll in order to 
process the image data in TerraPhoto.

To load exterior orientation files:

1. Select Load list command from the Images pulldown menu.

This opens the Image list files dialog, a standard dialog for opening files.

2. Define the text files that contain the exterior orientation information for the images and 
click Done.

This opens the Import Orientation File dialog:

3. Define settings and click OK.

The software reads the content of the text file and converts the information into a TerraPhoto 
image list.

4. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the image list file.

Setting: Effect:
Camera Name of the camera for which image orientation values are loaded.
Input format Name of the exterior orientation format defined in TerraPhoto 

Settings.
Input angles Format of the input angles:

• Radians - 2*pi - angle values are given in radians. The software 
normalizes the values between -pi and +pi.

• Degree - 360 - angle values are given in degree. The software 
normalizes the values between -180 and +180 degree.

• Gones - 400 - angle values are given in gones. The software 
normalizes the values between -200 and +200 gones.

Base rotation Rotation of the camera within the system relative to the flight 
direction.

Rotation order Order of the input angles. Usually, the order is omega phi kappa. This 
is used to derive the correct rotation matrix for heading, roll, and pitch 
angles.
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Compute list
Not Lite

Compute list command creates an image list from time-stamped trajectory information and 
system-specific image list files. The application derives the corresponding xyz position and 
orientation angles for each image from the trajectory. If there is already an active image list in 
TerraPhoto, the new entries are added to the active list.

This command requires that trajectories are imported first by using the Manage Camera 
Trajectories tool. In most cases, the image list is computed for one camera at a time. Therefore, 
the steps have to be repeated several times in order to add images from multiple cameras to the 
image list.

The image information can be provided in different ways:

• Image timing files - time of image capture and name of each image are stored space- or tab-
separated columns in a text file.

• Event + naming file - time of image capture and an event number are stored in one text file, 
event number and image name are stored in another text file.

• Lynx survey file - specific text file from the Optech Lynx system.
• Riegl csv files - specific text files from the Riegl system.
• Trimble MX8 dbf files - specific dbf files from the Trimble MX8 system.

The command can utilize a selected shape for bounding an area. Only images, for which the xyz 
position is located inside the boundary are added to the image list.

To compute an image list from image timing files:

1. (Optional) Draw and select a shape around the area for which to add images to the image 
list.

2. Select Compute list command from Images pulldown menu.

This opens the Compute list dialog:

3. Select the source file format in the Source list.
4. Select whether to add all images from the selected source file or only image inside a 

selected shape.

The following settings depend on the selected source file format.
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Image timing files, Riegl csv files
5. Select the camera in Camera field for which the input files apply.
6. Click on the Add botton to add image timing files to the list.

OR

Click on the Add directory botton to add all text files from a directory to the list.

This opens the Image timing files/directory dialog, a standard dialog for opening files/
folders.

7. Define the text file(s)/folder and add them to the list in the Compute list dialog.
8. Click OK.

The software links each image timing file with the trajectory information using the time 
stamps. For each image, the positional and orientation information is derived and added to 
the image list.

9. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the image list file.

Event + naming files
5. Select the camera in Camera field for which the input files apply.
6. Click on the Add files botton to add event files to the list.

This opens the Event files dialog, a standard dialog for opening files.

7. Define the text file(s) and add them to the list in the Compute list dialog.
8. Click on the Add files botton to add image name files to the list.

This opens the Image naming files dialog, a standard dialog for opening files.

9. Define the text file(s) and add them to the list in the Compute list dialog.
10. Click OK.

The software links each image naming file to the corresponding event file using the event 
number. Then, the event file is linked with the trajectory information using the time stamps. 
For each image, the positional and orientation information is derived and added to the image 
list.

11. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the image list file.

Lynx survey files
5. Click on the Add button to add the survey-specific text files to the list.

OR

Click on the Add directory botton to add all text files from a directory to the list.

This opens the Image timing files/directory dialog, a standard dialog for opening files/
folders.

6. Define the text file(s)/folder and add them to the list in the Compute list dialog.
7. Click OK.

The software reads the positional and orientation information for each image from the survey 
file and adds it to the image list.

8. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the image list file.
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Trimble MX8 dbf files

5. Select a camera in Camera field for which the input files apply.
6. Select the time stamp format that is used in the source files.
7. Define a number of seconds to be added to the time stamps.
8. Define a method of handling the Source images.

Source images are renamed during the image list computation in order to make their naming 
unique over all cameras.

9. Define the Source folder, where images are stored. The images can be stored in several 
subfolders within the source folder.

10. Click on the Add botton to add .dbf files to the list.

OR

Click on the Add directory botton to add all .dbf files from a directory to the list.

This opens the Image timing files/directory dialog, a standard dialog for opening files/
folders.

11. Define the .dbf file(s)/folder and add them to the list in the Compute list dialog.

The file names of the dbf files also define the name of subfolders the software checks for 
source images.

12. Click OK.

The software links each image timing file with the trajectory information using the time 
stamps. For each image, the positional and orientation information is derived and added to 
the image list.

13. Repeat steps 5 to 12 for all cameras for which to add images to the image list.
14. Select Save list or Save list As commands from the Images pulldown menu in order to save 

the image list file.
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Close list

Close list command closes the active list of images. This results in an empty image list.

To close an image list:

1. Select Close list command from the Images pulldown menu.

If the image list has been changed and not yet saved, a dialog opens and asks for confirmation 
of the closing action.

2. Click Yes in order to close the image list without saving the changes to the image list file.

Save list

Save list command saves the active image list to the same file from which it was opened before. 
This is only possible as long as no additional images have been added to the original image list.

Save list As

Save list As command saves the active image list into a new file.
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Define color corrections

Define color corrections command applies color corrections for all or selected images in the 
image list. Corrections can be applied for red, green, and blue color channels, as well as for 
intensity, saturation, and contrast values.

The command can be used, for example, to correct systematic color or brightness issues in the raw 
images, such as color casts in all images of a camera or within a certain time interval. Furthermore, 
are grid-based brightness correction can be applied to the images. This improves images that are 
darker towards the image edges/corners and brighter in the center.

See Chapter Color corrections on page 67 for a detailed description of settings and commands 
for defining color corrections.

To define color corrections:

1. (Optional) Select Analyze images command from the Utility pulldown menu in order to 
check a report about average color values, intensity, saturation, and contrast for each image 
as well as an average value for all or selected images.

2. Select Define color corrections command from the Image pulldown menu.

If thumbnails do not yet exist in the temporary files folder of the mission, the Create 
thumbnails dialog opens. See Create thumbnails command for more information.

The Define color corrections dialog opens:

3. Scroll through the thumbnail list on the right side to get an overview of the image coloring.
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4. Select images in the thumbnail list for which you want to apply color corrections. Set 
correction values and click Apply for each setting.

This updates the display of the thumbnails and writes the correction values into the image 
list. Continue with step 4 for all images that need color corrections.

5. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the color corrections into an image list file.

You can check the result of color corrections by choosing Define color points command from the 
Rectify pulldown menu in the TPhoto Main window. This creates a preview of the ortho mosaic 
using the color corrections on-the-fly.
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Transform positions
Not Lite

Transform positions command changes the positions of images in the image list by applying a 
transformation. You can apply a transformation from WGS84 coordinates to a projection system 
and/or a user-defined transformation.

The projection systems and transformations must be defined in the Coordinate transformations 
categories of TerraPhoto Settings.

To transform image list positions:

1. Select Transform positions command from the Images pulldown menu.

This opens the Transform image coordinates dialog:

2. Select settings and click OK.

This transforms the image positions for the active image list.

3. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

Setting: Effect:
Apply to Images to transform:

• All images - all images in the image list.
• Selected images - selected images only. This requires the selection 

of images in the image list before the command is started.
WGS84 Target projection system for applying a transformation from WGS84 

coordinates to the given projection system. You can choose from any 
of the builtin or user-defined projections systems which are set as 
active in Coordinate transformations / Builtin projection systems, 
Coordinate transformations / US State Planes, and Coordinate 
transformations / User projection systems of TerraPhoto Settings.

Transform User-defined transformation to apply. You can choose from any 
transformation that is defined in Coordinate transformations / 
Transformations of TerraPhoto Settings.

Dz Value by which images are transformed in elevation. This is only 
active if Transform is set to Dz.

Dxyz Location and name of a file that contains transformation values. This 
is only active if Transform is set to Dxyz.
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Adjust to geoid
Not Lite

Adjust to geoid command applies an elevation correction to images of the active image list. This 
command is often used to transform the WGS84-based ellipsoidal elevation values to a geoid-
based height model.

The input model for elevation adjustment can be provided in different ways:

• Points from file - text file containing space-delimited X Y dZ points.
• TerraModeler surface - triangulated surface created from X Y dZ points. The model must be 

loaded in TerraModeler. This has the advantage that you can visualize the adjustment model.
• Selected linear chain - linear element which has vertices derived from X Y dZ points.

The first two input models utilize aerial interpolation while the last input model uses linear 
interpolation along the linear element’s segments in order to derive adjustment values.

To adjust image elevations to a geoid model:

1. (Optional) Load a geoid model into TerraModeler.
2. Select Adjust to geoid command from the Images pulldown menu.

This opens the Adjust to geoid dialog:

3. Select the input model type in the Dz model field and click OK.

If Points from file is selected as the Dz model, the Geoid dz file dialog opens, a standard 
dialog for opening files.

4. Define the text file that contains the geoid coordinates and elevation differences and click 
Open.

This applies the elevation adjustment to all images of the active image list. An information 
dialog shows the minimum and maximum values of the adjustment.

5. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.
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Convert angles
Not Lite

Convert angles command lets you apply a mathematical equation to the image orientation angles 
heading, pitch, and roll. The modification effects the anlges of all or selected images in the active 
image list.

To convert angles of images:

1. Select Convert angles command from the Images pulldown menu.

This opens the Convert angles dialog:

2. Define equations for the angles.
3. Click OK.

This computes the new values for the image orientation angles.

4. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

Setting: Effect:
Apply to Images for which the computation of new angles is applied:

• All images - all images in the image list.
• Selected images - selected images only. This requires the selection 

of images in the image list before the command is started.
Heading Equation for modifying the heading angle.
Roll Equation for modifying the roll angle.
Pitch Equation for modifying the pitch angle.
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Convert time stamps
Not Lite

Convert time stamps command can be used to convert the format of time stamps. Supported 
conversions are GPS seconds-of-week to GPS standard time, Unix time to GPS standard time, 
GPS standard time to GPS seconds-of-week, and Unix time to GPS seconds-of-week. The 
modification effects the time stamps of all or selected images in the active image list.

To convert time stamps:

1. Select Convert time stamps command from the Images pulldown menu.

This opens the Convert time stamps dialog:

2. Define settings for the conversion.
3. Click OK.

This converts the image time stamps to the new format.

4. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

Setting: Effect:
Apply to Images for which the computation of new angles is applied:

• All images - all images in the image list.
• Selected images - selected images only. This requires the selection 

of images in the image list before the command is started.
Current values Original time stamp format of the images.
Convert to Target time stamp format.
Survey date Date when the images were captured. The format is day / month / year. 

The date should be given within 2-3 days of the actual surveying day. 
This is only active for the conversion from GPS seconds-of-week to 
GPS standard time.
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Define tie points
Not Lite

Define tie points command switches the application into tie point mode. This involves building a 
triangulated model of the ground (if available) and re-arranging the views for the work with tie 
points.

For airborne missions, the tie point mode is only available if a ground model is loaded into 
TerraPhoto. For mobile missions, a ground model is not required for working with tie points.

The processing workflow and all commands related to tie points are described in detail in Chapter 
Working with Tie Points on page 76.

To start the tie points mode:

1. Select Define tie points command from the Images pulldown menu.

This might open the Tie point view setup dialog, unless the view setup has been saved for 
the design file before.

2. Define view setup settings and click OK. See Setup command for more information about 
the view setup.

The software reorganizes the MicroStation views according to the setup settings. It also 
opens the Tie points window which contains the active image list.

If the Tie points window is closed, the MicroStation windows used for tie point processing are 
closed as well. The view setup switches back to the same arrangement that had been active before 
the tie point mode was started. However, the tie points are still active and loaded in the memory.
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Adjust positions
Not Lite

Adjust positions command adjusts the positions of the images in the active image list. The 
software tries to improve the match of the tie point rays from different images. This process is also 
called aerial triangulation. The adjustment can use tie points from a file or active tie points. The 
latter alternative requires that the Tie points window is open and tie points are active.

The adjustment can be applied to image orientation angles, image elevation, and/or image xyz 
positions. If the raw positioning of the images is good and based on GPS measurements, it is 
recommended to modify the orientation angles only. There is a high correlation between xy and 
roll/pitch adjustments. The adjustment of both is reliable only if there is a very good number of 
tie points for each image.

Positional adjustment of the images can be performed with the following goals in mind:

• Improve camera calibration parameters. You can make changes to camera misalignment 
angles or principal point z based on the adjustment report.

• Find bad tie points. Bad tie points cause bigger changes to raw positioning which are 
highlighted in the report if you specify suitable flagging limits. Furthermore, when you have 
adjusted image positioning, bad tie points stand out by having larger mismatch values.

• Produce an adjusted image list which provides more accurate image positioning. This image 
list should be saved as its own file and can be used for orthorectification or for vectorization 
tasks.

To adjust image positioning using tie points:

1. Select Adjust positions command from the Images pulldown menu.

This opens the Adjust position using tie points dialog:

2. Define settings and click OK.

This starts the adjustment process. After the process has finished, the Tie point adjustment 
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report is displayed.

3. Select Save list As commands from the Images pulldown menu in order to save the image 
list into a new file.

Tie point adjustment report
Adjust positions produces a report which plays a central role for optimizing camera parameters 
and for fine tuning tie points.

The start of the report may look like:

Start average          4.9789 cm
Final average          1.3724 cm

Start average indicates how well tie point rays match each other before the adjustment. This 
value is a measure of how good the raw positioning of images is, how good the camera calibration 
works, and how good the tie points are. Whenever you try to improve any of these factors, you 
aim to minimize the average mismatch.

Final average indicates how well tie point rays match each other after the adjustment. This value 
is primarily a measure of how good the camera calibration is and how good the tie points are.

The end of the report may look like:

Avg magnitude   0.0     0.0     0.0   0.039   0.010   0.009
Average        +0.0    +0.0    +0.0  -0.000  -0.001  -0.000
Median         +0.0    +0.0    +0.0  +0.000  -0.001  -0.000

Avg magnitude indicates how big the average changes to parameters are. These changes give an 
indication of the quality of the raw GPS/IMU trajectory information.

Average and Median give an indication if heading, roll, and pitch misalignment values for the 

Setting: Effect:
Camera Name of the camera for which to apply the adjustment. 

Alternatively, images from Any camera can be adjusted.
Adjust Images that are effected by the adjustment:

• All images - all images in the active image list that have tie 
points.

• Well defined images - images that have enough tie points to 
meet the given Point value and Coverage limits.

• Selected - selected images only. This requires the selection of 
images in the image list before the command is started.

Point value Required Tie point values for images to be adjusted. This is only 
active if Adjust is set to Well defined images.

Coverage Required Tie point distribution for an image to be adjusted. This 
is only active if Adjust is set to Well defined images.

Use Source of tie points: Active tie points or Tie point file.
Tie points File from which to read tie points. This is only active if Use is set 

to Tie point file.
Fix heading If on, the process modifies the heading angles of images.
Fix roll If on, the process modifies the roll angles of images.
Fix pitch If on, the process modifies the pitch angles of images.
Fix elevation/scale If on, the process modifies the camera z coordinates of images.
Fix xyz If on, the process modifies the camera xyz coordinates of images.
Fix time position Not yet implemented.
Write adjustment curve If on, the changes are written to a text file that contains time stamps 

and adjustment values. This may be useful, for example, to find out 
whether there has been drift in the IMU measurement.
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camera are good. Average heading, roll and pitch changes should be practically zero if the 
misalignment values in the camera file are correct and if you have good tie points.
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Add

Add command lets you add an image to the active image list. You define manually the image file 
name, xyz position, heading, roll, pitch angles, and (optional) other image parameters.

To add an image to the list:

1. Select Add command from the Images pulldown menu.

This opens the Image information dialog:

2. Define settings and click OK.

This adds a new image to the image list.

3. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

Setting: Effect:
File name Name of the raw image file.
Time stamp (Optional) Time stamp of the image.
Camera Name of the camera which captured the image.
Rectify Defines whether the image is used in orthorectification processes 

or not. An image with rectification status Yes is considered an 
active image, otherwise images are considered as inactive.

Tie status Defines the status of the image for tie point work:
• Check - the image is included in the list of images for placing 

tie points.
• Approved - the image is excluded from the list of images for 

placing tie points.
Quality (Optional) Quality value of the image.
Group (Optional) Group number of the image.
Easting Easting coordinate of the image position (focal point).
Northing Northing coordinate of the image position (focal point).
Elevation Elevation coordinate of the image position (focal point).
Heading Heading angle of the image orientation. Given in degree.
Roll Roll angle of the image orientation. Given in degree.
Pitch Pitch angle of the image orientation. Given in degree.
Accuracy (Optional) Accuracy estimate of the image xyz positioning.
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Edit

Edit command lets you modify the information of one or several images in the active image list.

If information is changed for several images, the values for image position coordinates, 
orientation angles, and time are no longer absolute values but difference values. These difference 
values are then added to the original values of the selected images.

To modify information of a single image:

1. Select one image in the image list.
2. Select Edit command from the Images pulldown menu.

This opens the Image information dialog.

3. Modify settings and click OK. See Add command above for more information.

This modifies the values for the selected image.

4. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

To modify information of multiple images:

1. Select multiple images in the image list.
2. Select Edit command from the Images pulldown menu.

This opens the Edit several images dialog:

3. Check the toggle buttons for the parameters to modify.
4. Define values and click OK.

This applies the modified values to the selected images.

5. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.
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Delete / Selected images

Delete / Selected images command removes selected images from the active image list.

To delete selected images:

1. Select the images to be deleted in the image list.
2. Select Delete / Selected images command from the Images pulldown menu.

An alert dialog is displayed that asks for a confirmation of the delete action.

3. Click Yes to the Alert dialog in order to remove the images from the image list.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save 

the changes into an image list file.

Delete / By camera

Delete / By camera command removes images captured by a given camera from the active image 
list.

To delete images of certain camera(s):

1. Select Delete / By camera command from the Images pulldown menu.

This opens the Delete by camera dialog:

2. Select the camera(s) from which to delete the images.

The images captured by the selected camera(s) are removed from the image list. An 
information dialog displays the number of removed images.

3. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.
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Delete / Inactive images

Delete / Inactive images command removes images from the active image list for which the 
rectification status attribute is set to No. See Add and Edit commands for selected images for 
more information about the attributes of images.

To delete selected images:

1. Select Delete / Inactive images command from the Images pulldown menu.

An alert dialog is displayed that asks for a confirmation of the delete action.

2. Click Yes to the dialog in order to remove the images from the image list.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save 

the changes into an image list file.

Delete / Closeby images

Delete / Closeby images command removes images from the image list that are captured within 
a defined time interval, distance, or turn angle. This can be used, for example, to delete multiple 
images that see almost the same location, such as images captured by a mobile ground-based 
camera system during a stop, slow drive, or sharp turn.

To delete closeby images:

1. Select Delete / Closeby images command from the Images pulldown menu.

This opens the Delete closeby images dialog:

2. Define settings and click OK.

The software detects closeby images and removes them from the image list. An information 
dialog displays the number of deleted images.

3. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

Setting: Effect:
By 3D distance Images captured within the given distance from each other are 

deleted.
By heading Images for which the change in heading angle is within the given 

value are deleted.
By time Images captured within the given time interval are deleted.
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Delete / Overlapping images

Delete / Overlapping images command removes unnecessary overlapping images from the 
active image list. It computes accurate coverage areas of images on the ground and makes sure 
that the removal of images does not result in gaps.

To delete overlapping images:

1. Select Delete / Overlapping images command from the Images pulldown menu.

This opens the Delete overlapping images dialog:

2. Define settings and click OK.

The application detects the image overlap and removes the unnecessary images according to 
the given settings.

3. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

Setting: Effect:
Prefer images Determines which images to keep and which to remove:

• Vertical facing - keeps images with smaller roll or pitch angles.
• Small pixel size - keeps images from a lower altitude and deletes 

images from a higher altitude.
• First in list - keeps images which appear first in the image list.
• Last in list - keeps images which appear last in the image list.

Delete Defines, how many images are deleted:
• All redundant images - deletes all images which can be removed 

without causing gaps.
• Limited number - deletes only up to a given number of images.

Upto Maximum number of images that are removed. This is only active if 
Delete is set to Limited number.

Ignore Number of pixels on the edge of an image to ignore when detecting 
the overlap between images.
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Delete / Inside fence

Delete / Inside fence command removes images from the active image list whose camera xy 
position is inside the fence. You can also use a selected shape instead of a fence to specify the area.

To delete images inside a fence:

1. Use MicroStation tools to draw a fence or digitize and select a shape around the area from 
which to remove the images.

2. Select Delete / Inside fence command from the Images pulldown menu.

An alert dialog is displayed that asks for a confirmation of the delete action.

3. Click Yes to the dialog in order to remove the images inside the fence from the image list.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save 

the changes into an image list file.

Delete / Outside fence

Delete / Outside fence command removes images from the active image list whose camera xy 
position is outside the fence. You can use a selected shape instead of a fence to specify the area.

To delete images outside a fence:

1. Use MicroStation tools to draw a fence or digitize and select a shape around the area for 
which to keep the images in the image list.

2. Select Delete / Outside fence command from the Images pulldown menu.

An alert dialog is displayed that asks for a confirmation of the delete action.

3. Click Yes to the dialog in order to remove the images outside the fence from the image list.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save 

the changes into an image list file.
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Delete / Outside ground

Delete / Outside ground command removes images from the active image list that are not located 
inside the area defined by the ground model in TerraPhoto. It computes accurate coverage areas 
of images on the ground and makes sure that only those images are removed that do not see enough 
ground area.

To delete overlapping images:

1. Select Delete / Outside ground command from the Images pulldown menu.

This opens the Delete images outside ground dialog:

2. Define settings and click OK.

The application detects the images outside the ground model area and removes them from 
the image list.

3. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

Setting: Effect:
Camera Name of the camera for which to apply the image removal. 

Alternatively, images from Any camera can be removed.
Max point distance Distance between the camera position of an image and points in the 

ground model within which the ground model points are considered 
for the process. The usage of points that are far away from a camera 
position slows down the computation process. This is especially 
relevant for images seeing the ground from a direction that is much off 
from vertical.

Must see Minimum amount of points of the ground model that an image must 
see in order to being kept in the image list.
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Delete / Non-tower images

Delete / Non-tower images command removes images from the active image list that are not 
captured from a tower locations along a power line. The tower locations are defined by a tower 
string element in TerraScan. The process keeps only those images which provide the vertical or 
the best oblique view of tower structures.

To delete images outside tower locations:

1. Select the tower string element.

1. Select Delete / Non-tower images command from the Images pulldown menu.

This opens the Delete non-tower images dialog:

2. Define settings and click OK.

The application detects the images at tower locations and removes all other images from the 
image list.

3. Select Save list or Save list As commands from the Images pulldown menu in order to save 
the changes into an image list file.

Setting: Effect:
Camera Name of the camera for which to apply the image removal. 

Alternatively, images from Any camera can be removed.
Select Method for selecting images that remain in the image list:

• Best vertical - the most vertical image for each tower 
location.

• Best oblique - the most oblique image for each tower 
location.

• Dual sided oblique - two oblique images facing each tower 
from different directions.

Keep Defines the images that are kept in the image list:
• Best image only - only the best image for each tower 

location.
• Sequence of three - the best three consecutive images for 

each tower location.
Tower sizes Method of determining the tower size in order to decide which 

oblique image(s) see the tower best:
• From tower cells - the size of a tower is determined by a cell 

element.
• From wires - the size of a tower is determined by wire 

elements.
This is only active if Select is set to Best oblique or Dual sided 
oblique.

Levels Numbers of levels in the design file that contain the tower cells 
or wire elements for determining the tower sizes. This is only 
active if Select is set to Best oblique or Dual sided oblique.
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Delete / Missing file images

Delete / Missing file images command removes images from the active image list for which there 
are no raster files in the image directory of the camera that captured the images.

The image directory for a camera is stored in the mission definition. If an image file is not stored 
in the given directory, the File status attribute for the image in the image list is set to ‘-’. See New 
mission command for a description of how to define a mission and image directories for specific 
cameras.

To delete missing file images:

1. Select Delete / Missing file images command from the Images pulldown menu.

An alert dialog is displayed that asks for a confirmation of the delete action.

2. Click Yes to the dialog in order to remove the images from the image list.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save 

the changes into an image list file.
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Rectify pulldown menu
Commands from the Rectify pulldown menu are used to define color points and selection shapes, 
to lay out an array of tiles, to produce an orthophoto mosaic, and to create wall textures.

To: Choose menu command:
Define color points and selection shapes to improve the 
quality of orthos

Define color points

Draw an array of tiles for rectification Place tile array
Produce orthorectified images for selected tiles Rectify mosaic
Produce wall textures Rectify wall rasters



Page 253
16 Main Window Menu Commands
Define color points

Define color points command starts the color point mode. This includes opening of the Color 
points menu and additional processing steps depending on the specified color point mode:

• Ground ortho - creation of a ground model, preview of rectified images.
• Point cloud - on-the-fly extraction of color values for each point, display of the point cloud.

The Color points menu allows you to create color points and to define different types of 
correction polygons that improve the quality of the final ortho mosaic or a colored point cloud.

Color points for the rectification of images or orthophoto production require a ground model. 
Therefore, the corresponding color point mode is only available, if ground points are loaded into 
TerraPhoto.

Color points for point clouds require a TerraScan project that manages the point cloud and a point 
cloud format that is able to store color values, image numbers, and normal vectors/dimensions for 
each point. The storage of all these attributes is only possible in TerraScan Fast binary format. 
See TerraScan User’s Guide for more information about projects, point cloud formats and 
attributes.

The concept of color points and commands of the Color points menu are described in detail in 
Chapter Color Points and Selection Shapes on page 124.

To start the color point mode for (ortho) rectification:

1. Select Define color points from the Rectify pulldown menu.

This opens the Color point setting dialog:

2. Select Ground ortho in the Mode list.
3. Define settings and click OK.

This starts the color point mode.

Setting: Effect:
Rectification pixel Intended pixel size of the final orthophoto mosaic.
Computation Pixel size scale factor for color point computation. Color points 

and selection shapes do not need to be computed at the full 
resolution of the final orthophoto. It is recommended to use a 
factor of 2 or 3 in order to make computation processes faster.

Max ground triangle Maximum triangle length in the ground model.
Bounding polygons If on, the area available for color points is limited by the 

polygon(s) drawn on the given MicroStation level. The list 
contains all levels with elements in the design file.
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To start the color point mode for point clouds:

1. Select Define color points from the Rectify pulldown menu.

This opens the Color point setting dialog:

2. Select Point cloud in the Mode list.
3. Define settings and click OK.

This starts the color point mode.

View update Method of updating the view display after modifications to color 
points and selection shapes:
• On command - the display must be updated manually.
• Automatic - the display is updated automatically after each 

modification.
Use object shapes If on, object shapes on the given levels are used to create a true 

orthophoto preview.
Levels Number(s) of MicroStation design file levels that contain 3D 

objects for true orthophotos. Separate several levels by comma. 
This is only active if Use object shapes is switched on.

Edge buffer Distance from the edge of a 3D object within which object pixels 
are not rectified on the ground. The prevents, for example, roof 
pixels to be rectified on the ground next to buildings. This is only 
active if Use object shapes is switched on.

Setting: Effect:
Pixel size Approximate pixel size of raw images. Determines the size of a 

color point.
Use classes Point classes used for color point creation. Exclude classes with 

non-planar objects, such as poles, wires, etc.
Opens the Select classes dialog which contains the list of active 
classes in TerraScan. You can select multiple source classes 
from the list that are then used in the Use classes field.

Setting: Effect:
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Use only planar points If on, only points with dimension attribute Planar are used for 
color point creation.

View update Method of updating the view display after modifications to color 
points and selection shapes:
• On command - the display must be updated manually.
• Automatic - the display is updated automatically after each 

modification.
To classes Point classes for which color values are extracted on-the-fly for 

displaying points in the color point mode.
Opens the Select classes dialog which contains the list of active 
classes in TerraScan. You can select multiple source classes 
from the list that are then used in the To classes field.

Max distance Maximum distance between a raw image and a laser point. 
Images outside that distance are not considered for color 
extraction.

Use depth maps If on, depth maps files are included in the color extraction 
process.

Favor better quality 
images

If on, the quality attribute stored for raw images in an image list 
is considered in the color extraction process.

Favor cameras by class If on, the settings in the TerraPhoto mission file related to 
favouring cameras for coloring points are considered in the color 
extraction process.

Display classes Point classes that are displayed in color point mode.
Opens the Select classes dialog which contains the list of active 
classes in TerraScan. You can select multiple source classes 
from the list that are then used in the Display classes field.

Setting: Effect:
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Place tile array
Not Lite

Place tile array command places an array of tile rectangles which can be used as orthophoto 
boundaries. The area covered by the tiles can be defined by laser points loaded in TerraScan, the 
footprints of the active image list, or selected shapes.

Placing a tile array only works if a mission, a ground model, and an image list are loaded into 
TerraPhoto.

The size of the tiles is defined in pixels. Width and height of a tile can be constant (all tiles have 
the same size) or variable (tiles are minimized at coverage area boundaries). The figures below the 
command description illustrate different settings for array type, tile width and height.

To place an array of tile rectangles:

1. Select Place tile array command from the Rectify pulldown menu.

This opens the Place Tile Array dialog:

2. Define settings and click OK.

This places an array of tile rectangles on the active level using the active symbology settings 
in MicroStation.

Setting: Effect:

Coverage from Source from which to determine the covered area: Image 
footprints, Laser points, or Selected shapes.

Array type

Tile pattern to construct:
• Regular grid - regular tile pattern. The positioning is organized 

as multiple of the nominal tile size.
• X axis filling - tiles are extended horizontally.
• Y axis filling - tiles are extended vertically.

Tile width

Determines the tile width:
• Constant - all tiles have a constant width.
• Minimized by coverage - the width is minimized to the 

coverage area.



Page 257
16 Main Window Menu Commands
The Place Tile Array dialog can also be opened by using the Place Tile Array tool. 

Tile height

Determines the tile height:
• Constant - all tiles have a constant height.
• Minimized by coverage - the height is minimized to the 

coverage area.

Require Percentage of tile size that image footprints, laser data, or selected 
shapes must cover for the tile to be placed.

Inside fence only
If on, tiles are placed to cover fence contents only. This requires 
the placement of a MicroStation fence before the command is 
started.

Pixel size Intended pixel size of the orthophotos.
Tile width Width of a nominal tile in pixels.
Tile height Height of a nominal tile in pixels.

Tile numbering

Order for placing text elements inside tiles:
• None - no text elements are created.
• North to south - increasing numbering from north to south and 

east to west.
• South to north - increasing numbering from south to north and 

east to west.
• Along element - incresing numbering in the direction of a 

selected linear element.

Prefix Text that is included in the text elements before the numbering. 
This is only active if Tile numbering is not set to None.

First number Number of the first tile and amount of digits used in the text 
elements. This is only active if Tile numbering is not set to None.

Setting: Effect:
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Regular grid 2000 x 2000 pixels with constant (red) 
and minimized (yellow) width and height.

Regular grid 2000 x 3000 pixels with constant (red) 
and minimized (yellow) width and height.

X axis filling with tile height 2000 pixels (yellow) Y axis filling with tile width 2000 pixels (yellow)
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Rectify mosaic
Not Lite

Rectify mosaic command starts the production of an orthophoto mosaic.

Various rectification settings control the quality and the speed of the rectification process. 
TerraPhoto can produce lower quality ortho photos very fast. In contrast, if you select the highest 
quality options, the application uses a more complex process which takes a longer time. The 
different settings are illustrated in Chapter Orthophoto Production on page 162.

The process requires the selection of rectangular shape elements prior to starting the command. 
The rectangular shapes specify the tiles of the resulting orthophoto mosaic. They are preferably 
created with Place tile array command or Place Tile Array tool in TerraPhoto, but any 
MicroStation tool the produces rectangular shapes can be used as well.

To create an ortho photo mosaic:

1. Use MicroStation Selection tool in order to select tile shapes and (optional) text elements 
for naming the tiles.

2. Select Rectify mosaic command from the Rectify pulldown menu.

This opens the Rectify selected tiles dialog:

3. Define settings and click OK.

This starts the rectification process. The software produces one orthophoto for each selected 
tile.

Setting: Effect:
Use images Raw images to use: All images or Selected.
Attach Defines how to display the produced ortho images:

• Do not attach - no display.
• As TerraPhoto references - attach and display as reference 

files in TerraPhoto.
• As MicroStation references - attach and display as 

MicroStation raster references (not MicroStation V8i).
Pixel size Pixel size of the orthophotos. This should be the same or a 

multiple of the pixel size used when creating the tiles.
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Tile naming Tile naming method. In addition to user-defined tile naming 
schemes, you can select from:
• Automatic numbering - application assigns increasing 

numbers to tiles in selection order.
• Selected names - a selected text element inside each tile is 

used.
• Selected numbers - a selected numerical text element inside 

each tile is used.
User-defined tile naming schemes are defined in Tile naming 
schemes of TerraPhoto Settings.

Prefix Text that is included in the tile names before the numbering or 
the selected text elements.

First tile Number of the first selected tile. This is only active if Tile 
naming is set to Automatic numbering.

Ratio Compression ratio for ECW or JPEG2000 files.
Datum Datum information that is written in the header of ECW and 

JPEG2000 files. Commonly used datum names can be selected 
by using the Select button.

Projection Projection information that is written in the header of ECW and 
JPEG2000 files. Commonly used projection names can be 
selected by using the Select button.

Color depth Defines how color values are stored in GeoTIFF files: 8 bit, 3*8 
bit, 3*16 bit, n*8 bit, n*16 bit where n is the number of 
channels in the created orthophoto.

Create TFW file If on, external georeference files are created for GeoTIFF files. 
The files have the extension .TFW.

Coord system Coordinate system information that is written in the header of 
GeoTIFF files. Commonly used coordinate system names and 
numbers can be selected by using the >> button.

Format Raster file format to produce: ECW compressed, GeoTIFF, or 
JPEG2000.

Background R, G, B RGB color values for locations outside the image area.
Search points Margin around each tile for searching ground model points.
Laser points Memory handling of ground model points:

• Keep in memory - keep all ground model points in memory.
• Save temporarily - save laser points temporarily, load only 

needed points for each tile and reload all points at the end of 
the process.

• Abandon - free laser point memory, load only needed points 
for each tile but do not reload points at the end of the process.

Cache Image cache increase in megabytes for the rectification task. 
This is only active if Laser points is not set to Keep in memory.

Sample pixel color If on, the pixel color for the orthophoto is computed by sampling 
a circular area of the raw image.

Use surface objects If on, true orthophotos are produced using shapes from given 
Levels in addition to the rectification surface.

Fill object gaps If on, small gaps Up to the given amount of pixels next to surface 
objects in true orthophotos are filled. This is only active if Use 
surface objects is switched on.

Edge buffer Distance from the edge of a 3D object within which object pixels 
are not rectified on the ground. The prevents, for example, roof 
pixels to be rectified on the ground next to buildings. This is only 
active if Use surface objects is switched on.

Setting: Effect:
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Use color points If on, color points from the selected file are used to balance 
brightness and color differences between images.

Use breaklines If on, breaklines from the given Levels are add to the ground 
model and thus, included in the rectification process.

Use boundaries If on, polygons from the given Levels are used to limit the area 
that is filled with raw image information. Pixels outside the 
polygons are filled with the given Background RGB color.

Use selection shapes If on, selection shapes stored in the active design file are used in 
the rectification process.

Draw text If on, a text is burned into each ortho photo. This can be used, for 
example, to at a watermark to all orthophotos. The text as well as 
size, color, transparency, and position of the text can be set by 
using the Define button.

Setting: Effect:
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Rectify wall rasters
Not Lite

Rectify wall rasters command starts the production of wall texture files. Wall textures can be 
created from oblique images from an airborne system or from side-looking images from a ground-
based mobile system. The textures are created as raster files which are used when a view is 
rendered with Display Rendered View tool in TerraPhoto. In addition, MicroStation material table 
and palette files can be created in order to use the wall textures for MicroStation rendering.

The process requires the selection of 3D building vector models prior to starting the command. 
The vector models can been created, for example, with TerraScan tools for building vectorization.

The software decides what image to use for a wall polygon based on the viewing direction and 
percentage of wall area seen by the image. Depth maps created in TerraPhoto can support the 
creation of wall textures. See Compute depth maps for more information about depth maps.

To create wall textures:

1. Use MicroStation Selection tool in order to select 3D vector models of buildings.
2. Select Rectify wall rasters command from the Rectify pulldown menu.

This opens the Rectify wall rasters dialog:

3. Define settings and click OK.

This starts the rectification process. The software produces raster file(s) for each selected 
wall polygon.

4. Save the design file and the design file settings in order to save the references to the wall 
raster files.

Setting: Effect:
Use images Raw images to use: All images or Selected. Alternatively, the 

name of one camera can be selected from which to use the 
images.
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Each polygon from Defines the amount of images that are used for creating a texture 
for a wall polygon:
• Only one image - the best image is used.
• Upto two|three|four best - up to two|three|four best images 

are used.
• Any number of images - any amount of images can be used.

Minimum area Smallest wall area for which the software creates a texture file.
Require Minimum percentage of a wall polygon that an image must cover 

in order to be considered for texture creation.
Pixel size Pixel size of the wall textures.
Format Raster file format to produce: BMP, JPG, or TIFF.
Depth maps Method of using depth maps in the rectification process:

• Do not use - depth maps are not used.
• Image selection - the best image(s) are used even if there are 

obstructing objects in the image(s).
• Selection and obstruction - an image is not used if there are 

obstructing objects in the image. This may result in blank 
areas for walls.

Tolerance Distance from a wall in depth maps, within which objects in front 
of the wall are ignored. This is only active if Depth maps are 
used.

Definition file Defines how the software creates material table and palette files:
• Create material and palette - both file types are created.
• Add to existing palette - the new textures are added to an 

existing palette file.
Material Directory and name of the material table file.
Palette Directory and name of the palette table file.
Open materials for 
MicroStation

If on, the material table and palette files are opened in 
MicroStation and thus, are available for MicroStation rendering.

Raster directory Directory for storing the wall texture files on a hard disk.
Name prefix Text to add before an increasing number for naming the wall 

texture file.
Modify element color If on, the color of the wall shape in the 3D model is changed to 

the average color of the texture pixels.

Setting: Effect:
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View pulldown menu
Commands from the View pulldown menu are used to control the appearance of the TPhoto Main 
window, to sort images in the image list, to create or remove camera views, and to fit a view to 
show the entire area covered by images.

To: Choose menu command:
Switch main window to minimal size Minimal dialog
Switch main window to small size Small dialog
Switch main window to large size Large dialog
Set columns which are visible in the main window Fields
Sort the images in the image list Sort images
Setup a perspective view using an image from the list Create camera view
Stop displaying a perspective image in a view Remove camera view
Fit a view to show area covered by all images Fit view
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Minimal dialog

Minimal dialog command changes the TPhoto Main window to a minimal size which consists 
of a title bar and pulldown menus only.

Small dialog

Small dialog command changes the TPhoto Main window to a small size which consists of a title 
bar, the pulldown menus, and a small size list displaying the active image list.

Large dialog

Large dialog command changes the TPhoto Main window to a large size which consist of a title 
bar, the pulldown menus, and a large size list displaying the active image list.
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Fields

Fields command lets you select which attributes are displayed for each image in the image list. 
The command is only active if the TPhoto Main window size is set to a Small dialog or Large 
dialog.

To select visible fields:

1. Select Fields command from the View pulldown menu.

This opens the View image fields dialog:

2. Select fields and click OK.

Field: Description:
File number Internal image number.
File name Name of the image file.
Camera name Name of the camera that captured the image.
Active status Image status for ortho rectification.
Tie status Image status for placing tie points.
Image quality Number that indicates the quality of the image.
Group Group number of the image.
Time stamp Time stamp of the camera position when the image was captured.
Easting Easting coordinate of the image position (focal point).
Northing Northing coordinate of the image position (focal point).
Elevation Elevation coordinate of the image position (focal point).
Heading Heading angle of the image orientation. Given in degree.
Roll Roll angle of the image orientation. Given in degree.
Pitch Pitch angle of the image orientation. Given in degree.
Accuracy xyz Accuracy estimate of the image xyz positioning.
Pixel size Size of a raw image pixel on a rectification surface.
File status Indicates whether the image file is available in the image directory on the 

hard disk or not.
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Sort images

Sort images command can be used to sort the images of the active image list according to two 
attributes.

To sort the images of the image list:

1. Select Sort images command from the View pulldown menu.

The Sort images dialog opens:

2. Select a Primary key and Secondary key for sorting the images.
3. Click OK.

The images are sorted according to the selected attributes.

4. Save the image list using Save list or Save list As commands from the Images pulldown 
menu in order to save the changes into an image list file.

Setting: Effect:
Primary key Attribute used first for sorting the images:

• Camera - camera name. The order is defined by the order of cameras 
in the mission definition.

• Time stamp - increasing time stamps.
• Number - increasing internal image numbers.
• Angle from vertical - increasing angle off from vertical.
• Pixel size - increasing pixel size of the images.
• Tie point value* - increasing amount of tie points in the image.
• Tie point coverage* - increasing coverage of the image by tie points.
• Tie point mismatch* - increasing average mismatch of the image 

calculated from tie points.
• Tie status - image status for tie point placement. Approved images are 

at the end of the image list.
• Quality - increasing quality number.

* Attributes are only available for sorting if tie points are loaded into 
TerraPhoto.

Secondary key Attribute used second for sorting the images:
• See Primary key attributes.
• None - no secondary key is used for sorting.
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Create camera view

Create camera view command sets up a window as a perspective view displaying the world as 
seen by a camera when recording one of the raw images. In addition to displaying the image file, 
a camera view can display laser points and vector elements projected into the same perspective 
view.

MicroStation views can act as orthographic or as perspective views. An orthographic view is like 
a map. There is no specific viewer location and equal size objects are drawn with the same size on 
the screen. A perspective view has a specific viewer or camera location. Objects close to the 
viewer occupy a larger space on the screen than distant objects. Perspective views correspond to 
the way we see the world.

To create a camera view:

1. Select Create camera view command from the View pulldown menu.

The Create Camera View dialog opens:

2. Select the target view in the View field.

If the mouse pointer is moved inside a view, the application displays the footprint of the 
closest image.

3. Identify a location with a data click to select which image to use.

This sets the Camera attribute on in the view. The camera location is set to the xyz position 
of the camera when the selected image was captured. The selected image is displayed in the 
view as well as laser data and vector elements, if available.

The display of laser data can be managed using the Display dialog of TerraScan. The display 
of vector elements is organized in the Level Display dialog of MicroStation.

Setting: Effect:
View MicroStation view for displaying the camera view.
Camera Name of the camera from which to display the images. 

Alternatively, images from Any camera can be selected for 
display.

Select by Defines the selection method of images for display:
• Camera xy - the image with the camera xy position closest to 

the mouse pointer is selected.
• Target xy - the image with the target xy position closest to 

the mouse pointer is selected.
• Target xyz - the image with the target xyz position closest to 

the mouse pointer is selected.
Image Number of the image selected for display. The selection list 

contains all images of the active image list.
Fix for lens distortion If on, the image is displayed with applied lens distortion 

correction. The lens distortion is defined in the TerraPhoto 
camera dialog dialog.
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Camera views are excellent for comparing laser data and/or vector elements to images. You can 
compare any objects regardless of the elevation - you are not limited to ground objects as with 
rectified images. The figure below illustrates a camera view of an oblique image overlayed with 
laser data (points on roofs and high vegetation) and 3D vector models of buildings.
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Remove camera view

Remove camera view command deactivates a camera view that has been set up earlier.

To deactivate a camera view:

1. Select Remove camera view command from the View pulldown menu.
2. Place a data click inside the view.

This deactivates the camera view display by switching the Camera attribute off for that 
view. You can continue with step 2 for other views.

Fit view

Fit view command rotates a view to top rotation and fits it to display the area covered by all 
images of the active image list.

To fit a view to display all raw images:

1. Select Fit view command from the View pulldown menu.
2. Place a data click inside the view.

This rotates the view to top rotation, fits the view to all images, and redraws the view. You 
can continue with step 2 for other views.
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Utility pulldown menu
Commands from the Utility pulldown menu are used to start various processing steps for images 
of the active image list.

To: Choose menu command:
Draw image footprints as shape elements Draw footprints
Draw image coverage as pyramids extending to camera Draw projections
Analyze brightness distribution of images Analyze images
Adjust image colors Adjust images
Assign a group number to images Assign groups
Assign trajectory numbers to images Deduce line numbers
Create thumbnail images for different resolution ratios Create thumbnails
Create depth maps Compute depth maps
Create shadow maps Compute shadow maps
Create text files that store orientation values for images Export orientation
Copy needed images from central storage Transfer images
Rectify raw images Rectify images
Adjust image angles and focal length visually Adjust image angles
View raw images View images
Open TerraPhoto Settings dialog Settings



Page 272
16 Main Window Menu Commands
Draw footprints

Draw footprints command draws the footprints of images as shape elements into the design file. 
A footprint shape shows the area covered by the image on the rectification surface, i.e. usually the 
ground.

The tool may be useful for the following tasks:

• To locate places where there is redundant imagery caused by multiple overlapping flightlines.
• To locate gaps between images. This can be easily seen if you change the created footprint 

shapes to be filled with a color.
• To identify images that do not have enough tie points. The tie point value that is required for a 

well-defined image is set in Tie points / Display of the TerraPhoto Settings.
• To locate images that belong to the same group.

To draw image footprints:

1. Select Draw footprints command from the Utility pulldown menu.

This opens the Draw footprints dialog:

2. Select settings and click OK.

This draws the footprint shapes into the design file using active level and symbology settings.

Setting: Effect:
Camera Name of the camera of which images are drawn. Alternatively, image 

footprints from Any camera can be drawn.
Draw images Defines which image footprints are drawn:

• All - all images.
• Selected - images selected in the active image list.
• Active - images with rectification status Rectify.
• Inactive - images with rectification status No Rect.

Tie value Defines which image footprints are drawn related to the tie point value 
of the images:
• Any - all images.
• Well defined - draws images with a tie point value equal or larger 

than the value defined in TerraPhoto Settings.
• Under defined - draws images with a tie point value smaller than 

the value defined in TerraPhoto Settings.
The options Well defined and Under defined are only active if tie 
points are loaded in TerraPhoto.
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Tie status Defines which image footprints are drawn related to the tie point 
status of the images:
• Any - all images.
• Check - draws images with tie point status ‘Check’.
• Approve - draws images with tie point status ‘Approved’.

The options Check and Approve are only active if tie points are 
loaded in TerraPhoto.

Projection Accuracy of footprint shape to draw:
• Approximate - uses ground elevation only at camera xy location. 

The shape is drawn assuming that the ground is flat.
• Accurate - computes ground elevation at several locations along 

image edges and produces a more accurate shape.
Color Color of the footprint shapes:

• Active color - images inside the rectification surface are drawn 
with the active color set in MicroStation, images outside the 
rectification surface are drawn with red (or blue) color.

• Group color - images are drawn using different colors according 
to assigned group numbers. The group number determines the 
color by using the same color number from the active color table 
in MicroStation.

• Mismatch distance - images are drawn according to the mismatch 
computed from tie points. This is only active if tie points are 
loaded in TerraPhoto.

Label Text element that is drawn for each footprint shape:
• None - no label is drawn.
• Image number - the unique image number.
• Full file name - the full name of the image.

Setting: Effect:
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Draw projections

Draw projections command draws the footprints of all images as well as line elements 
connecting the image corners on the ground with the camera position. This produces three-
dimensional pyramids that illustrate the image projections.

Analyze images
Not Lite

Analyze images command produces a report of color distribution of the images in the active 
image list. The report contains information about the average red, green, blue, intensity, 
saturation, and contrast values. The values are computed for each image and averaged for images 
of one camera or time intervals. 

The values from the report may give some idea for color corrections described in Chapter Color 
corrections on page 67.

To analyze images:

1. (Optional) Select images in the image list or draw a fence to identify images which you 
want to analyze.

2. Select Analyze images command from the Utility pulldown menu.

This opens the Analyze images dialog:

3. Define settings and click OK.

The application opens a report window which shows the values of the analysis. You can save 
the report as text file or print it directly from the File pulldown menu of the report window. 
The size of the report window can be adjusted using commands from the View pulldown 
menu.

Setting: Effect:
Analyze Images that are analyzed:

• All images - all images from the active image list.
• Selected images - images selected in the active image list.
• Inside fence - images inside a fence.
• Outside fence - images outside a fence.

Averages Calculation of average values:
• For each camera - averages values of images per camera.
• For each time interval - averages values of images per time 

intervals. This is normally used to get averages for different flight 
paths.

Time gap Defines the start of a new time interval for averaging analysis values. 
If the time difference between consecutive images is larger than the 
given value, a new time interval starts. This is only active if Averages 
is set to For each time interval.
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Adjust images
Not Lite

Adjust images command modifies images of the active image list by fixing the size, the lens 
distortion, or by adjusting brightness or coloring. The modifications effect the original image files.

To adjust images:

1. Select Adjust images command from the Utility pulldown menu.

This opens the Adjust images dialog:

2. Define settings and click OK.

This processes the images and overwrites the raw image files with the modified versions.

Setting: Effect:
Adjust Images effected by adjustments:

• All - all images of the active image list.
• Selected - images selected in the active image list.
• <camera name> - images captured by the selected camera.

Fix size to match camera If on, the size of raw images is fixed to the image width and 
height values defined for the selected camera.

Create tiles If on, the images are converted into tiled TIFFs. The tile size is 
defined by the Size value.

Lens distortion If on, pixels are moved according to lens distortion values.
Fill missing CCD line Not yet implemented.
Overall to average of images If on, the average brightness of images is computed and each 

individual image is adjusted towards the average.
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It is recommended to avoid modifications of the original raw image whenever possible. Therefore, 
the command should be used only in exceptional cases. The lens distortion is normally computed 
on-the-fly by the application based on the camera values. Brightness and color corrections should 
be applied by using the Define color corrections command.

Distribution within one image If on, the brightness of different parts of each raw image is 
computed and adjusted towards the average brightness. The 
percentage value determines how much of an individual image 
is used for computing the brightness.

RGB brightness If on, red, green, and blue color components are adjusted 
separately using the given values.

Contrast If on, the contrast is adjusted by the given percentage value.

Setting: Effect:
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Assign groups
Not Lite

Assign groups command assigns a group number to images based on the sun direction. The group 
number is stored as attribute for each image in the image list.

The computation of the sun angle requires that the image time stamps are provided in GPS 
standard time in order to enable the software to derive the date and time of image capture. In 
addition, the correct projection system must be defined in the mission definition in order to 
provide the geographical location.

To assign a group number to images:

1. Select Assign groups command from the Utility pulldown menu.

This opens the Assign groups dialog:

2. Define a Sun tolerance value and click OK.

The software assigns group numbers to all images of the active image list. The group number 
increases if the sun angle in two consecutive images changes more than the given tolerance 
value.

3. Save the image list using Save list or Save list As commands from the Images pulldown 
menu in order to save the changes into an image list file.
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Deduce line numbers
Not Lite

Deduce line numbers command assigns line numbers from trajectories to images. The 
assignment is based on the time stamp stored for each image and the time stamps stored for 
trajectory positions.

The command requires that a trajectory are splitted into separate lines. This is the normal case for 
scanner trajectories in TerraScan. Therefore, it is recommended to use TerraScan trajectories for 
this command in TerraPhoto.

Line numbers for images are required for placing selection shapes in point clouds. They allow to 
select the image to use inside a selection shape by line number. See Place selection command for 
point clouds for more information.

To deduce line numbers for images:

1. Use Manage Camera Trajectories command in order to set a TerraScan trajectory 
directory as active directory.

2. Select Deduce line numbers command from the Utility pulldown menu.

This assigns the trajectory number as line number attribute to the images. An information 
dialog shows the number of effected images.
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Create thumbnails
Not Lite

Create thumbnails command starts the creation of thumbnails for defined resolution ratios. The 
tool creates GeoTiffs which are stored in the /TEMP directory of the mission. The default file 
name is ‘thumb<ratio>_<image name>.tif’.

Thumbnails can speed up the image display for different TerraPhoto processes:

• Define color corrections display
• Active full view in tie point mode
• Define color points display

If the size of the raw images exceeds 100 MB, tiled TIFFs can be used for many operations. 
TerraPhoto caches tiles to reduce memory requirements and speed up tasks because only parts of 
images need to be read. Raw images can be converted into tiled TIFFs in the same process that 
creates thumbnails.

To create thumbnails and/or tiled TIFFs:

1. Select Create thumbnails command from the Utility pulldown menu.

This opens the Create thumbnails dialog:

2. Define settings and click OK.

This starts the thumbnail creation. Depending on the amount of images and chosen ratios, 
this may take a while. A progress bar shows the progress of the process.

Setting: Effect:
Camera Name of the camera of which thumbnails are created. Alternatively, 

thumbnails are created for images of Any camera.
Thumbnail ratios Selection of resolution ratios for which thumbnails are created:

• 1:2 - 50% pixel size of a raw image.
• 1:3 - 33% pixel size of a raw image.
• 1:4 - 25% pixel size of a raw image.
• ...
• 1:50 - 2% pixel size of a raw image.

Convert to tiled TIFF If on, raw images are converted into tiled TIFFs. This overwrites the 
original images in the mission’s image directories.

Tile size Size of the tiles for converted images in pixels.
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Compute depth maps
Not Lite

Compute depth maps command creates depth raster files for each image of the active image list. 
The pixels in the depth maps encode the distance between the camera position and the closest 
object represented by laser points or 3D vector elements.

Depth maps are stored in the /TEMP directory of the mission. The files have the extension .DPM. 
They can be used by several processes:

• deriving the approximate location of tie points if a tie point is entered in one image
• extraction of colors from images to laser points
• production of wall textures

To compute depth maps:

1. Select Compute depth maps command from the Utility pulldown menu.

The Compute depth maps dialog opens:

2. Define settings and click OK.

This starts the computation process. Depending on the amount of images and selected 
settings, the process may take some time. A progress bar shows the progress of the process.

Setting: Effect:
Compute Images for which depth maps are created:

• All - all images of the active image list.
• Selected - images selected in the active image list.
• <camera name> - images captured by the selected camera.

Resolution Pixel size of the depth maps related to the resolution of the raw 
images:
• 1x1 - one pixel in a depth map equals one pixel in a raw image.
• 2x2 - one pixel in a depth map equals the area of two times two 

pixels in the raw image.
• ...
• 20x20 - one pixel in a depth map equals the area of 20x20 pixels 

in the raw image.
Min depth Minimum distance between the camera position and an object that is 

included in the depth maps.
Max depth Maximum distance between the camera position and an object that is 

included in the depth maps.
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Depth maps can be displayed using the View image window in TerraPhoto. The window is 
opened by the View images button from the TPhoto Main window or the View images command 
from the Utility pulldown menu.

Depth resolution Accuracy of the depth value computation. Small values (about 1 mm 
for mobile data, 1 cm for airborne data) are required for collecting tie 
points for positional improvement. Bigger values (about 0.1 m to 1 m 
can be used for the creation of wall textures and extraction of color 
values.

Use polygons Determines whether selected 3D polygons are included in the depth 
maps computation of not. Selected is only active if the polygons are 
selected in MicroStation design file.

Use points Determines the laser data source for computing depth maps:
• Do not use - no laser points are used.
• Loaded points - points that are loaded into TerraScan are used. 

This is only active if points are loaded in TerraScan.
• Project points - points of the active project in TerraScan are used. 

This is only active if a project is loaded in TerraScan.
Use Defines how to use the laser points related to time stamps:

• All points - all points are used.
• Close in time only - only points which are collected within the 

given time difference from an image are used.
This is only active if the time stamps of the laser data match the time 
stamps of the images.

Within Time difference between a laser point and an image that determines 
whether the point is used for depth map computation or not. This is 
only active if Use is set to Close in time only.

User every Defines whether all laser points are used or only every xth point. This 
is only active if Use points is not set to Do not use.

Classes Defines which points are used related to classes. Use the >> button in 
order to open the Select classes dialog which lets you select the 
classes. This is only active if Use points is not set to Do not use.

Setting: Effect:



Page 282
16 Main Window Menu Commands
Compute shadow maps
Not Lite

Compute shadow maps command creates raster files for each image of the active image list. The 
pixels in the shadow map files encode shadow areas close to high objects, such as high vegetation 
or buildings. The objects are represented by laser points and (optional) 3D vector elements.

Shadow maps are stored as TIFF files in the /TEMP directory of the mission. They are used for 
automatic tie point and color point placement.

To compute shadow maps:

1. Select Compute shadow maps command from the Utility pulldown menu.

The Compute shadow maps dialog opens:

2. Define settings and click OK.

This starts the computation process. Depending on the amount of images and selected 
settings, the process may take some time. A progress bar shows the progress of the process.

Setting: Effect:
Compute Images for which shadow maps are created:

• All - all images of the active image list.
• Selected - images selected in the active image list.
• <camera name> - images captured by the selected camera.

Use points Determines the laser data source for computing shadow maps:
• Loaded points - points that are loaded into TerraScan are used. 

This is only active if points are loaded in TerraScan.
• Project points - points of the active project in TerraScan are used. 

This is only active if a project is loaded in TerraScan.
Classes Defines which points are used related to classes. Use the >> button in 

order to open the Select classes dialog which lets you select the 
classes.

Minimum height Minimum height of objects that are considered in shadow maps.
Use surface objects If on, 3D vector elements on the given design file Levels are included 

in the shadow map computation.
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Export orientation
Not Lite

Export orientation command writes the exterior orientation for images of the active image list 
into a text file. The format of the text file can be defined in Exterior orientation formats of the 
TerraPhoto Settings. The output file may contain, for example, the image name, xyz position, as 
well as orientation angles defined as Heading Roll Pitch or Omega Phi Kappa values.

To export an orientation text file from the image list:

1. Select Export orientation command from the Utility pulldown menu.

The Export Orientation dialog opens:

2. Define settings and click OK.

This opens the Exterior orientation file dialog, a standard dialog for saving files.

3. Define a location and name for saving the text file and click OK.

This creates the text file.

Setting: Effect:
Camera Name of a camera. The output file contains only images captured by 

the selected camera. Alternatively, images from All cameras can be 
included.

Output format Name of the exterior orientation format as defined in the TerraPhoto 
Settings. The format is used for the output file.

Output angles Format of the orientation angles:
• Radians - 2*pi - radian values normalized between -pi and +pi.
• Degrees - 360 - degree values normalized between -180 and +180.
• Gons - 400 - gon values normalized between -200 and +200.

Rotation order Order of orientation angles required for computing the correct rotation 
matrix.The most common order is Heading pitch roll.
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Transfer images
Not Lite

Transfer images command copies missing images from specified source directories into the 
image directory that is defined in the mission file. Only images that are contained in the active 
image list are effected by the process. The images of one camera can be transfered in one process.

The command is useful, for example, if raw images for an entire project are stored on a central 
server and you want to copy the needed images to your own hard disk for processing a smaller part 
of the project. You may use the following workflow:

• Store all raw images on a server.
• Create an image list which contains all images.
• Draw a fence around a smaller part you are working on, delete images outside fence, and save 

the image list into a new file.
• Use Transfer images command to copy needed images from the server to your own hard disk 

for faster access.

To transfer images:

1. Select Transfer images command from the Utility pulldown menu.

This opens the Transfer Images dialog:

2. Select a camera in the Camera list. Only images captured by this camera are transfered.

Image directory line displays the directory which is specified as the image directory for the 
selected camera in the mission definition. This is the target directory into which the images 
are copied.

The text below the directory line shows how many raw images are already in the target 
directory.

3. Click Add to browse for a source directory from where to copy images.

This opens a standard dialog for selecting a folder.

You may continue to step 3 if there are multiple source directories.

4. Click Execute to copy the images.

The image files are copied to the target directory. After the process has finished, you should 
check the text below the Image directory line to make sure that all needed images are 
copied.
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Rectify images
Not Lite

Rectify images command creates rectified images from raw images in the image list. There is no 
mosaic step which means that for each raw image a new georeferenced image is produced.

The process requires a rectification surface which is usually provided by a ground model. 3D 
surface objects and breaklines stored in the design file can be included in the rectification process.

To rectify images:

1. Select Rectify images command from the Utility pulldown menu.

This opens the Rectify images dialog:

2. Define settings and click OK.

This starts the image rectification process. An information window shows the number of 
rectified images out of the number of all images. The rectified images are stored in the 
Rectified images directory that is defined in the mission definition.

Setting: Effect:
Rectify Raw images to use: All images, Selected or images captured by a 

given <camera>.
Output naming Naming method of the output files: Raw file name or rec<image 

number>.
Pixel size Pixel size of the ouput images.
Format Raster file format to produce: ECW compressed, GeoTIFF, or 

JPEG2000. The following settings depend on the selected format.
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Ratio Compression ratio for ECW or JPEG2000 files.
Datum Datum information that is written in the header of ECW and 

JPEG2000 files. Commonly used datum names can be selected by 
using the Select button.

Projection Projection information that is written in the header of ECW and 
JPEG2000 files. Commonly used projection names can be selected 
by using the Select button.

Color depth Defines how color values are stored in GeoTIFF files: 8 bit, 3*8 bit, 
or 16*8 bit.

Create TFW file If on, external georeference files are created for GeoTIFF files. The 
files have the extension .TFW.

Coord system Coordinate system information that is written in the header of 
GeoTIFF files. Commonly used coordinate system names and 
numbers can be selected by using the >> button.

Search points Margin around each image for searching ground model points.
Laser points Memory handling of ground model points:

• Keep in memory - keep all ground model points in memory.
• Save temporarily - save laser points temporarily, load only 

needed points for each image and reload all points in the end of the 
process.

• Abandon - free laser point memory, load only needed points for 
each image but do not reload points in the end.

Use surface objects If on, 3D shapes from the given design file Levels are used in addition 
to the ground model. This may result, for example, in roofs of high 
buildings being at the correct xy location in the rectified images.

Use breaklines If on, linear elements from the given design file Levels are added as 
breaklines to the ground model.

Use color points If on, color points from the given File are included in the rectification 
process.

Sample pixel color If on, the pixel color for a rectified image is computed by sampling a 
circular area from the raw image.

Fill object gaps If on, small gaps Upto the given size next to surface objects are filled.

Setting: Effect:
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Adjust image angles
Not Lite

Adjust image angles command can be used to test and modify the rotation angles and the focal 
length. The modifications are done on a step-by-step basis and can be checked in Camera Views.

The rotation is adjusted either related to the image or related to the camera. If the modification is 
applied to the image, the changes in heading, roll, and pitch effect the image list. Angle 
adjustments applied to the camera and focal length modifications effect the camera file.

The tool is useful, for example, for adjusting individual images more accurately to laser data or 
for finding approximate camera values for the orientation anlges and the focal length.

To adjust image angles and focal length:

1. Create a camera view using the Create camera view command. Set up the view display, for 
example, by loading laser points that can be used for comparing image positioning with 
laser data.

2. Select Adjust image angles command from the Utility pulldown menu.

The Adjust image angles dialog opens:

3. Select the View that is used as camera view.
4. Select whether to Apply the rotation adjustment to the Image are to the Camera.
5. Define a Step size for adjusting angles and/or the focal length.
6. Use the arrow buttons in the dialog in order to adjust heading, roll, and pitch.

AND/OR

7. Use the plus/minus buttons in the dialog in order to adjust the focal lenght.
8. Check the effect of the changes in the camera view.
9. If the rotation angles for an image have been adjusted, select Save list or Save list As 

commands from the Images pulldown menu in order to save the modifications to an image 
list file.

AND/OR

10. If the focal length and/or the rotation of the camera have been changed, save the camera file 
using the commands of Camera dialog which is opened by the Define Camera tool.
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View images

View images command opens a window for viewing raster images. The window has menu 
commands for opening raster files, for viewing an image at certain resolution levels, and for 
testing color, intensity, brightness, and contrast adjustments.

The View image button in the TPhoto Main window opens this same window and displays the 
image selected in the image list.

You can move to the previous image by selecting File / Previous image command or by using the 
<PageUp> key. You can move to the next image by selecting File / Next image command or by 
using the <PageDn> key.

View histogram
View histogram command can be used to test color, intensity, saturation, and contrast 
adjustments for the displayed image.

The values tested in the Image Histogram dialog are neither stored in the image list not do they 
modify the original image file. See Define color corrections command for correcting color values 
of images effectively.

To test histogram adjustments:

1. Select View histogram command from the File pulldown menu.

This opens the Image Histogram dialog:

To: Select menu command:
Open an image file or a depth map file File / Open
Open the previous image in the active image list File / Previous image
Open the next image in the active image list File / Next image
Test histogram, brightness, or contrast adjustments File / View histogram
Display an image at certain resolution levels:
• full resolution
• half of full resolution
• third of full resolution

...

Zoom / 1:1
Zoom / 1:2
Zoom / 1:3
...
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2. Type correction values for RGB and/or Intensity, Saturation, Contrast. The values are 
added to the current pixel values in the image.

3. Click Apply in order to see the effect of the changes in the image.



Page 290
16 Main Window Menu Commands
Settings

Settings command opens the TerraPhoto Settings dialog for managing user settings. It performs 
the same action as the Settings tool.
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Help pulldown menu
Commands from the Help pulldown menu are used to open this Users’ Guide and to display 
license information for TerraPhoto.

Help / Contents

Contents command launches Acrobat Reader for accessing this Users’ Guide in PDF format. It 
performs the same action as the Help On TerraPhoto tool.

To: Choose menu command:
Open the TerraModeler Users’ Guide Help / Contents
Display the license information dialog Help / About TerraPhoto
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17 Manage Trajectories
Trajectories are required for some processing steps in TerraPhoto. They provide positional and, 
usually, attitude information of the camera system for each point of time during the data collec-
tion.

Normally, the raw trajectory is produced by so-called post-processing software that combines the 
input of GPS and IMU sensors. The raw trajectory may be provided in a binary or ascii file format. 
TerraPhoto is able to import common binary formats of post-processing software as well as a 
number of ASCII formats. Additional text file input formats for trajectories can be defined in 
Trajectory formats of TerraPhoto Settings. All imported trajectories are converted into the 
TerraPhoto trajectory binary format (*.TRJ).

TerraPhoto trajectory files are fully compatible with TerraScan and vice versa. Therefore, trajec-
tories that are imported and/or processed in one of the applications, can be used in the other appli-
cation without any problems.

All commands related to trajectories is combined in the TerraPhoto Trajectories window which 
is opened by the Manage Camera Trajectories tool.

TerraPhoto Trajectories window
The Trajectories window contains pulldown menu commands for importing, modifying, and 
managing trajectory information.

The list in the window shows all trajectory files that are stored in the active trajectory folder. The 
active directory is shown in the title bar of the window.

To select a trajectory, click on the line in the list. Press the <Ctrl-key> to select several trajecto-
ries.

To show the location of a trajectory, select a line in the list. Click on the Show location button 
and move the mouse pointer into a view. This displays the selected trajectory. With a data click 
inside the view you can center the selected trajectory in the view.

To identify a trajectory, click on the Identify button and place a data click close to a trajectory in 
a view. This selects the corresponding line in the Trajectories window.
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File pulldown menu
Commands from the File pulldown menu are used to import trajectory information into 
TerraPhoto.

To: Use:
Set active trajectory folder Set directory
Import trajectory files Import files
Import trajectory files from a folder and its subfolders Import directory
Import separate text files from GPS and INS sensors Merge from GPS and INS
Import accuracy files for trajectories Import accuracy files
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Set directory

Set directory command is used to define the active trajectory directory. The software writes 
trajectory files into this folder during the import process. It loads TerraPhoto trajectory files from 
a folder if it is set as active directory and files do already exist. Usually, this is the first command 
you use when you start working with trajectories.

It is good practice to reserve a folder in your project directory structure for storing trajectories 
imported into TerraPhoto. In some cases, it might be advisable to save a new copy of TerraPhoto 
trajectories. Then, you would have multiple trajectory directories in a project and change the 
active directory whenever needed in order to access the correct set of trajectory files.

To set the active trajectory directory:

1. Select Set directory command from the File pulldown menu.

This opens the standard dialog for selecting a folder.

2. Select a folder and click OK.

This sets the active directory to the given folder. TerraPhoto scans the directory. If there are 
trajectory files in the folder, it reads the header information from each file into memory and 
displays them in the list.
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Import files

Import files command is used to import raw trajectories into TerraScan. During the import, trajec-
tory information is converted into TerraPhoto binary files (*.TRJ).

The input files must contain at least time-stamped position and, for most processing tasks, attitude 
information. The input files can be:

• text files in one of the implemented ASCII formats.
• binary files from Applanix or Riegl software.
• text files in a user-defined file format, see Trajectory formats.

During the import, the software assigns some attributes to the trajectories and can apply coordinate 
transformations and/or a time stamp format conversion. Most of the settings defined in the import 
process can be changed later for the converted trajectory files by using the Edit information com-
mand or commands from the Tools pulldown menu.

To import trajectories:

1. Select Import files command from the File pulldown menu.

This opens the Import trajectory files dialog, a standard dialog for opening files.

2. Select raw trajectory file(s) and click Done.

The Import trajectories dialog opens:

3. Define settings and click OK.

This imports the trajectory file(s) and stores them as TerraPhoto trajectory binary file(s) into 
the active trajectory directory. The name of a file is determined by the seconds values of the 
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first and last position in a trajectory file separated by an underline character..

Computing an image list based on trajectory information requires all trajectory positions. 
Therefore, Thin positions setting should be switched off if camera trajectories are imported.

Setting: Effect:
File format Format of the raw trajectory file. The software tries to detect it 

automatically. If a text file is imported, the list of formats 
contains implemented formats as well as formats defined in 
Trajectory formats of TerraPhoto Settings.

Attitude format Format of the INS file. This is only active if Merge from GPS 
and INS command is used to import trajectory information.

First number Number assigned to the first trajectory file. If more than one file 
is imported, the files are numbered incrementally.

Group Group number assigned to the trajectory file(s).
Quality Quality attribute assigned to the trajectory file(s).
WGS84 Transformation from latitude/longitude coordinates to another 

projection system. The list contains projection systems that are 
active in Coordinate transformations / Builtin projection 
systems, Coordinate transformations / US State Planes or 
defined in Coordinate transformations / User projection 
systems of TerraPhoto Settings.

Transform Coordinate system transformation applied to the trajectories. 
The list contains transformations that are defined in 
Coordinate transformations / Transformations of TerraPho-
to Settings.

Input time Format of the time stamps in the raw trajectory file(s): GPS 
seconds-of-week, GPS standard time, or Unix time.

Store time as Format of the time stamps in the converted trajectory file(s): 
GPS seconds-of-week or GPS standard time. If the format is 
different from the Input time format, time stamps are 
converted.

Survey date Date when the trajectory data was captured. The format is day/
month/year (dd/mm/yyyy). This is required for the conversion 
of time stamps from GPS seconds-of-week to GPS standard 
time and is only active if Input time and Store time as are set 
accordingly.

Input angles Format of angle values in the raw trajectory file(s): Degrees, 
Radians, or TopEye radians. This is usually set automatically 
for implemented input formats.

Adjust heading If on, the software applies a meridian convergence correction to 
heading values. The correction is based on the projection 
system set for WGS84 or the coordinate transformation set for 
Transform.

Thin positions If on, intermediate trajectory positions are skipped as long as 
the trajectory accuracy stays within the given tolerances.

Xyz tolerance Maximum allowed xyz difference caused by thinning. This is 
only active if Thin positions is switched on.

Angle tolerance Maximum allowed angular difference caused by thinning. This 
is only active if Thin positions is switched on.
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Import directory

Import directory command imports trajectory files into TerraPhoto. All files of the same format 
in a directory are imported. The import process itself works in the same way as described for the 
Import files command above.

To import all trajectory files in a directory:

1. Select Import directory command from the File pulldown menu.

This opens the Import directory dialog:

2. Define settings and click OK.

This opens the Import trajectories dialog. Follow the steps of Import files procedure in 
order to import the files.

Merge from GPS and INS

Merge from GPS and INS command creates a trajectory binary file for TerraPhoto from separate 
GPS and INS files. The GPS file contains time stamps and coordinates for the trajectory positions, 
while the INS file includes time stamps and orientation angle values for the same trajectory 
positions. The software combines the two input files using the time stamp.

The GPS and INS files are usually text files. The format of the files can be defined in Trajectory 
formats of TerraPhoto Settings.

To create a trajectory from GPS and INS files:

1. Select Merge from GPS and INS command from the File pulldown menu.

This opens the GPS positions files dialog, a standard dialog for opening files.

2. Open the file that contains the positional information.

This opens the INS attitude files dialog, a standard dialog for opening files.

3. Open the file that contains the attitude information.

The Import trajectories dialog opens. See Import files for a description of the settings in 
the dialog.

4. Define settings and click OK.

The software combines the two input files and creates the binary trajectory file in the active 
trajectory directory.

Setting: Effect:

Directory Folder from which to import files. Click on the Browse button in 
order to select a folder in the Browse for Folder dialog.

Files
Defines the extension of files that are imported. You can use the * 
character as placeholder for any file extension or type a specific 
extension.
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Import accuracy files

Import accuracy files command imports an output file from post-processing software that 
contains accuracy estimates for each trajectory position. The file includes the RMS values for xyz 
positions as well as for heading, roll, and pitch angles. It is connected to the trajectory file by the 
time stamp.

TerraPhoto can import the accuracy files from Applanix and IPAS SOL software. The RMS 
values are stored in the binary trajectory files. TerraPhoto stores only four RMS values for each 
trajectory position: x/y, z, heading, roll/pitch.

The information from the accuracy files is used for computations based on certain tie point types 
or for drawing trajectories into the design file.

To import an accuracy file:

1. Import the trajectory file(s) as described in Import files or Import directory.
2. Select Import accuracy files command from the File pulldown menu.

This opens the Import accuracy files dialog, a standard dialog for opening files.

3. Open the accuracy file delivered by the post-processing software.

This reads the file and connects the RMS values to the trajectory. The values are saved 
automatically to the binary trajectory files in the active trajectory directory. A dialog informs 
about the number of positions for which RMS values are available.
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Trajectory pulldown menu
Commands of the Trajectory pulldown menu are used to modify information of a trajectory, to 
set the accuracy of trajectory positions, to delete trajectory files, and to view the positions of a tra-
jectory.

The commands of the pulldown menu are only available if at least one trajectory is selected 
in the Trajectories window.

To: Use:
Modify trajectory information Edit information
Set trajectory accuracy values Set accuracy
Delete selected trajectories Delete
Display trajectory positions information View positions
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Edit information

Edit information command opens a dialog that contains basic information and attributes stored 
for a selected trajectory. The attributes can be modified. Modifications are immediately stored in 
the binary trajectory file.

In addition, up to two video files can be linked to a trajectory and a waveform file can be linked 
to a trajectory. The waveform file settings are not actively used by TerraPhoto but required for the 
compatibility of trajectories with TerraScan.

To modify trajectory information:

1. Select a trajectory in the list of the Trajectories window.
2. Select Edit information command from the Trajectory pulldown menu.

This opens the Trajectory information dialog:

3. Define settings and click OK.

This modifies the information in the header of the corresponding .TRJ file.

Setting: Effect:
Number Number of the trajectory (= flightline number).

Group Group number of the trajectory. Different groups may be used, for 
example, to distinguish flight sessions.

Quality Quality attribute of the trajectory.

Description Text that describes the trajectory. By default, the name of the raw 
trajectory file is used as descriptive text.

Video 1 Primary video file linked to the trajectory. This video is referred to 
as Vertical video, for example, by Verticle video command.

Start time GPS time stamp of the start position of Video 1.
End time GPS time stamp of the end position of Video 1.

Video 2 Secondary video file linked to the trajectory. This video is referred 
to as Forward video, for example, by Forward video command.

Start time GPS time stamp of the start position of Video 2.
End time GPS time stamp of the end position of Video 2.
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TerraPhoto requires that you specify both, the start time and the end time of a video file in GPS 
time stamp format. Normally the end time should be equal to the length of the video file added to 
the start time. The ability to specify the end time explicitly allows you to compensate for possible 
inaccuracy of the video clock. The application scales the display speed of the video file in order 
to cover the given time interval.

If you select several trajectories in the Trajectories window, the Edit information command 
opens the Edit several trajectories dialog. This dialog allows you to modify only settings which 
may apply for several trajectories, such as Group and Quality settings.

Waveform
Waveform data file linked to the trajectory. This is not actively 
used by TerraPhoto but required for the compatibility of 
trajectories with TerraScan.

Setting: Effect:
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Set accuracy

Set accuracy command defines accuracy estimates for all positions of one or more selected 
trajectories. Accuracy estimates are mainly used in TerraMatch for computing weighted 
corrections for strip matching. They also effect tie points that are collected in TerraPhoto for 
matching purposes. See Chapter Working with Tie Points on page 76 for more information about 
tie points.

Accuracy estimates may be computed for each trajectory position by the post-processing software 
together with the other attributes, such as coordinates and attitude angles. However, if the values 
are not provided, the command offers a way to assign accuracy estimates to trajectories manually.

To set the accuracy for trajectory files:

1. Select one or several trajectories in the list.
2. Select Set accuracy command from the Trajectory pulldown menu.

This opens the Set trajectory accuracy dialog:

3. Switch on the accuracy type that you want to set
4. Select an accuracy estimate value from the list.
5. Click OK.

The sets the accuracy for all positions of all selected trajectories.

Delete

Delete command deletes one or more selected trajectory files. The entries for the files are removed 
from the list and the binary files are deleted from the hard disc.

To delete trajectories:

1. Select the trajectory file(s) in the list.
2. Select Delete command from the Trajectory pulldown menu.

A dialog asks to confirm the removal of the file(s).

3. Click Yes in order to delete the selected file(s).

A dialog informs about the deletion process.

Setting: Effect:
Accuracy xy Horizontal accuracy estimate.
Accuracy z Vertical accuracy estimate.
Accuracy h Heading accuracy estimate.
Accuracy rp Roll and pitch accuracy estimate.
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View positions

View positions command can be used to display the single positions of a trajectory file. The 
command opens a window that shows the list of positions and for each position the attributes 
stored in the trajectory file. This may include the time stamp, coordinate values, heading, roll, and 
pitch values, as well as RMS values.

To view trajectory positions:

1. Select a trajectory file in the list.
2. Select View positions command from the Trajectory pulldown menu.

This opens the View trajectory positions dialog which contains the list of trajectory 
positions.

To show the location of a trajectory position, select a line in the list of positions. Click on the Show 
location button and move the mouse pointer into a view. This highlights the selected position with 
a cross. Place a data click inside a view in order to center the display at the selected position.

To identify a position, click on the Identify button and place a data click close to a trajectory in a 
view. This selects the line of the position closest to the data click in the View trajectory positions 
dialog.
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Display pulldown menu
Commands from the Display pulldown menu in the Trajectories window are used display video 
files.

Verticle video

Verticle video command opens the TerraPhoto Video Viewer with the video file that is linked to 
a trajectory as Video 1 in the Trajectory information dialog. See Edit information command 
for information about linking a video file to a trajectory.

General settings for the display of videos in TerraPhoto are defined in Video / Display and Video 
/ Misalignment of TerraPhoto Settings.

To start the Video 1 file of a trajectory:

1. Select the trajectory in the list.
2. Select Vertical video command from the Display pulldown menu.

The Video Viewer opens.

3. Display the video by using the control buttons of the viewer.

The command performs a similar action as the Display Video tool. However, the command does 
not start the video display automatically.

Forward video

Forward video command opens the TerraPhoto Video Viewer with the video file that is linked 
to a trajectory as Video 2 on the Trajectory information dialog. See Edit information command 
for information about linking a video file to a trajectory.

General settings for the display of videos in TerraPhoto are defined in Video / Display and Video 
/ Misalignment of TerraPhoto Settings.

To start the Video 2 file of a trajectory:

1. Select the trajectory in the list.
2. Select Forward video command from the Display pulldown menu.

The Video Viewer opens.

3. Display the video by using the control buttons of the viewer.

The command performs a similar action as the Display Video tool. However, the command does 
not start the video display automatically.

To: Use:
Display the vertical or forward video file in 
TerraPhoto Video Viewer

Verticle video
Forward video
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View pulldown menu
Commands of the View pulldown menu are used to change the size of the Trajectories window, 
to sort trajectory files in the list, and to select attribute fields for being displayed in the window.

Small dialog

Small dialog command changes the size of the Trajectories window to be a small window.

Large dialog

Large dialog command changes the size of the Trajectories window to be a large window.

Sort

Sort command defines the display order of trajectory files in the list. The trajectories can be sorted 
by up to two attributes.

To sort trajectory files:

1. Select Sort command from the View pulldown menu.

This opens the Sort trajectories dialog:

2. Select a Primary key and Secondary key for sorting.
3. Click OK.

The display order of the trajectory files in the list is changed according to the settings.

To: Use:
Change the size of the Trajectories window to a 
small or large window

Small dialog
Large dialog

Sort trajectories according to two attributes Sort
Select attribute fields for display Fields

Setting: Effect:
Primary key Attribute used first for sorting the trajectories:

• Number - increasing flightline numbers.
• Group - increasing group numbers.
• Time - increasing time stamps.

Secondary key Attribute used second for sorting the images:
• See Primary key attributes.
• None - no secondary key is used for sorting.
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Fields

Fields command lets you select which attributes are displayed for each trajectory in the 
Trajectories window.

To select visible fields:

1. Select Fields command from the View pulldown menu.

This opens the View trajectory fields dialog:

2. Select fields and click OK.

Field: Description:
Number Trajectory number.
Group Group number of the trajectory.
Quality Attribute that indicates the quality of the trajectory.
File Name of the trajectory file on the hard disk.
Description Description of the trajectory given in the Trajectory information dialog.
Vertical video Name of the video file defined as Video 1 in the Trajectory information 

dialog.
Forward video Name of the video file defined as Video 2 in the Trajectory information 

dialog.
Waveform file Path and name of a waveform file linked to the trajectory.
Start time Time stamp at the start of the trajectory.
End time Time stamp at the end of the trajectory.
Duration Length of the trajectory in seconds.
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Tools pulldown menu
Commands from the Tools pulldown menu are used to manipulate trajectories.

To: Use:
Split a trajectory into smaller parts Split
Transform trajectory coordinates Transform
Adjust trajectory elevations to a geoid model Adjust to geoid
Apply a mathematical equation to trajectory angles Convert angles
Convert time stamps into another time format Convert time stamps
Draw trajectories into the design file Draw into design
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Split

Split command can be used to split a trajectory into smaller parts. This is useful for some tools 
that require that one trajectory does not contain turnarounds and overlaps itself.

To split a trajectory:

1. Select Split command from the Tools pulldown menu.

If the mouse pointer is moved inside a MicroStation view, the closest trajectory is 
highlighted.

2. Identify the trajectory to split with a data click.

A red cross shows dynamically the split location.

3. Define the position at which to split the trajectory with a data click.

This cuts the trajectory at the given position. The application deletes the old trajectory file 
and creates two new files in the active trajectory directory.

There are automatic ways to split a trajectory in TerraScan. See the TerraScan User’s Guide for 
more information.
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Transform

Transform command applies a transformation to the coordinates of a trajectory. The 
transformation can be, for example, a change of the projections system or any other transformation 
defined in Coordinate transformations / Transformations of TerraPhoto Settings.

To transform a trajectory:

1. Select Transform command from the Tools pulldown menu.

This opens the Transform trajectories dialog:

2. Define settings and click OK.

The coordinates of the trajectory are changed. The modification is saved to the trajectory 
binary files in the active trajectory directory.

Setting: Effect:
Apply to Trajectories to transform:

• All trajectories - all trajectories in the list.
• Selected only - selected trajectories only. This requires the 

selection of one or more trajectory files in the list before the 
command is started.

WGS84 Target projection system for applying a transformation from WGS84 
to the given projection system. You can choose from any of the builtin 
or user-defined projections systems which are set as active in 
Coordinate transformations / Builtin projection systems, 
Coordinate transformations / US State Planes, and Coordinate 
transformations / User projection systems of TerraPhoto Settings.

Transform User-defined transformation to apply. You can choose from any 
transformation that is defined in Coordinate transformations / 
Transformations of TerraPhoto Settings.

Adjust heading If on, the software applies a meridian convergence correction to 
heading values. The correction is based on the projection system set 
for WGS84 or the coordinate transformation set for Transform.
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Adjust to geoid

Adjust to geoid command applies an elevation correction to trajectory files. The command is 
used, for example, to transform the WGS84-based ellipsoidal elevation values of a raw trajectory 
file to a local height model. The input model for geoid adjustment must be provided in one of the 
following formats:

• Points from file - text file containing space-delimited X Y dZ points.
• TerraModeler surface - triangulated surface created from X Y dZ points. The model must be 

loaded in TerraModeler. This has the advantage that you can visualize the adjustment model.
• Selected linear chain - linear element which has vertices derived from X Y dZ points.

XY are the easting and northing coordinates of the geoid model points, dZ is the elevation differ-
ence between ellipsoidal and local heights at the location of each geoid model point. Intermediate 
adjustment values of the model are derived by aerial (text file or surface model as input) or linear 
(linear element as input) interpolation between the known geoid model points.

The first two input models utilize aerial interpolation while the last input model uses linear 
interpolation along the linear element’s segments in order to derive adjustment values.

To adjust trajectories to a geoid model:

1. (Optional) Load a geoid model into TerraModeler.
2. (Optional) Select trajectory file(s) to adjust.
3. Select Adjust to geoid command from the Tools pulldown menu.

This opens the Adjust trajectories to geoid dialog:

4. Define settings and click OK.

If Points from file is selected as the Dz model, the Geoid dz file dialog opens, a standard 
dialog for opening files.

5. Define the text file that contains the geoid coordinates and elevation differences and click 
Open.

This applies the elevation adjustment to all or selected trajectories. The modification is saved 
to the trajectory binary files in the active trajectory directory. An information dialog shows 
the minimum and maximum values of the adjustment.

Setting: Effect:
Process Trajectories to adjust:

• All trajectories - all trajectories in the list.
• Selected only - selected trajectories only.

Dz model Source file that provides the geoid correction model:
• Points from file - text file.
• Selected linear chain - linear element selected in the design file.
• <name> - name of the geoid model surface loaded in 

TerraModeler.
Extend Distance of a linear extension. This is only active if Dz model is set 

to Selected linear chain.
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Convert angles

Convert angles command lets you apply a mathematical equation to the orientation angles 
heading, pitch, and roll of each trajectory position. The current angle value can be accessed by 
using constants H (heading), R (roll), and P (pitch). Thus, the command can also be used to ex-
change angle values.

To convert angles of trajectory positions:

1. (Optional) Select trajectory file(s) for which to manipulate angles.
2. Select Convert angles command from the Tools pulldown menu.

This opens the Convert trajectory angles dialog:

3. Define equations an click OK.

This computes the new values for the orientation angles. The modification is saved to the 
trajectory binary files in the active trajectory directory. An information dialog shows the 
number of effected trajectories.

Setting: Effect:
Apply to Trajectories for which the computation of new angles is applied:

• All trajectories - all trajectories in the list.
• Selected only - selected trajectories only.

Heading Equation for modifying the heading angle.
Roll Equation for modifying the roll angle.
Pitch Equation for modifying the pitch angle.
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Convert time stamps

Convert time stamps command can be used to convert the format of time stamps. Supported 
conversions are GPS seconds-of-week to GPS standard time, Unix time to GPS standard time, 
GPS standard time to GPS seconds-of-week, and Unix time to GPS seconds-of-week.

The conversion is necessary, for example, if data collected in several weeks is processed together 
in one project. Then, GPS seconds-of-week time stamps result in repeated values and GPS stan-
dard time must be used in order to provide unique time stamps for each trajectory position. This 
is a requirement for many processes that rely on trajectory information. Some post-processing 
software generates data with Unix seconds-of-day time stamps. They must be converted into 
another GPS time format as well.

It is essential that time stamps of trajectories and images are stored in the same GPS time format.

To convert time stamps:

1. (Optional) Select trajectory file(s) for which to manipulate angles.
2. Select Convert time stamps command from the Tools pulldown menu.

This opens the Convert trajectory time dialog:

3. Define settings and click OK.

This converts the trajectory time stamps to the new format. The modification is saved to the 
trajectory binary files in the active trajectory directory. An information dialog shows the 
number of effected trajectories.

Setting: Effect:
Apply to Trajectories for which the conversion of time stamps is applied:

• All trajectories - all trajectories in the list.
• Selected only - selected trajectories only.

Current values Original time stamp format of the trajectory positions.
Convert to Target time stamp format.
Survey date Date when the trajectory data was captured. The format is day/month/

year (dd/mm/yyyy). This is only active for the conversion from GPS 
seconds-of-week to GPS standard time.
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Draw into design

Draw into design command draws the trajectories as line elements into the design file. The line 
elements are drawn on the active level using the active line width and style settings of 
MicroStation. The color(s) of the line elements are defined by the command’s settings.

The command can use accuracy values that are assigned to trajectory positions. See Import 
accuracy files for more information.

The line elements are drawn by placing a vertex for each trajectory position. The lines can by sim-
plified by removing positions within a given tolerance.

To draw trajectory lines into the design file:

1. (Optional) Select trajectory file(s) to draw.
2. Select Draw into design command from the Tools pulldown menu.

This opens the Draw trajectories dialog:

3. Define settings.
4. If the trajectory is drawn with an accuracy-based coloring option, click on the Colors 

button.

This opens the Coloring scheme dialog:

5. (Optional) Define your own coloring scheme for drawing trajectories.
6. Click on the Auto fit button in order to fit the colors to RMS value ranges.
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7. Click OK to the Coloring scheme dialog.
8. Click OK to the Draw trajectories dialog.

This draws the line element(s) into the design file.

You can undo the drawing of trajectories by using the Undo command from the Edit pulldown 
menu of MicroStation.

Setting: Effect:
Draw Trajectories that are drawn:

• All trajectories - all trajectories in the list.
• Selected only - selected trajectories only.

Color by Determines how the color is chosen for drawing a trajectory line:
• Active color - the active color of MicroStation is used.
• Trajectory number - the color whose number in the active color 

table of MicroStation corresponds to the trajectory number is used.
• Xy accuracy - x/y accuracy values are applied to a color scheme.
• Z accuracy - z accuracy values are applied to a color scheme.
• H accuracy - heading accuracy values are applied to a color 

scheme.
• Rp accuracy - roll/pitch accuracy values are applied to a color 

scheme.
Colors Button to open the coloring scheme for accuracy-based coloring 

methods.
Thin positions If on, intermediate trajectory positions are skipped when the line is 

drawn as long as the line accuracy stays within the given positional 
Accuracy tolerance.
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18 Commands for Raster References
Raster references are usually orthophotos which are attached in TerraPhoto’s Manage Raster 
References window. However, every image in one of the supported formats can be attached, 
visualized, and modified by TerraPhoto raster reference tools. Supported formats include BMP, 
ECW compressed, GeoTIFF, JPEG, JPEG2000, RawRGB, and TIFF. A brief description of how 
to visualize reference images in TerraPhoto is given in Chapter Viewing Images on page 21. 

General settings for reference images are defined in Reference images / Default visibility and 
Reference images / Raster references of the TerraPhoto Settings.

Manage Raster References window
The Manage Raster References window can be opened by using the Manage Raster References 
tool. The window provides menu commands for handling and modifying raster references as well 
as buttons for manipulating the display of the reference files.

Overlapping reference images are displayed in MicroStation views in the order given in the 
reference list. This means, that images on top of the list are displayed behind images further down 
in the list. The order of images in the list can be changed by using commands from the Display 
pulldown menu.

Button: Effect:
Show location Shows the location of a selected image if the mouse pointer is moved 

into a MicroStation top view.
Identify Identifies an image in the list, if it is selected in a MicroStation top 

view by a data click.
1 ... 8 Switches the display for selected images on/off in the corresponding 

MicroStation views.
R (=Render) If on, image(s) are used by TerraPhoto rendering tools. The 

raster files are draped on shape elements, such as building roofs, and 
on a surface model displayed as Raster triangles in TerraModeler.

I (=Invert) If on, images are displayed with inverted colors.
Color field Display color of monochrome images.
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File pulldown menu
Commands from the File pulldown menu are used to attach and detach raster files, to save a list 
of attached reference files, or to create thumbnails of attached reference images.

Attach files

Attach files command attaches individual files as raster references.

To attach individual raster files:

1. Select Attach files command from the File pulldown menu.

This opens the Attach raster files dialog, a standard dialog for opening files.

2. Select the images you want to attach.

TerraPhoto checks the selected files and opens the Reference Visibility dialog:

3. Select views for reference visibility and click OK.

This attaches the selected images as raster references. The images are displayed if the 
selected views are top views and cover the location of the images.

To: Choose menu command:
Attach individual image files Attach files
Attach all image files in a directory Attach directory
Attach a previously saved list of images Attach list
Save a list of attached images Save list As
Save a list of attached images to the design file Save list to design
Create thumbnails for attached raster files Create thumbnails
Detach reference images Detach / Selected

Detach / Inside fence
Detach / Outside fence
Detach / All

Setting: Effect:
View 1 ... 8 If on, images are displayed in the selected MicroStation views, 

provided that they are top views.
Render If on, images are displayed in views that are rendered by TerraPhoto 

rendering tools.
Invert If on, images are displayed with inverted colors.
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Attach directory

Attach directory command attaches all image files from a directory as raster references.

To attach all raster files from a directory:

1. Select Attach directory command from the File pulldown menu.

This opens the Browse For Folder dialog, a standard dialog for selecting a directory.

2. Select the folder which contains the images you want to attach and click OK.

TerraPhoto checks the selected files and opens the Reference Visibility dialog.

3. Select views for reference visibility as described for Attach files command above.

This attaches all images in the selected folder as raster references.

Attach list

Attach list command attaches a previously stored TerraPhoto reference list. For information 
about creating a reference list, see Save list As command below.

To attach a reference list:

1. Select Attach list command from the File pulldown menu.

This opens the Attach reference list, a standard dialog for opening files.

2. Select the reference list you want to attach and click Open.

This attaches all images included in the list as raster references.

Save list As

Save list As command creates a TerraPhoto reference list. A reference list is a text file which 
includes information for each raster reference, such as coordinates of image corners, image height 
and width in pixels, color depth, background color, view display settings, and the path to the 
referenced image.

To save a reference list:

1. Attach images.
2. Select Save list as command from the File pulldown menu.

This opens the Save reference list dialog, a standard dialog for saving a file.

3. Select a location for storing the list, define a name for the list file, and click Save.

This creates a reference list file with the extension .LST.
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Save list to design

Save list into design command saves the attached references with their current settings to the 
design file. As a result, the references are automatically loaded, when TerraPhoto is started in this 
design file.

To save a list to design:

1. Attach images.
2. Select Save list to design command from the File pulldown menu.

This saves the reference list into the design file. An Information dialog is displayed.

To remove a saved reference list from a design file, detach all references and save the empty list 
to the design file.

Create thumbnails

Create thumbnails command creates thumbnails for all attached reference images. The ratio for 
the thumbnails is defined in Reference images / Raster references of the TerraPhoto Settings.

Thumbnails speed up the display of reference images at lower resolution ratios. The resolution 
ratio of a display can be defined by using Zoom to commands from the Display pulldown menu.

To create thumbnails for reference images:

1. Attach images for which you want to create thumbnails.
2. Select Create thumbnails command from the File pulldown menu.
3. Click OK in the alert dialog in order to start the process.

The thumbnail files are saved as .tif files with the file name ‘thumb<imagename>.tif’ into 
the same directory where the attached images are stored. If thumbnail files already exist, they 
are overwritten without warning.
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Detach / Selected

Detach / Selected command detaches selected reference images.

To detach selected reference images:

1. Select images in Manage Raster References window which you want to detach.
2. Select Detach / Selected command from the File pulldown menu.
3. Click Yes in the alert dialog in order to detach the selected images.

Detach / Inside fence

Detach / Inside fence command detaches reference images that are located completely inside a 
fence. The fence can be defined by a MicroStation fence element or by a selected shape.

To detach reference images inside a fence:

1. Draw a fence around the images which you want to detach.
2. Select Detach / Inside fence command from the File pulldown menu.
3. Click Yes in the alert dialog in order to detach the images. The dialog shows how many 

images are effected.

Detach / Outside fence

Detach / Outside fence command detaches reference images that are located completely outside 
a fence. The fence can be defined by a MicroStation fence element or by a selected shape.

To detach reference images outside a fence:

1. Draw a fence that excludes the images which you want to detach.
2. Select Detach / Outside fence command from the File pulldown menu.
3. Click Yes in the alert dialog in order to detach the images. The dialog shows how many 

images are effected.

Detach / All

Detach / All command detaches all reference images.

To detach all reference images:

1. Select Detach / All command from the File pulldown menu.
2. Click Yes in the alert dialog in order to detach the images.
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Edit pulldown menu
Commands from the Edit pulldown menu are used to modify attached reference images. This 
includes the modification of image parameters like image corner coordinates and pixel size as well 
as interactive changes or transformation of image positions.

Modifications made with these tools effect only the display of attached references. The changes 
get lost, if the references are detached. However, they can be stored in TerraPhoto reference lists 
using Save list As command from the File pulldown menu.

To: Choose menu command:
Modify parameters of an attached image Modify attachment
Enter an image position interactively Enter position
Transform positions of reference images Transform positions
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Modify attachment

Modify attachment command lets you change parameters for single or several reference images. 
This includes visibility parameters, image coordinates and size, and background information. If 
several images are selected for modification, the options are limited.

To modify a single attached reference image:

1. Select the reference image which you want to modify.
2. Select Modify attachment command from the Edit pulldown menu.

This opens the Modify attachment dialog:

3. Enter new values for parameters which you want to change.
4. Click OK.

This applies the new parameters to the selected image.

Setting: Effect:
View 1 ... 8 Defines the visibility of the reference image in MicroStation views.
Render Defines the visibility of the reference image in views that are rendered 

with TerraPhoto rendering tools.
Invert Defines the reference image to be displayed with inverted colors.
Easting Values for image positioning along the x axis:

• Origin - X coordinate of the image origin.
• Pixel size - pixel width.
• Corner - X coordinate of the image corner opposite to the origin.

Northing Values for image positioning along the y axis:
• Origin - Y coordinate of the image origin.
• Pixel size - pixel height.
• Corner - Y coordinate of image corner opposite to the origin.

Background Pixels to display as transparent:
• Not transparent - no image pixels are transparent.
• Extract color - pixels with exact given RGB color value.
• Close to color - pixels close to a given RGB color value.
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To modify multiple attached reference images:

1. Select several reference images which you want to modify.
2. Select Modify attachment command from the Edit pulldown menu.

This opens the Modify several attachments dialog:

3. Enter new values for parameters which you want to change.
4. Click OK.

This applies the new parameters to the selected images.

Red Green Blue Color values for transparent pixels expressed in RGB color space 
values. This is only active if Background is set to Exact color or 
Close to color.

Tolerance Tolerance value added to the RGB values for defining transparent 
pixels. This is only active if Background is set to Close to color.

Channels Channel numbers of the reference images which are displayed in place 
of TerraPhoto’s RGB channels. You may replace, for example, the 
red channel with a near-infrared channel stored in the reference 
image.

Setting: Effect:
Pixel width Width of the image pixels.
Pixel height Height of the image pixels.
Channels Number of original image channels applied to RGB channels in 

TerraPhoto.
Background Pixels to display as transparent:

• Not transparent - no image pixels are transparent.
• Extract color - pixels with exact given RGB color value.
• Close to color - pixels close to a given RGB color value.

Red Green Blue Color values for transparent pixels expressed in RGB color space 
values. This is only active if Background is set to Exact color or 
Close to color.

Tolerance Tolerance value added to the RGB values for defining transparent 
pixels. This is only active if Background is set to Close to color.

Setting: Effect:
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Enter position

Enter position command allows to define the position of a reference image interactively. This can 
be used, for example, to change the positioning of images that do not have georeferencing 
information. MicroStation elements can be used for placing an image position accurately.

To place a reference image interactively:

1. Select the reference image which you want to place interactively.
2. Select Enter position command from the Edit pulldown menu.
3. Define the image origin (south-west corner) of the image by a data click.
4. Define the opposite image corner (north-east corner) of the image by another data click.

This moves the image to the new position. If the defined rectangle is smaller/larger than the 
original image size, the pixel size of the image is changed.

Transform positions

Transform positions command applies an user-defined transformation to the display of attached 
raster references. The transformation must be defined in Coordinate transformations / 
Transformations of the TerraPhoto Settings.

To transform the display of reference images:

1. Select Transform positions command from the Edit pulldown menu.

This opens the Transform reference positions dialog:

2. Select settings and click OK.

This transforms the reference images to the new position.

To apply a transformation permanently for reference images, use Convert references command 
from the Utility pulldown menu.

Setting: Effect:
Apply to Apply transformation to All images or Selected images.
Transform Transformation to be applied. The transformation must be defined in 

Coordinate transformations / Transformations of the TerraPhoto 
Settings.

Modify extent If on, a transformation can modify the pixel size of the images. 
Otherwise only the position is changed.
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Display pulldown menu
Commands in the Display pulldown menu are used to fit views to images, zoom to defined 
resolution ratios, and change the display order for overlapping images.

Fit

Fit command fits a view to show the area that is covered by all or selected reference images. The 
view has to be a top view in order to display the reference images.

To fit a view to image locations:

1. (Optional) Select images in the Manage Raster References window.
2. Select Fit / All or Fit / Selected command from the Display pulldown menu.
3. Select a view with a data click inside the view.

This fits the selected view to display all or the selected reference images.

Zoom to

The resolution options in the Zoom to command apply the respective resolution ratio to a view. 
The predefined ratios are 1:1 (full resolution), 1:2 (50% of full resolution), 1:4 (25% of full 
resolution), and 1:8 (12.5% of full resolution).

For viewing many reference images at a small resolution ratio, the display is faster if thumbnails 
are used instead of the full resolution images. See Create thumbnails command for more 
information about thumbnails for raster references.

To zoom to a defined ratio:

1. Select a ratio from Zoom to command from the Display pulldown menu.
2. Move the mouse pointer inside a view.

The mouse pointer shows a rectangle indicating the size of an image at the selected resolution 
ratio.

3. Click inside the view.

This fits the view to display the images with the selected ratio.

To: Choose menu command:
Fit a view to show the area covered by all or selected 
reference images

Fit

Zoom to defined resolution ratios Zoom to
Send a reference image to the back of the display Send to back
Bring a reference image to the front of the display Bring to front
Send a reference image stepwise backward Send backward
Bring a reference image stepwise forward Bring forward
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Send to back

Send to back command moves an image to the back of the reference image display order.

To send an image to the back:

1. Select one or more images in the Manage Raster References window.
2. Select Send to back command from the Display pulldown menu.

The image is moved to the top of the reference list. It is displayed behind all other images in 
MicroStation top views.

Bring to front

Bring to front command moves an image to the front of the reference image display order.

To bring an image to the front:

1. Select one or more images in the Manage Raster References window.
2. Select Bring to front command from the Display pulldown menu.

The image is moved to the end of the reference list. It is displayed in front of all other images in 
MicroStation top views.

Send backward

Send backward command moves an image stepwise backward in the reference image display 
order.

To send an image backward:

1. Select one or more images in the Manage Raster References window.
2. Select Send backward command from the Display pulldown menu.

The image is moved up in the reference list. It is displayed behind the next image in display order 
in MicroStation top views.

Bring forward

Bring forward command moves an image stepwise forward in the reference image display order.

To bring an image forward:

1. Select one or more images in the Manage Raster References window.
2. Select Bring forward command from the Display pulldown menu.

The image is moved down in the reference list. It is displayed in front of the next image in display 
order in MicroStation top views.
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View pulldown menu
Commands in the View pulldown menu are used to control the appearance of the Manage Raster 
References window.

Small dialog

Small dialog command changes the Manage Raster References window to small size which 
consists of a title bar, a menu bar, and a small size list displaying the attached reference images.

Medium dialog

Medium dialog command changes the Manage Raster References window to medium size 
which consists of a title bar, a menu bar, and a medium size list displaying the attached reference 
images.

Large dialog

Large dialog command changes the Manage Raster References window to large size which 
consists of a title bar, a menu bar, and a large size list displaying the attached reference images.

To: Choose menu command:
Change the size of the raster references window Small dialog

Medium dialog
Large dialog

Set the visibility of columns in the window Fields
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Fields

Fields command lets you select which attribute columns are displayed for each attached image in 
the Manage Raster References window.

To select visible fields:

1. Select Fields command from the View pulldown menu.

This opens the View Reference Fields dialog:

2. Select the fields you want to display and click OK.

Setting: Effect:
Directory Directory where the reference image is stored.
File name File name of the reference image.
File format File format of the reference image.
Pixel depth Pixel depth of the reference image.
Origin easting/northing Coordinate values of the image origin.
Corner easting/northing Coordinate values of image corner opposite to the origin.
Width/Height in meters Image width and height in meters.
Width/Height in pixels Image width and height in pixels.
Tile size Shows the size of tiles, if the image is a tiled image file.
Position status Indicates, if the position of the image is defined:

• OK - positional information for the image is available.
• Undefined - no positional information is available for the image.
• Outside - the position is outside the coordinate range defined for 

the design file.
Thumbnail status Indicates, if thumbnails are available:

• OK - thumbnails are available.
• No - thumbnails are not available.

Active channels Numbers of active channels of the reference image.
View list View numbers for which the display of the image is switched on.
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Utility pulldown menu
Commands in the Utility pulldown menu are used to retile attached reference images, convert 
reference images into another image format, and to create roof materials.

To: Choose menu command:
Retile images into new tiles Retile images
Create roof materials for MicroStation rendering Create roof materials
Convert images into another format Convert references
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Retile images

Retile images command creates new images from reference files using a new tile array. This 
requires the definition of tiles using for example Place tile array command in TerraPhoto or any 
other tool for digitizing rectangles. The new images can be named automatically or by utilizing 
text elements placed inside each tile.

During the retile process, another image format, pixel size, or clip boundaries can be applied to 
the new images. In addition, the process can use vector elements on a specific design file level and 
“burn” these elements into the new image.

The rotation of the images can be orthonormal or defined by a line element. The line element 
represents the left-right axis for the new images and must be drawn into the design file before 
starting the retiling process. Rotated images can not be saved with internal georeferencing 
information.

To retile images:

1. Select tiles and (optional) text elements inside each tile using MicroStation Selection tool.
2. (Optional) Select a line element that defines the rotation for the new images.
3. (Optional) Select reference images to be used for retiling images.
4. Select Retile images command from the Utility pulldown menu.

This opens the Retile images dialog:

5. Select settings and click OK.

This starts the retiling process. A window shows the progress of the process.

Setting: Effect:
Use rasters Reference images used for retiling: All references or Selected only.
Rotation Rotation of the new images:

• Orthonormal - the north direction points up in the new images.
• From selected vectors - a selected line element defines the 

direction of the left-right axis in the new images.
Pixel size Pixel size of the new images.
Burn vectors If on, all vector elements that are visible in the selected View are 

drawn into the new images.
Clip to boundary If on, new images are clipped to boundaries drawn on the given 

Levels.
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Write as Image format of the new images. If the rotation of the images is 
defined by a selected vector element, only formats JPEG, TIFF, and 
RawRGB are available.

Create TFW/JGW files If on, separate georeferencing files are created for the image formats 
GeoTIFF, TIFF, and JPEG.

Target Ratio Compression ratio for the new images. This is only active for the 
formats ECW and JPEG2000.

Datum/Projection Datum and projection information that is written into the image file 
header. This is only active for formats ECW and JPEG2000.

Coord system Coordinate system information that is written into the image file 
header. This is only active for format GeoTIFF.

Directory Directory where the new image files are stored.
File naming Defines the naming method for the new image files:

• Increasing numbers - files are named by increasing numbers.
• Selected names - selected text elements are used to name the files. 

Requires that a text element is placed inside each tile and selected 
before the command is started.

Name prefix Text that is added at the beginning of an image name.
First number Number of the first image. This is only active if File naming is set to 

Increasing numbers.

Setting: Effect:
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Create roof materials

Create roof materials command creates a MicroStation material definition based on reference 
images. This can be used for rendering design file elements with MicroStation rendering. The tool 
creates the following files which form a MicroStation material definition:

• Material table file (.mat) – defines material assignments to MicroStation elements.
• Palette file (.pal) – defines the appearance of material.
• Image files (.tif) – material images.

To create roof materials:

1. Digitize one or more shapes around the area(s) for which to define roof materials.
2. Select the shape(s).
3. (Optional) Select reference images to be used for material creation.
4. Select Create roof material command from the Utility pulldown menu.

This opens the Create roof materials dialog:

5. Define settings and locations for file creation and storage.
6. (Optional) Click the Options button.

This opens the Material parameters dialog:

7. (Optional) Adjust settings and click OK.
8. Click OK to the Create roof materials dialog.

A .mat, .pal, and one or more .tif files are created in the given directories. Material images 
are named with the given Name prefix and an increasing number.

Setting: Effect:
Use rasters Reference images used for roof material creation: All references or 

Selected only.
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The created material definition can be used and edited in MicroStation tools Assign materials and 
Define Materials and thus, be applied for MicroStation rendering.

Pixel size Pixel size of the material images.
Directory Location on a hard disk where the material images are stored.
Name prefix Text added at the beginning of material image names.
First number Number of the first material image.
Definition files Files for material definition in MicroStation:

• Create material and palette - new files are created. Existing files 
with the same name are overwritten.

• Add to existing palette - if the files already exist, the new material 
images are added to the existing palatte file.

Material Path and file name of the material table file.
Palette Path and file name of the palette file.

Setting: Effect:
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Convert references

Convert references command converts attached reference images into another image format. 
During the conversion process, a user-defined transformation can be applied to the images. The 
transformation must be defined in Coordinate transformations / Transformations of the Terra-
Photo Settings.

If the transformation is a projection system change, the original rectangular tiles of the images do 
not remain the same rectangles. The software computes new rectangular tiles by using multiple 
reference images for each tile.

To convert reference images:

1. (Optional) Select reference images to be converted.
2. Select Convert references command from the Utility pulldown menu.

This opens the Convert Reference Files dialog:

3. Select settings and click OK.

This starts the conversion process. A window shows the progress of the process.

Existing image files in the output directory of the conversion that have the same name and 
format are overwritten without warning.

Convert references command can be used to save temporary modifications for reference images 
permanently into new image files. See command descriptions in Section Edit pulldown menu on 
page 320 for information about temporary changes of reference images.

Setting: Effect:
Convert Reference images that are converted: All references or Selected only.
Output directory Directory for storing the new image files.
Write as File format of the converted images.
Create TFW/JGW files If on, separate georeference files are created for the image formats 

GeoTIFF, TIFF, and JPEG.
Target Ratio Compression ratio for the new images. This is only active for the 

formats ECW and JPEG2000.
Datum/Projection Datum and projection information that is written into the image file 

header. This is only active for formats ECW and JPEG2000.
Coord system Coordinate system information that is written into the image file 

header. This is only active for format GeoTIFF.
Coordinates Transformation applied to the converted images. The transformation 

must be defined in the TerraPhoto Settings. This is only active if an 
output format is seleced that stores georeferencing information, either 
internally in the file header (ECW, GeoTIFF, JPEG2000) or 
externally in an additional file (TIFF + TFW, JPEG + JGW).
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Programming Interface
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TerraPhoto has a number of public functions which can be called by other MDL applications. 

Public functions make it possible for another MDL application to interact with TerraPhoto. These 
same routines are used internally by Terrasolid for interaction between TerraScan, TerraModeler 
and TerraPhoto.

The public functions can be used to:

• retrieve information about attached raster references
• attach, detach or control raster references
• open a mission file or an image list
• retrieve information about active mission or active image list
• create a camera view
• derive an average color inside a polygon from raw images
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Calling Method

The functions can be called with mdlCExpression_ getValue(). The code example below 
illustrates the method:

void    Example( void)
{
    int     Ret ;

    if (TphotoCall( &Ret, "FnPhotoCount()") > 0)
        mdlOutput_printf( MSG_PROMPT, “%d references attached”, Ret) ;
}

/*-------------------------------------------------------------------
    Call a function in TerraPhoto.
    Set *Ret to be the return value.

    Return 1 if successful.
    Return 0 if could not load TPHOTO.
    Return -1 if failed.
*/

int     TphotoCall( int *Ret, const char *Expr)
{
    CExprValue    Val ;
    CExprResult   Res ;
    int           Ok ;

    if (!LoadApp( “TPHOTO”))
        return (0) ;
    Ok = mdlCExpression_getValue( &Val, &Res, Expr, VISIBILITY_CALCULATOR);
    if (Ok != SUCCESS)
        return (-1) ;
    if (Ret)
        *Ret = (int) Val.val.valLong ;
    return (1) ;
}

/*-------------------------------------------------------------------
    Load MDL application with Name (such as “TPHOTO”).

    Return 1 if successful.
    Return 0 if application not found.
*/

int    LoadApp( char *Name)
{
    void    *Ptr ;
    int     Ok ;

    // Is application already loaded?

    Ptr = mdlSystem_findMdlDesc( Name) ;
    if (Ptr)                               return (1) ;

    // Not loaded, attempt loading

    Ok = mdlSystem_loadMdlProgram( Name, NULL, "") ;
    if (Ok == SUCCESS)                     return (1) ;

    return (0) ;
}
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Structure definitions
// FnPhotoRefGet() info about raster reference

typedef struct {
char    Name[400] ; // Full path to file
double  OrgX ;      // Lower left corner X
double  OrgY ;      // Lower left corner Y
double  SizeX ;     // X size of covered area
double  SizeY ;     // Y size of covered area
int     CntX ;      // X number of pixels
int     CntY ;      // Y number of pixels
int     Fmt ;       // 1051=geotiff, 1052=ecw, 1053=tiff or IMAGEFILE_xxx
int     Views ;     // visibility view bits
BYTE    Bck[4] ;    // Background transparency color RGBT
                    // where T: 0=exact RGB, 1-254=tolerance, 255=not transparent
BYTE    Clr[4] ;    // Foreground color for monochrome images RGB + unused

} PhoRef ;

// FnPhotoCamImages() info about possible camera images

typedef struct {
int     CamInd ;   // Camera index
int     Nbr ;      // Image number
int     Outside ;  // Number of vertices outside image
int     HasGrd ;   // Ground exists
double  Dst ;      // Squared distance from camera to furthest vertex
Dp3d    Xyz ;      // Camera position
Dp3d    Vrt[4] ;   // Projection vertices on ground
double  Par1 ;     // Free for caller to use
int     Par2 ;     // Free for caller to use
int     Par3 ;     // Free for caller to use

} PhoCim ;

// FnPhotoCameraList() info about mission cameras

typedef struct {
char    Name[40] ;        // Descriptive name
char    RawDir[400] ;     // Directory for input images
char    CameraFile[400] ; // Camera calibration file
int     RawFormat ;       // Raw image file format
int     Accuracy ;        // Positional accuracy 0=low, 1=normal, 2=good

} PhoCam ;



Page 338
19 MDL Public Functions
Function prototypes
// =================================================================
// Return number of currently attached raster references.
// =================================================================

int FnPhotoCount( void)

// =================================================================
// Return information about reference raster with index Ind.
// Valid indexes are 0,1,2,...FnPhotoRefCnt()-1.
//
//   P      Pointer to structure to fill.
//   Ind    Index of raster reference to query.
//
// Return 1 on success.
// Return 0 if invalid index.
// =================================================================

int FnPhotoGet( PhoRef *P, int Ind) ;

// =================================================================
// Find reference raster which has file name Name.
//
//   Name    Full path of raster file to search.
//
// Return index (0,1,2,...) on success.
// Return -1 if not found.
// =================================================================

int FnPhotoFindName( char *Name) ;

// =================================================================
// Find first reference raster which covers point X,Y.
// If (View >= 0) and (View <= 7), search only rasters which
// are on for that view. If View is outside those limits,
// search all attached raster references.
//
//   X     X position
//   Y     Y position
//   View  Search view or -1 for any view.
//
// Return index (0,1,2,...) on success.
// Return -1 if not found.
// =================================================================

int FnPhotoFindPos( double X, double Y, int View) ;

// =================================================================
// Attach raster file Name as reference. Raster file must be
// contain georeferencing (ECW, GeoTIFF, TIFF+TFW, ...).
//
//   Name    Full path of raster file to attach.
//   Update  If non zero, update affected views.
//
// Return index (0,1,2,...) of attached file on success.
// Return -1 if failed.
// =================================================================

int FnPhotoAttach( char *Name, int Update) ;
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// =================================================================
// Attach raster file Name as reference setting position explicitly.
// Any georeferencing in raster file is ignored.
//
//   Name    Full path of raster file to attach.
//   OrgX    Lower left corner X coordinate.
//   OrgY    Lower left corner Y coordinate.
//   PixW    Width of each pixel.
//   PixH    Height of each pixel.
//   Update  If non zero, update affected views.
//
// Return index (0,1,2,...) of attached file on success.
// Return -1 if failed.
// =================================================================

int FnPhotoAttachPos( char *Name, double OrgX, double OrgY,
                  double PixW, double PixH, int Update) ;

// =================================================================
// Detach raster reference with index Ind.
//
//   Ind     Index of raster. If Ind == -1, detach all.
//   Update  If non zero, update affected views.
//
// Return 1 on success.
// Return 0 if Ind is invalid or nothing to detach.
// =================================================================

int FnPhotoDetach( int Ind, int Update) ;

// =================================================================
// Set view visibility of raster reference with index Ind.
//
//   Ind     Index of raster.
//   View    View (0-7, -1=all views) to switch on or off.
//   On      If non zero, set on. If zero, set off.
//   Update  If non zero, update affected views.
//
// Return 1 on success.
// Return 0 if invalid parameters.
// =================================================================

int FnPhotoSetView( int Ind, int View, int On, int Update) ;
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// =================================================================
// Open mission file Name.
//
// If Action is true, read mission always.
// If Action == 0, read mission if it is not active already.
//
// Return 2 if mission was opened.
// Return 1 if mission was already active (Action == 0).
// Return 0 if could not read mission.
// =================================================================

int FnPhotoOpenMission( char *Name, int Action) ;

// =================================================================
// Reference points of class Class from TerraScan as ground model.
//
// Return number of points referenced.
// =================================================================

int FnPhotoReferClass( int Class) ;

// =================================================================
// Open image list file Name.
//
// If Action is true, read list always.
// If Action == 0, read list if it is not active already.
//
// Return 2 if list was opened.
// Return 1 if list was already active (Action == 0).
// Return 0 if could not read list.
// =================================================================

int FnPhotoOpenList( char *Name, int Action) ;

// =================================================================
// How many images are in the image list?
//
// Return number of images.
// Return 0 if no images or no mission.
// =================================================================

int FnPhotoListSize( void) ;

// =================================================================
// Fill table Tbl[] of camera definitions for active mission.
// MaxCnt is the number of definitions calling application has
// allocated Tbl to hold.
//
// Return number of cameras in mission.
// Return 0 if no mission or no cameras.
// =================================================================

int FnPhotoCameraList( PhoCam *Tbl, int MaxCnt) ;

// =================================================================
// Find image which best sees points Vrt[].
//
//   Cam       camera index 0,1,2,... (-1 for any)
//
// Return image number on success.
// Return 0 if no image sees the location.
// =================================================================

int FnPhotoCamBest( Dp3d *Vrt, int Vct, int Cam) ;
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// =================================================================
// Create camera view View using image which best sees points Vrt[].
// Open view if it is not open already.
// Zoom window to show area Vrt[].
//
// Return image number on success.
// Return 0 if no image sees the location.
// =================================================================

int FnPhotoCamView( int View, Dp3d *Vrt, int Vct) ;

// =================================================================
// Create camera view View using image number Nbr.
// Open view if it is not open already.
// Zoom window to show area Vrt[].
//
// Return 1 on success.
// Return 0 if no image with number Nbr or failed.
// =================================================================

int FnPhotoCamViewNbr( int View, int Nbr, Dp3d *Vrt, int Vct) ;

// =================================================================
// Create camera view View using image number Nbr using rotation
// so that Dir vector is y axis on screen.
//
// Open view if it is not open already.
// Zoom window to show area Vrt[].
//
// Return 1 on success.
// Return 0 if no image with number Nbr or failed.
// =================================================================

int FnPhotoCamViewDir( int View, int Nbr, Dp3d *Vrt, int Vct, Dp3d *Dir) ;

// =================================================================
// Create a sorted list of images which see vertices Vrt[].
//
// If CamInd < 0, use any camera.
// If CamInd >= 0, use only images from that camera.
//
// Return number of images in Tbl[].
// =================================================================

int FnPhotoCamImages( PhoCim *Tbl, int Max, Dp3d *Vrt, int Vct, int CamInd) ;

// =================================================================
// Create camera view View using image which gives the best
// oblique view to points Vrt[].
//
// Dir specifies an xy direction vector.
// If Side < 0, find image looking in direction of vector.
// If Side > 0, find image looking opposite to vector direction.
//
// If CamInd < 0, use any camera.
// If CamInd >= 0, use only images from that camera.
//
// Return image number.
// Return 0 if no image found.
// =================================================================

int FnPhotoObliqueView( int View, Dp3d *Vrt, int Vct, Dp3d *Dir, int Side, int Cam) ;
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// =================================================================
// Compute average color for planar shape Vrt[]. Use image which
// sees the shape best.
//
// Return number of pixels used on success.
// Return 0 if no image sees the location.
// =================================================================

int FnPhotoShapeClr( RgbClr *Clr, Dp3d *Vrt, int Vct) ;

// =================================================================
// Retrieve color values for marked laser points Tbl[] from open
// ortho images.
//
// Note that this routine changes Flag values of laser points.
//
// Return number of colors retrieved.
// =================================================================

int FnPhotoColorOrtho( RgbClr *Clr, BYTE *Flg, Point3d *Pnt, BYTE *Mrk, int Cnt,
                         int Mark, double Foot) ;

// =================================================================
// Retrieve color values for marked laser points Tbl[] from raw
// images of the active image list.
//
// Return number of colors retrieved.
// Return -1 if failed (out of memory).
// Return -2 if no mission.
// Return -3 if no image list.
// =================================================================

int FnPhotoColorRaw( RgbClr *Clr, Point3d *Pnt, BYTE *Mrk, double *Dbl, int Cnt,
                       int Mark, int Use, double Foot) ;
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Mission file format

A mission file stores the basic information about a mission definition. The default extension for a 
mission file is .MIS.

The mission file is written as a text file where the first row is a constant header which is used for 
recognizing the file. Each of the following rows contains one parameter name followed by an 
equal sign and the value(s) for that parameter. The order of the parameter rows is free. This file 
structure is very flexible as the basic file structure does not need to be changed if new parameters 
are added or old ones are removed.

The possible parameters are:

• Description - descriptive name for the mission.
• Date - date of the survey.
• Operator - operator during the survey.
• Location - location of the survey.
• Platform - system platform used for the survey (0=Airborne, 1=Mobile).
• ProjectionSystem - projections system of the data used for defining the scale factor.
• ProjectionScale - scale factor.
• OrthoDirectory - directory for storing rectified images of a ortho mosaic.
• TempDirectory - directory for storing temporary files.
• RectifyDirectory - directory for storing rectified images.
• CameraCount - number of camera systems or camera setups in the mission.

• Name0 - descriptive name of the first camera.
• Accuracy0 - 0=bad, 1=normal, 2=good accuracy.
• DirectoryCount0 - number of raw image directories.
• Directory0_n - directory from where to read raw images (n = number of the directory).
• CalFile0 - camera calibration file ofthe first camera.
• RawFormat0 - raw image format (9=BMP, 18=JPG, 1001=RAW, 1052=ECW, 1053=TIFF).
• Numbering0 - method of deriving unique image numbers from the file name.

• Name1 – descriptive name for the second camera.
• ...

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19

[TerraPhoto mission v2]
Description=Training
Date=
Operator=
Location=Finland
Platform=0
ProjectionSystem=9026
ProjectionScale=1.00000000
OrthoDirectory=..\ortho
TempDirectory=..\temp
RectifyDirectory=..\rect
CameraCount=3
Name0=Vertical
Accuracy0=1
DirectoryCount0=1
Directory0_0=..\images_vert\
CalFile0=.\vertical.cal
RawFormat0=1052
Numbering0=5

20
21
22
23
24
25
26
27
28
29
30
31
32
33

Name1=Back
Accuracy1=1
DirectoryCount1=1
Directory1_0=..\images_obl\
CalFile1=.\back.cal
RawFormat1=18
Numbering1=5
Name2=Forward
Accuracy2=1
DirectoryCount2=1
Directory2_0=..\images_obl\
CalFile2=.\fore.cal
RawFormat2=18
Numbering2=5
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Image list file format

An image list stores the positions and the orientations of raw images. The default extension for an 
image list file is .IML.

TerraPhoto stores an image list as a text file where the first row is a header row which is used to 
recognize the file format. Each of the following rows contains one parameter name followed by 
an equal sign and the value(s) for that parameter. Several rows contain the complete information 
for one image.

The possible attributes stored for each image are:

• Image - image file name.
• Time - image time stamp.
• Xyz - camera easting, northing, and elevation (focal point of the image), values separated by 

space.
• Hrp - heading angle (degrees, zero north, increase clockwise), roll angle (degrees, zero wings 

level, increase left wing up), and pitch angle (degrees, zero nose level, increase nose up), 
values separated by space.

• Camera - camera index from the mission definition.
• Quality - quality value.
• Color - color correction values, start with letter C followed by semicolon-separated values for 

red, green, blue, intensity, saturation, contrast.
• Contrast
• Rectify - status related to ortho rectification (0=inactive)
• TieStatus - status related to tie points (1=approved)
• Group - group value.
• AccuracyXyz - accuracy value of the image.
• BrightDistr - comma-separated grid values for radial intensity corrections.
• Histogram information field

1
2
3
4
5
6
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8
9
10
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14

[TerraPhoto image list v5]
Image=003151-052412050144-CAM1
Time=363703.858196
Xyz=487929.914 6904407.122 858.887
Hrp=-180.22586 1.47839 2.76466
Camera=0
Quality=1
Color=C0;-1;2;4;40;20
Contrast=55
Rectify=0
TieStatus=1
Group=1
AccuracyXyz=0.100
BrightDistr=9,7,20,12,6,3,2,3,6,12,20,14,6,0,-3,-4,-3,0,6,14,11,3,-3,-6,-
8,-6,-3,3,11,10,2,-4,-8,-9,-8,-4,2,10,11,3,-3,-6,-8,-6,-3,3,11,14,6,0,-
3,-4,-3,0,6,14,20,12,6,3,2,3,6,12,20
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Camera calibration file format

A camera calibration file stores the geometrical parameters of a camera system. The default 
extension for a camera calibration file is CAL.

The camera calibration file is written as a text file where the first row is a constant header which 
is used for recognizing the file. Each of the following rows contains one parameter name followed 
by an equal sign and the value(s) for that parameter. The order of the parameter rows is free. This 
file structure is very flexible as the basic file structure does not need to be changed if new 
parameters are added or old ones are removed.

The possible parameters are:

• Version - camera calibration file format version.
• Description - descriptive name of the camera.
• TimeOffset - time offset (seconds) to add to time stamps.
• Exposure - additional time offset (seconds) for xy position vs. attitude offset.
• LeverArm - vector from trajectory positions to the camera, space-separated values for lever 

arm XYZ components.
• AntennaToCameraOffset - not used by the software.
• AttitudeCorrections (HRP) - heading, roll, and pitch misalignment angles separated by space.
• PlateSize - size of the CCD plate (pixels recommended), space-separated width and height 

values.
• ImageSize - image size in pixels, space-separated width and height values.
• Margin - number of pixels ignored along image edges.
• FiducialRadius
• FiducialMarks
• Orientation - overall camera orientation.
• PrincipalPoint(XoYoZo) – principal point XYZ position (pixels recommended), separated by 

space.
• LensModel - lens distortion model.
• LensA3, A5 - radial lens distortion parameter.
• LensA7 - radial lens distortion parameter (if modeled as Function or Homogenous).
• LensA9 - lens distortion parameter (if modeled as Homogenous).
• LensR0 - zero radius for lens distortion (if modeled as Zero radius functions).
• LensK0, K1, K2 - lens distortion parameter (if modeled as Balanced)
• LensP1, P2 - tangential lens distortion parameters.
• LensColumns - number of lens distortion grid columns (if modeled as Grid)
• LensRows - number of lens distortion grid row (if modeled as Grid)
• LensRow01 ... AA - values for each lens distortion grid row, colums separated by space 

(AA=number of rows in the grid)
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[TerraPhoto calibration]
Version=20050513
Description= Vertical
TimeOffset= 0.0000
Exposure= 0.00000
LeverArm= 0.0000 0.0000 0.0000
AntennaToCameraOffset= 0.0000 0.0000 0.0000
AttitudeCorrections(HRP)= 0.0094 -0.0450 -0.0635
PlateSize= 5616.00000000 3744.00000000
ImageSize= 5616 3744
Margin= 0
Orientation= TOP
PrincipalPoint(XoYoZo)= -14.24375000 -6.49375000 -8059.35469829
LensModel=Function
LensA3=-9.646484E-010
LensA5=2.248258E-017
LensA7=-1.177917E-025
LensP1=-3.806478E-008
LensP2=-5.885584E-008
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Rotation Computation
TerraPhoto uses three angles to define the rotation of airborne images: heading, roll, and pitch. 
The angles are stored in the image list and displayed to the user as degree values where:

• heading zero is aircraft nose pointing north, increases clockwise
• roll zero is wings horizontal, increases left wing up
• pitch zero is nose horizontal, increase nose up

Three angles alone is not enough to fully define the rotation of an image. The order of rotation 
needs to be specified as well. TerraPhoto supports six different rotation orders. Attitude 
computation in the TerraPhoto Settings contains a list for selecting which order to use. This order 
must match the order in which input data was generated (normally the input trajectory). The 
standard order of IMU systems is TerraPhoto’s Heading pitch roll order setting.

Angle values heading 30.0, roll 8.0 and pitch 3.0 degrees would result in the following rotation 
matrices going from camera image to world coordinate system:

Heading roll pitch

 0.85759730   0.50562269   0.09419428
-0.49513403   0.86119667  -0.11481545
-0.13917310   0.05182663   0.98891094

Heading pitch roll

 0.86123918  0.49931477    0.09461413
-0.48882612  0.86483855   -0.11446973
-0.13898237  0.05233596    0.98891094

Roll pitch heading

 0.85395543   0.50144195   0.13898237
-0.49931477   0.86483855  -0.05233596
-0.14644075  -0.02470338   0.98891094

Pitch roll heading

 0.85759730   0.49513403   0.13917310
-0.49300685   0.86848042  -0.05182663
-0.14653024  -0.02416692   0.98891094

Roll heading pitch

 0.85759730   0.50173923   0.11306906
-0.50000000   0.86483855  -0.04532427
-0.12052744  -0.01766456   0.99255282

Pitch heading roll

 0.85759730   0.50000000   0.12052744
-0.48717171   0.86483855  -0.12131781
-0.16489568   0.04532427   0.98526906
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TerraPhoto shares the same directory structure with all Terra Applications.  It is recommended 
that you install all Terra Applications in the same directory.

The list below shows a typical directory structure when TerraPhoto has been installed in path 
C:\TERRA.

c:\terra directory where TerraPhoto was installed

config for configuration files

 tphoto.cfg defines environment variables

coordsys for coordinate system data

 ostn02.txt OSTN02 transformation grid data

docs for documentation

 tphoto.pdf documentation in Acrobat Reader format

license for user license files

 tphoto.lic user license

ma for application files

 tphoto.ma application

 tphoto.dll routine library

 ncscnet.dll ECW library

 ncsecw.dll ECW library

 ncsecwc.dll ECW library

 ncsutil.dll ECW library

seed for seed files

 seed3dcm.v8 example 3D seed file for V8

tphoto for user settings
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MicroStation is able to locate TerraPhoto with the help of configuration variables. When you 
install TerraPhoto, the installation program will create a configuration file TERRA.CFG which 
defines the required environment variables. This file is placed in MicroStation's CONFIG\APPL 
subdirectory.

For example, C:\USTATION\CONFIG\APPL\TERRA.CFG may contain:

#-------------------------------------------------------
#
#  TERRA.CFG - Configuration for Terra Applications
#
#-------------------------------------------------------

TERRADIR=c:/terra/
TERRACFG=$(TERRADIR)config/
TERRADOCS=$(TERRADIR)docs/

MS_MDLAPPS < $(TERRADIR)ma/

%if exists ($(TERRACFG)*.cfg)
%   include $(TERRACFG)*.cfg
%endif

This configuration file will include all the configuration files in C:\TERRA\CONFIG directory. 
TerraPhoto's configuration file TPHOTO.CFG contains:

#--------------------------------------------------------------
#
#  TPHOTO.CFG - TerraPhoto Configuration File
#
#--------------------------------------------------------------

TPHOTO_DATA=$(TERRADIR)data/
TPHOTO_LICENSE=$(TERRADIR)license/

#   Directory for user preferences (user has write access)

TPHOTO_PREF=$(TERRADIR)tphoto/

#   Directory for settings (may point to read-only directory)

TPHOTO_SET=$(TERRADIR)tphoto/

#   Files for settings (may be shared by organization)

TPHOTO_TILENAMING = $(TPHOTO_SET)tilename.inf
TPHOTO_TRANSFORM  = $(TPHOTO_SET)trans.inf

#   WGS84 to Ordnance Survey National Grid data files

TPHOTO_UK_OSTN   = $(TERRADIR)coordsys/ostn02.txt
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In a default configuration, MicroStation will automatically include these settings as configuration 
variables.  You can use MicroStation's Configuration command from Workspace menu to check 
the values for these variables.  In case these variables have not been defined correctly, you should 
define them manually.

MS_MDLAPPS should include the directory where TPHOTO.MA is located.

TPHOTO_DATA defines a default directory for incoming laser points.

TPHOTO_LICENSE should point to the directory where user license TPHOTO.LIC is located.

TPHOTO_SET should point to a directory where user settings and user preferences can be stored.

TPHOTO_TILENAMING specifies a file in which tile naming schemes are stored.

TPHOTO_TRANSFORM specifies a file in which coordinate transformations are stored.

TPHOTO_UK_OSTN specifies a file from which to read UK National Grid data.
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